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 اٌجاد رعد و برق در فتوشاپ
 
 

 

 

  
در اٌن آموزش نحوه ساخت افكت رعد و برق 

 .را مً آموزٌد
 

 
 
 
 
  

 

بتدا ٌک صفحه جدٌد با مشخصات ا 

:  روبرو اٌجاد کنٌد

  

Width:200pixels Height:100pixels  

Resolution: 72 pixels/inch  

Mode: RGB color Contents:White 

  

 

 

 را انتخاب کنٌد ابزار گردٌٌنت 

و و از چپ به راست بر روی صفحه 

قبل از اٌن کار مطمئن شوٌد (.بکشٌد

پٌش زمٌنه به صورت  رنگ پس و

پٌش فرض هستند برای اٌن کا مً 

هنگام کشٌدن  )رو بزنٌد" D"تونٌد کلٌد 

ابزار گردٌٌنت بر روی صفحه کلٌد 

شٌفت را پاٌٌن نگه دارٌد 

  

 
 

 

 Filter<Render <Differenceبه 

Cloudsبروٌد   .

  

 
 



 

 

 

 Image < Adjust < Invertبه  

.  بروٌد

  

 
 

 

 Image < Adjust < Levelsبه 

و دسته وسطی رو مانند شکل  .بروٌد

. زٌر تنظٌم کنٌد

  

 
 

   

 
  

 

 Image < Adjust < Colorبه

Balance   و اونو جوری . بروٌد

تنظٌم  کنٌد تا شبٌه تصوٌر روبرو 

امٌدوارم از اٌن آموزش خوشتون ! بشه 

. اومده باشه

  

 
 

      

    
 

 
 
 

 . ساخت نوشته شٌشه اي بسٌار براق
 



 

 

 
 

 

  
در اٌن آموزش نحوه ساخت نوشته شٌشه اي 

 .براق را مً آموزٌد
http://www.ashyaneeh.com/ 

 
 
 
 
 

 

 
 
 
 
  

 

فاٌل جدٌدی با پس زمٌنه سفٌد باز  

کنٌد و متن خود را با ستفاده از 

با رنگ مشکی  Typeابزار 

. بنوٌسٌد

  

  

 

 >Layer < Layer styleبه 

Drop shadow بروٌد و مقادٌر 

آن را مطابق با شکل روبرو تنظٌم 

برای آوردن  (. کنٌد

 می توانٌد Layer style پنجره 

بر روی لاٌه متن هم دو بار کلٌک 

 )! کنٌد
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 Inner Shadow سپس به 

بروٌد و مقادٌر آن را مطابق با 

.  شکل روبرو تغٌٌر دهٌد

  

 
 

 

 رفته  و از Inner Glowحالا به قسمت 
مقادٌر استفاده شده در شکل روبرو استفاده 

 . کنٌد

 
 



 

 

 

 بروٌد و Bevel and Embossسپس به 
مقادٌر آن را نٌز مطابق شکل روبرو تنظٌم 

 . کنٌد

 
 

 

 Gradientدر اٌن مرحله به قسمت  
Overlay بروٌد و آن را مطابق شکل 

. روبرو تنظٌم کنٌد
 
 
 
 
 
 
 
 
 

   

در اٌن مرحله  به وجود آوردن 

Gradient مطابق شکل است 

برای اٌن کار بر روی قسمت 

Gradient دبل کلٌک کرده و 

 را همانند Gradientسعی کنٌد 

به وجود  )2شكل (شکل روبرو 

 !آورٌد

 
 

 
)  2شكل (

 



 

 

 

 بروٌد و از مقادٌر Strokeحال به قسمت 
 . شکل روبرو استفاده کنٌد

 
 

      

      
 

 
 
 

 ساخت افكت شعله آتش در فتوشاپ
 
 

 

 

  
در اٌن درس نحوه ساخت شعله آتش رو به شما آموزش 

 .كه بسٌار ساده مً باشد. مً دهم
http://www.ashyaneeh.com/ 

 
 

 
 
  

 

 300 ×400ابتدا ٌک فاٌل جدٌد با اندازه 

pixel  اٌجاد کرده وBackground color 

ٌعنً سفٌد قرار  FFFFFF#آن را برابر با 

. دهٌد
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را سفٌد و   Foreground colorحالا 

Background Color   را  به رنگ سٌاه

. اٌن كار الزامً مً باشد.تغٌٌر دهٌد

  

  

 

 > FILTER < RENDERحالا به 

CLOUDSرفته و فٌلتر را اعمال کنٌد  .

  

  

 

 > FILTER < RENDERسپس به  

LIGHTING EFFECTS بروٌد و تنظٌمات 

. آن را مانند شکل زٌر انجام دهٌد

  

  

   

 
  

 

 .حالا از لاٌه خود ٌک کپً بگٌرٌد 

  

 

 > FILTER < BRUSH STROKESسپس به 
ACCENTED EDGES رفته و فٌلتر را روي لاٌه 
 .اي که کپً کردٌد اعمال کنٌد

 



 

 

 

 

حالا در حالً که لاٌه کپً انتخاب شده ، ابزار 

Erase  را انتخاب کرده و اندازهBrush  آن

 تنظٌم کنٌد و به وسٌله آن قسمت 200را برابر 

. روشنتر آتش را پاک کنٌد

  

  

   

 
 
  

 

 
حالا با سلٌقه ! به همٌن سادگً . خوب کار ما تمام شد 

 .خود طرحتان را تزئٌن کنٌد
  

      
      

 

 
 
 

 ! نحوه ساخت پرتو هاي نور منفجر شده
 
 

 

 

 نور منفجر شده
اٌن افكت كاراًٌ . در اٌن مقاله شما با استفاده از ٌك سري فٌلترها و با كمً به خرج دادن سلٌقه مٌتوانٌد ٌك افكت بسٌار زٌبا را اٌجاد كنٌد 

  .پس حالا دست به كار شوٌد و خودتان ٌك همچٌن افكتً را اٌجاد كنٌد. هاي بسٌار زٌادي دارد كه مطمئنا شبٌه آن را در جاهاي دٌگر دٌده اٌد

  طرح شما پس از كامل شدن مٌباست مانند شكل زٌر شود

 
  



 

 

 

من براي اٌن كار . در ابتدا ٌك فاٌل جدٌد اٌجاد نماٌٌد
 پٌكسل اٌجاد 100 پٌكسل در 600فاٌلً با اندازه 

 را بفشارٌد تا رنگهاي شما به Dسپس كلٌد . كردم
 . تبدٌل شوندDefaultحالت 

 

 

 

را RenderCloudsگزٌنه  Filterسپس از منوي 
. انتخاب كنٌد

  

 

 

 

 گزٌنه Filterبعد از آن از منوي 
PixelateMosaic را انتخاب كنٌد و سپس مقدار  

 . را وارد كنٌد15

 
 

 

براي .  به طرح خود بدهٌدBlurحالا باٌد مقداري 
 را از منوي Radial Blurاٌنكار گزٌنه 
FilterBlur انتخاب كنٌد و مقدار Amount  را 

 را برابر Blur Method و مقدار 20برابر 
Zoomقرار دهٌد . 

 

 

 

 را منوي Embossسپس باٌد گزٌنه 
FilterStylizeپس از انتخاب كردن .  انتخاب كنٌد

 :آن مقادٌر زٌر را وارد كنٌد

  
Angle : 135 
Height : 10 
Amount : 170 

 

 

 

 Brush گزٌنه Filterبعد از آن از منوي 
StrokesAccented Edges را انتخاب كنٌد و 

 :مقادٌر زٌر را وارد كنٌد
Width : 2 
Brightness : 38 
Smoothness : 5 

 

 

 

 را FilterStylizeFind Edgesسپس گزٌنه 
. انتخاب كنٌد

  

 

 

 

 را بفشارٌد تا رنگهاي طرح شما Ctrl+Iسپس كلٌد 
Invertشوند  .

  

 

 

 

 بروٌد و گزٌنه  Filterحالا دوباره منوي 
BlurRadial Blurمقدار .  را انتخاب كنٌد

Amount و مقدار 60 را برابر Blur Method را 
.  قرار دهٌدZoomبرابر 

   



 

 

 

 

 را بفشارٌد تا پنجره مربوط به Ctrl+Lحال كلٌدهاي 
 نماٌان شود سپس در محلً كه در شكل Levelتنظٌم 

.  را وارد كنٌد60روبرو مشخص شده است عدد 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

 

 
 

 

 

را دوباره انجام  )10 و 9مرحله (حالا دو مرحله قبل 
 و 20 را به Radial Blurدهٌد اما اٌن بار مقدار 

Level تغٌٌر دهٌد200 را به . 

 
 

 

 رفته و از قسمت Imageحالا به منوي 
Adjustment گزٌنه Brightness/Contrast را 

قرار + 30 را برابر Contrastانتخاب كنٌد و مقدار 
 .دهٌد

 

 

 

حال طراحً شما تا حدودي به پاٌان رسٌده است و 
فقط باٌد آنرا رنگً كنٌد براي اٌنكار ٌك لاٌه جدٌد 

بالاي همٌن لاٌه اي كه كارهاي قبلً را بر روي آن (
اٌجاد كنٌد و آنرا از رنگ مورد نظر  )انجام دادٌد

 لاٌه را در Blend Modeسپس حالت . خود پر كنٌد
 . قرار دهٌد Colorحالت 

 

 

 

.  امٌدوارم اٌن آموزش مفٌد واقع شده باشد
  

 
 

      

 

    

 

  
  

 

 
 
 

 روش ساخت عكس روٌاًٌ
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 عكس خٌـــــالً
.  در اٌن آموزش شما اٌجاد افكت بر روي ٌك عكس را ٌاد خواهٌد گرفت

 
  .اٌجاد ٌك عكس روٌائً كه بسٌار ساده و راحت مً باشد

  طرح شما پس از كامل شدن مٌباست مانند شكل زٌر شود

 
  
  

 

سعً كنٌد كه فاٌل (. كنٌدOpenفاٌل عكس خود را در فتوشاپ 
 ) باشدJpg عكس شما با پسوند

 

 

 

سپس بر روي لاٌه عكس خود كلٌك سمت راست كرده و از 
 .  را برگزٌنٌدDuplicate Layerمنوي بازشده  

 

 



 

 

 

شكل (حالا لاٌه جدٌد اٌجاد شده را در حالت انتخاب قرار دهٌد 
 > Blur بروٌد و سپس از آنجا گزٌنه Filterو به منوي ) 1

Gaussian Blurرا به عنوان 5و مقدار .  را انتخاب كنٌد 
Radius2شكل (. وارد كنٌد(  

 
 1شكل 
 

 
  2شكل 

 

 . درصد تغٌٌر دهٌد70 لاٌه را به Opacityحالا 

 

 

 

طرح ما آماده شده است شما مً توانٌد با سلٌقه خود طرحً 
 .جالب تر از اٌن را هم بدست آورٌد

 
 
 
  

 

<------------------------------------------------------ 
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 ! روش ساخت عكس سنگً
 
 

 

 

  

در اٌن درس شما طرٌقه ساخت ٌك عكس بصورت سنگً 
. را در فتوشاپ ٌاد مٌگٌرٌد

توجه داشته باشٌد تمامً مراحلً كه در اٌن درس ذكر مً 
 مً باشد كه 7شوند بر حسب قسمتهاي موجود در فتوشاپ 

با كمً تفاوت دٌگر فتوشاپها نٌز همٌن قسمتها را نٌز در بر 
. دارند

از شما تقاضا دارم چنانچه از اٌن آموزش در جاًٌ دٌگر 
مٌخواهٌد استفاده نماٌٌد حتما نام و آدرس اٌن ساٌت را نٌز 

.  قٌد نماٌٌد

 و ٌك Close-upشما براي ساختن اٌن طرح به ٌك عكس 
Texture سنگ احتٌاچ دارٌد كه براي نمونه من خودم ٌك 

شماره ٌك ، ( در اٌنجا قرار داده امTextureعكس و ٌك 
كه مٌتوانٌد آن را ذخٌره كنٌد و براي ٌاد گٌري  )شماره دو

..  از آن استفاده نماٌٌد

طرح شما پس از طراحً مً باٌست مانند شكل روبرو 
>>>  شود 

 
 

 MajidOnline:  منبع 

 

 

 
 
  

 

در ابتدا فاٌل عكس خود را در فتو شاپ باز كنٌد توجه كنٌد كه براي اٌن 
آموزش حتما باٌد فاٌل خود را تبدٌل به حالت سٌاه و سفٌد كنٌد براي اٌن 

 را Grayscale گزٌنه ImagesModeكار مً توانٌد از منوي 
. انتخاب كنٌد

 
 
 
 
 
 
 
 
 
 
 
 

  

 

 
 

 عكس شماره ٌك



 

 

 

 سنگ را باز كنٌد و آنرا به داخل فاٌل عكس بكشٌد Textureحال فاٌل 
 نٌز به همان حالت Texture مٌباشد Grayscaleچون عكس حالت (

 كپً بردارٌد و كنار هم بچٌنٌد Textureو حالا از روي  )در مً آٌد
. بطوري كه كل صفحه را بپوشاند

 
 
 

  

 

 
 

 عكس شماره دو

 

به ٌاد اشته باشٌد كه پس از كپً (. طرح شما باٌد مانند شكل روبرو شود
 ها را با Texture و چٌندن آن كنار هم حتما لاٌه هاي Textureكردن 

 Texture كنٌد تا ٌك لاٌه شود براي اٌن كار تمام لاٌه هاي Mergeهم 

 را با Ctrl+Eو بعد كلٌد هاي  )(را كه كپً كردٌد را باهم لٌنك كنٌد 
 را Merge Layers گزٌنه Layerهم بفشارٌد ٌا اٌنكه از منوي 

 )انتخاب نماٌٌد
 
 
 
 
 
 
 
 
 

  

 

 
 

 عكس شماره سه

 

 Vivid Light به normal را از حالت Texture لاٌه Modeسپس 
شما مٌتوانٌد بسته به نظرتان و عكس تان اٌن حالت را تغٌٌر (تغٌٌر دهٌد 

 )دهٌد تا بهترٌن حالت ممكن بوجود آٌد
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

 

 
 

 عكس شماره چهار



 

 

 

در اٌنجا طرح شما كامل شده است حال مٌتوانٌد به سلٌقه خود آنرا تغٌٌر 
 .دهٌد و طرح مورد نظر خود را بسازٌد

 
 

 نمونه

     
  

 
 
 

 ! تبدٌل عكس رنگً به قدٌمً و كهنه
 
 

 

 

 عكس قدٌمً

.  در اٌن آموزش شما ٌك عكس جدٌد رنگً را مً توانٌد با كمً تغٌٌر در آن توسط فٌلترها آن را به عكسً بسٌار قدٌمً تبدٌل كنٌد

  طرح شما پس از كامل شدن مٌباست مانند شكل زٌر شود

 
 

   

 

 

كرده و مراحل  Openدر ابتدا فاٌل عكس اصلً خود را در فتوشاپ 
. بعدي را به ترتٌب بر روي آن انجام دهٌد

 
 
 
 
 
 
 
 
 

 



 

 

   

 

 

سپس بر روي لاٌه عكس خود كلٌك سمت راست كرده و از منوي بازشده 
با اٌن كار شما ٌك لاٌه جدٌد .  را انتخاب كنٌدDuplicate Layerكزٌنه 

. دٌگر از عكس خود را اٌجاد كرده اٌد
 
 
 
 
 
 
 
 
 
 
 
 

   

 

 

 

خوب در اٌن مرحله شما باٌد عكس خود را زا رنگً به سٌاه و سفٌد 
ً توانٌد از كلٌدهاي تركٌبً زٌر استفاده  تبدٌل كنٌد براي اٌن كار شما م

. كنٌد

Ctrl + Shift + U 
 
 
 
 
  

 

 

 

 را Filter/Noise/Add Noiseبعد از انجام مراحل بالا از گزٌنه 
 را OK قرار دهٌد و كلٌد 10 آن را برابر با  Amountانتخاب كنٌد و 

. بفشارٌد
 
 
 
 
 
 
 
 
 

   

 

 

 

در اٌن قسمت شما باٌد به تصوٌر خود رنگ بدهٌد ، براي اٌن كار گزٌنه 
Create New Fill ، را كلٌك كرده و از مـــــــنوي باز شده   ، 
Hue/Saturationو مقادٌر آن را متاٌق شكل زٌر تغٌٌر .   را برگزٌنٌد

. دهٌد

 



 

 

 

 

 
 
 
 
 
  

 

طرح ما آماده شده است امٌدوارم از اٌن آموزش بهره كافً را برده 
      .باشٌد

 
 
 
 
 
 
 

  

 

 

     
 

 

 
 
 

 ادغام كردن متن با زمٌنه خاكً
 
 

 

 

 )ادغام متن با زمٌنه خاكً  (. در اٌن آموزش شما ترفندي جالب را در فتوشاپ مً آموزٌد

. طرح شما پس از كامل شدن مً باٌست مانند شكل زٌر شود
 

 
  

 

  

 

خوب براي شروع شما باٌد زمٌنه طرح رو كه ٌك 
 .زمٌنه خاكً هستش ذخٌره كنٌد

  



 

 

 

 

 بشٌن و فاٌل طرح رو Photoshopحالا وارد 
ً بٌنٌد ( Channelsدر پالت .باز كنٌد اگر نم

روي  ) باز كنٌنWindowChannelsاز منوي 
چون كنتراست بٌشترٌرا بٌن (كانال قرمز كلٌك كنٌد 

روي كانال قرمز راست  )سٌاه و سفٌد دارا مً باشد
رو انتخاب Duplicate Channel كلٌك كنٌن و

. كنٌد

در پنجره اي كه باز مٌشه 
DestinationDocument را New انتخاب 
حالا مً خوام ٌه كم .كنٌد كه ٌه فاٌل جدٌد اٌجاد بشه

لاٌه رو نرمتر كنم براي همٌن هم از فٌلتر ها ،فٌلتر 
BlurGuassian Blur رو انتخاب مٌكنم و در 

 رو انتخاب مٌكنم pixel 7 عدد Radiusقسمت 
. تا ٌه كم لاٌه نرمتر شه

  

 

 

 
خوب فعلاً با اٌن فاٌل كاري ندارٌم چون فقط به 

پس اونو .مورد استفاده قرار مٌگٌره  Mapعنوان 
فقط اسم فاٌل رو .ذخٌره مً كنٌم.  psdبا پسوند 

. ٌادتون باشه

ً گردٌم به فاٌل اصلً . )همون فاٌل طرح(حالا بر م

خوب شما متن خودتون رو با اندازه بزرگ 
) 3شكل (.البته با رنگ سفٌد. بنوٌسٌد 

وقتً متن خودتون رو تاٌپ كردٌن حالا وقتشه كه 
روش كاراي لازم رو انجام بدٌم 

براي  .)1شكل ( كنٌدRasterizeاول باٌد اونو 
 كلٌك كنٌن و اٌن كار روي لاٌه متن خودتون راست

Rasterize Layer رو انتخاب كنٌد  .

خوب حالا وقت اونه كه ترفندي كه گفته بودم رو 
 را DistortDisplace از منوي فٌلترها.اجرا كنٌم

) 2شكل (.انتخاب كنٌد

  

 
) 1شكل (

  



 

 

 
) 2شكل (

 

 
) 3شكل(

  

 

ً بٌند رو وارد كنٌد و  )2شكل (مقادٌري كه تو  م
Okحالا فاٌلً رو كه به عنوان .  رو بزنٌدMap 

رو  OK ذخٌره كرده بودٌن را انتخاب كنٌد و
 !و نتٌجه را مشاهده كنٌد. بزنٌد

  

 

 
  

 

. كنٌدOverlay  حالا حالت لاٌه متن رو

  

 

 
  

 

در اتمام كار شما با كمً ساٌه به متن طرح شما به 
براي اٌن كار بر روي لاٌه متن . پاٌان مً رسد

 Drop Shadowخود دو بار كلٌك كرده و گزٌنه 
را فعال كنٌد و مقادٌر آن را مانند شكل روبرو 

 )با تشكر(. تغٌٌر دهٌد

  

 



 

 

 

 

 
 
 

 اٌجاد زمٌنه ٌخً در فتوشاپ
 
 

 

 

) Ice Background(اٌجاد زمٌنه ٌخً در فتوشاپ 
 
 رنگهای Dبا فشار دادن کلٌد .  پٌکسل با زمٌنه ای سفٌد باز کنٌد۴۰۰ × ۴۰۰صفحه ای را در اندازه - ۱

Foreground و backgroundسپس به منوی فٌلتر رفته و گزٌنه .  را به حالت اولٌه بٌرون آورٌدRender < 
Cloudsبعد از آن به .  را انتخاب کنٌدImage < Adjustment < Auto contrastبروٌد  .

 تغٌٌر داده و با فشار دادن کلٌدهای Color آن لاٌه را به Setٌک لاٌه جدٌد ساخته و با رنگ آبی آنرا پر کنٌد، سپس - ۲
Ctrl+E دو لاٌه را به همدٌگر ادغام )Merge( کنٌد .

 Artistic<Plasticبگٌرٌد، بعد به منوی فٌلتر رفته و گزٌنه  )Layer <Dublicate layer(ٌک کپی از آن لاٌه - ۳
:  را انتخاب کرده و موارد زٌر را تغٌٌر داهٌد

 
Highlight Strength = 15, Detail=9, Smoothness=7 

 . تغٌٌر دهٌدOverlay لاٌه بالا را به Setسپس .  بروی دو لاٌه موجود اعمال کٌندCtrl+Lبا فشار دادن کلٌدهای - ۴

 را به Option را انتخاب و گزٌنه Distor< Polar Cooordinatesبا انتخاب لاٌه بالاٌی به منوی فٌلتر رفته و - ۵
Polar to rectanularتغٌٌر دهٌد  .

 Setسپس .  انتخاب کنٌدWind from the left را انتخاب کرده و Stylize <Windبه منوی فٌلتر رفته و گزٌنه - ۶
.  تغٌٌر دهٌدLightenلاٌه را به 

 تغٌٌر دهٌد و بعد از آن تصوٌر خود Color لاٌه را به Setٌک لاٌه جدٌد بسازٌد و آنرا با رنگ آبی پر کنٌد، سپس - ۷
. را بچرخانٌد

البته شما با هر بار تکرار . بعد از اٌنکه شما تمامی مراحل بالا را انجام دادٌد شکلی نزدٌک به شکل پاٌٌن خواهٌد داشت
. اشکال مختلفی خواهٌد داشت

  



 

 

 
 

 
 
 
 

 نحوه ساخت نوشته پٌكسلً
 
 

 

 

AS 
در اٌن آموزش شما نحوه 

ساخت نوشته اي پٌكسلً را مً 
 .آموزٌد

 .طرح شا پس از كامل شدن مانند شكل زٌر مً شود

 

 
 
  



 

 

 

طبق معمول ٌك فاٌل جدٌد اٌجاد 
نماٌٌد اندازه آن بستگً به طرح 
شما دارد من براي طرح خودم 

 پٌكسل را 119 در 450انداره 
 Foreground. انتخاب كردم

Color 00145 را برابرF و 
Background Color را 

.  قرار دهٌد012B9Bبرابر 

  

 
 

 

 گزٌنه Filterحالا از منوي 
Render را و پس از آن 
Cloudsرا انتخاب كنٌد  .

  

 
 

 

. حالا متن خود را تاٌپ كنٌد
 FFFFFFرنگ آنرا برابر 

. ٌعنً سفٌد قرار دهٌد

  

 
 

 

سپس بر روي لاٌه متن خودتان 
كلٌك كنٌد و آنرا بر روي كلٌد 

Create a new Layer 
بكشٌد و رها كنٌد تا ٌك لاٌه 
دٌگر از همان لاٌه متن شما 

پس از اٌن كار لاٌه . اٌجاد شود
اي كه اٌجاد شد را به زٌر لاٌه 

. متن اصلً خود ببرٌد

  

 
 

 

سپس لاٌه اي كه جدٌد اٌجاد 
را انتخاب  )لاٌه كپً(كردٌد 

 Filterنماٌٌد و سپس به منوي 
 و Blurبروٌد و سپس گزٌنه 

 را Gaussian Blurبعد 
 را 4.0انتخاب كنٌد و مقدار 

 آن وارد Radiusبراي مقدار 
. كنٌد

  

 
 



 

 

 

 Filterحالا دوباره به منوي 
بروٌد و سپس گزٌنه 

Pixelate و بعد Mosaic را 
 Cellمقدار . انتخاب كنٌد

Size قرار دهٌد12 را برابر  .

  

 
 

 

حالا براي اٌنكه كمً طرح ما 
واضح تر و زٌبا تر شود كمً 

 Sharpباٌد طرحمان را 
براي اٌن كار از منوي . كنٌم 

Filter و بعد Sharpen 
 را انتخاب Sharpenگزٌنه 

اٌن كار را دوبار انجام . كنٌد
 را Ctrl+fٌا مً توانٌد (.دهٌد

 )ٌك بار فشار دهٌد

  

  

 
 

 

حالا براي اٌنكه طرح ما تكمٌل 
شود كافً است بر روي لاٌه 

 Dropمتن اصلً خود افكت 
Shadowرا اعمال نماٌٌد  .

كه براي اٌنكار مٌتوانٌد دوبار 
بر روي لاٌه كلٌك كنٌد و بعد 

در پنجره اي كه باز مٌشود 
مقدار ساٌه دلخواه خود را وارد 

. كنٌد

  

 
 

    

 

 
 
 

 ساخت حلقه نورانً منفجر شده
 
 

 

 

  
در اٌن آموزش نحوه ساخت حلقه نورانً 

 .منفجر شده را مً آموزٌد
http://www.ashyaneeh.com/ 
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اٌن آموزش مراحل اٌجاد ٌك حلقه انفجاري را 
در نرم افزار فتوشاپ آموزش مً دهد كه 
بسٌار زٌبا مٌباشد سطح اٌن آموزش مبتدي 

مٌباشد وهر كاربر مبتدي به راحتً مً توانند 
با دنبال كردن مراحل اٌن آموزش ٌك حلقه 

انفجاري بسٌار زٌبا را طراحً كنند طرح شما 
 : مً شود بالاپس از اتمام مانند شكل

 500در 500ٌك تصوٌر جدٌد ا به اندازه

را foreground color پٌكسل اٌجاد كنٌد

قرار دهٌد و )FFFFFF(برابر با رنگ سفٌد 

background color  را با رنگ تٌره تر

را )1B1B33( پر كنٌد كه من در اٌنجا رنگ

 انتخاب كردم

  

 
 
 
 
 

   

 

 

ٌك مربع  rectangle tool بوسٌله ابزار
بارٌك از بالا به پاٌٌن رسم كنٌد مانند شكل 

 روبرو

  

 
 



 

 

 

در اٌن مرحله براي ادامه كار باٌد مسٌر زٌر 
  را دنبال كنٌد

Filter > Stylize > Wind 

و windو در پنجره

 From the] گزٌنهdirectionقسمت

Right] سپس باٌد دوباره فٌلتر  را فعال سازٌد

جاري را روي طرح اجرا كنٌم و براي 

 + CTRL] از دو كلٌد تركٌبً سهولت كار

F] استفاده كنٌد كه در اٌن مرحله طرح شما 

 مانند شكل روبرو مً شود

  

 
 

 

مرحله جاري را دوباره اجرا . در اٌن مرحله

 قسمت كنٌد ولً با اٌن تفاوت كه در

direction گزٌنه [From the left]  را

 فعال سازٌد مانند شكل روبرو

 
 

 

  سپس مسٌر زٌر را دنبال كنٌد

[Image > Rotate Canvas > [ 90° 
CW ] 

 درجه مً چرخد90با اٌن كار طرح شما 
 سپس دوباره مسٌر زٌر را دنبال كنٌد

Filter > Blur > Motion Blur 

را angleمقدار motion blurدر پنجره 

را  distance قرار دهٌد و مقدار°90برابر با

دهٌد كه باٌد طرح شما  قرار % 20 برابر با

 مانند شكل روبرو شود

  

 
 



 

 

 

  سپس در ادامه مسٌر زٌر را دنبال كنٌد

Filter - Distort - Polar 
Coordinates 

 Rectangle toو در قسمت

Polar]    options ]كه در  را فعال سازٌد

 نهاٌت طرح شما مانند شكل روبرو مٌشود

  

 
 

 

  در اٌنجا طرح ما به پاٌان مً رسد

مراحل بالا اصول كار بود ولً شما مً توانٌد 

ابتكار كار خود را  با مقداري كار بٌشتر و

زٌباتر سازٌد مثلا من در شكل روبرو بجاي 

ٌك خط وحلقه از چند حلقه استفاده كردم و چند 

و تمرٌن به آنها پً  افكت دٌگر كه با كار زٌاد

 مً برٌد شما مٌتوانٌد با مقداري كار بٌشتر

روي اٌن طرح كارهاي زٌباتر از اٌن هم اٌجاد 

 كنٌد
 

 

 

 
 
 

 روش ساخت چشم در فتوشاپ
 
 

 

 

  
در اٌن آموزش نحوه ساخت چشم را به شما 

 .آموزش مً دهٌم
http://www.ashyaneeh.com/ 
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 پٌکسل با 120*200فاٌلی به ابعاد - 1
.  باز کنٌدTransparentزمٌنه 

  

) 000000(زمٌنه را با رنگ مشکی - 2
. بپوشانٌد

 پٌکسل ، با 20از سمت چپ به اندازه - 3
در اٌن مثال (.رنگ سبز روشن بپوشانٌد

48C1AF ( #

  
 

 

 

را  )Filter/Stylize/Wind (فٌلتر باد -4
 اعمال From the lef و windبه حالت 

. کنٌد

 ) ctrl +f (. بار تکرار نماٌٌد5فٌلتر را - 5

  

 از Rectangular marqeeبا ابزار -6
 پٌکسل را انتخاب 100سمت راست 

 و گزٌنه imageکرده  و ازطرٌق منوی 
cropتصوٌر را ببرٌد  .

  

 
 

 

 
 Rotate گزٌنه Imageاز منوی -7

canvas  درجه 90 تصوٌر را ccw 
. بچرخانٌد

در حالی که رنگ ها به حالت پٌشفرض -8
 گزٌنه Image،از منوی  )ctrl+d(هستند

Canvas size به صورت زٌر تصوٌر 
.  در آورٌد200*200را به اندازه 

  

 
 

 

اکنون قسمت بالاٌی تصوٌر را با رنگ -9
 .مشکی پرکنٌد

 
 



 

 

 

 Filter/Distort/Polar(فٌلتر  -10
coordinates(  را به صورت

Rectangular to polarاعمال کنٌد  .

  را به Inner shadowافکت -11
:  صورت مقابل به لاٌه بدهٌد 

 Distanse=0,Choke=0,Size=15  

  

 
 

 

 دلخواه Hue/Saturationاز طرٌق - 12
. را تنظٌم کنٌد

داٌره ای در وسط عنبٌه چشم انتخاب - 13
 به آن بدهٌد و Feather پٌکسل 5کنٌد و 

 Gradientدر لاٌه ای جدٌد با ابزار 
مطابق شکل زٌر طٌف سٌاه سفٌد به آن 

 .دهٌد

 
 

 

 کنٌد و Screenسپس حالت لاٌه را - 14
 )30(.  لاٌه را کم کنٌدOpacityمقداری 

 
 

 

مراحل ساخت به پاٌان رسٌد ، امٌدوارم از اٌن 
.  آموزش استفاده لازم را ببرٌد

هر گونه مشكلً را در انجمن هاي فتوشاپ 
 .ساٌت مطرح نماٌٌد

 

 

 
 
 

 .نحوه اٌجاد جلوه واقعً از خون
 
 

 

 

  
در اٌن آموزش نحوه اٌجاد 
ٌك جلوه واقعٌاز خون را 
 .به شما آموزش مً دهٌم

http://www.ashyaneeh.com/ 
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ابتدا تصوٌري را که 
مً خواهٌد جلوه خون 

را به آن اضافه کنٌد 
در فتوشاپ باز 

من از اٌن .کنٌد
تصوٌر استفاده کرده 

 .ام 

 
 

   

 

 

 ابزار ToolBarحالا از 
Lasso را انتخاب کنٌد و 

به کمک آن ، جاًٌ را که 
مً خواهٌد زخم وجود 

داشته باشد انتخاب 
حال ٌک لاٌه جدٌد .کنٌد

ساخته و آن را با رنگ 
رنگ .قرمز پر کنٌد

قرمزي که انتخاب مً کنٌد 
من از .باٌد تقرٌبا تٌره باشد

 # CC0000رنگ 
حالا .استفاده کرده ام

Blending Option لاٌه 
 Colorخود را روي 

Burnتنظٌم کنٌد . 
 



 

 

 

 

 Tool Barحال از 
 Smudgeابزارهاي 

Tool و Burn Tool را 
ازاٌن دو .انتخاب کنٌد

ابزار در اٌن صحنه زٌاد 
 .استفاده مً کنٌم 

   

 
  

 

 

سپس به کمک ابزار 
Smudge و با اندازه فلم 

تقرٌبا به اندازه (کوچک 
آنقدر  )عرض لکه خون¼ 

روي لکه کار کنٌد تا حالت 
چکٌدن خون از زخم را 

توجه کنٌد که .نشان دهد
براي واقعً تر جلوه کردن 

لکه خون باٌد ٌکً از 
کناره هاي لکه را بٌشتر 

. به طرف پاٌٌن بکشٌد 
همچنٌنئ استفاده از قلم 

از نظر (هاي متفاوت 
جلوه شما  ) Brushاندازه 

را واقعً تر نماٌش مً 
 .دهد

 
 
 
 
 
 



 

 

 
 
 
 
 
 
 

   

 

 

 
 

 وسط Burnحالا با ابزار 
لکه خون را شبٌه سازي 

با اٌن کار برٌدگً .کنٌد
زخم واقعً تر و عمٌق تر 

 .جلوه مً کند

 
 

 

حال با استفاده از 

ٌک فٌلتر لکه 

خون را بسٌار 

واقً جلوه مً 

. دهٌم 

 > FILTERبه 

TEXTURE < 

TEXTURIZE 

رفته و تنظٌمات 

آن را مانند شکل 

. زٌر انجام دهٌد

  

 
 



 

 

 

در نهاٌت طرح شما باٌد 
 .چٌزي شبٌه زٌر باشد

 
 

 
 
 

 نحوه ساخت افكت آتش بر روي متن
 
 

 

 

  
توسط اٌن آموزش مً توانٌد نوشته هاي خود 
را توسط نرم افزار فتوشاپ به صورت آتشٌن 

 .در آورٌد
http://www.ashyaneeh.com/ 

 
 
 

 
  

 

 اٌجاد كنٌد، زمٌنه اٌن فاٌل را سفٌد انتخاب كنٌد و رنك فرگراند آن را به 300x300ابتدا ٌك فاٌل جدٌد با اندازه 
 بر روي لاٌه متن Ctrlو با پاٌٌن نگاه داشتن كلٌد . سٌاه تغٌٌر دهٌد، سپس متن خود را با رنگ سٌاه تاٌپ كنٌد

 ها Channel كلٌك كنٌد تا به قسمت Channelبر روي تب . تا نوشته شما به صورت انتخاب در آٌد. كلٌك كنٌد

 با نام Channelكلٌك كنٌد تا ٌك لاٌه به  save selection as Channelسپس بر روي . بروٌد
Alpha 1 اٌجاد شود، در اٌن حالت بر روي لاٌه Alpha 1 كلٌك كنٌد، حال باٌد مسٌرهاي زٌر را بر روي آن 
. ابتدا مسٌر زٌر را اجرا كنٌد. اعمال كنٌد

Filter > Blur > Gaussian Blur 

http://www.ashyaneeh.com/


 

 

Radius = 3 

 .سپس مسٌر زٌر را انجام دهٌد

Image > Rotate Canvas > 90
o
 CW 

 .سپس مسٌر زٌر را دنبال كنٌد.  درجه مً چرخد90كه با اٌن كار مسٌر شما 

Filter > Stylize > Wind 
Method = Wind 
Direction = From The Left 

 .مسٌر زٌر را دنبال كنٌد

Image > Rotate Canvas > 90
o
 CCW 

 Levelsبراي اتمام كار باٌد به قسمت .  درجه مً چرخد و به حالت اولٌه بر مً گردد90با اٌن كار طرح شما 
 .براي اٌن كار مراحل زٌر را انجام دهٌد. بروٌم

Image > Adjustments > Levels 

 . تنظٌم كنٌد2و آن را مانند شكل شماره .  هم استفاده كنٌدCtrl + Iبراي اٌن كار مً توانٌد از كلٌد تركٌبً 

 
 

 



 

 

) 2شكل شماره (

   

 

 

 را پاٌٌن نگاه داشته و بر روي Ctrlحال كلٌد 
تا به .  ٌك بار كلٌك كنٌدAlpha 1لاٌه 

صورت انتخاب در آٌد، حال دوباره به پنل 
Layer برگشته و لاٌه BackGround را 

در  )اولٌن لاٌه اي كه ساخته شده(انتخاب كنٌد 
 Create a Newاٌن حالت بر روي دكمه 

Layer  ٌك بار كلٌك كنٌد تا بعد از لاٌه
بك گراند و لاٌه متن شما ٌك لاٌه جدٌد اٌجاد 

.  شود، سپس مسٌر زٌر را دنبال كنٌد

Select > Feather 
Feather Radius = 8 
 
 
or 
 
Ctrl+Alt+D 

سپس رنگ فورگراند را به رنگ قرمز ٌا 
FF0000سپس ابزار .  تغٌٌر دهٌد

Paintbucket Tool  را انتخاب كرده
و مناطق انتخاب شده را با رنگ قرمز پر 

 .كنٌد

  

 
 
 
 
 
 
 
 
 
 
 
 
 

   

 

 

 بازگشته و دكمه Channelمجدد به قسمت 
Ctrl را پاٌٌن نگه دارٌد و برو روي 

Channel Alpha 1 كلٌك كنٌد كه آن به 
سپس دوباره به .صورت سلكت شده در آٌد

قسمت لاٌه ها بروٌد و لاٌه اي را كه در 
قسمت قبل با رنگ قرمز پر كرده اٌد را 

 Create Newانتخاب كنٌد سپس روي دكمه 

Layer) (  كلٌك كنٌد تا بالاي لاٌه اي كه
. انتخاب كرده اٌد ٌك لاٌه جدٌد اٌجاد شود

. سپس مسٌر زٌر را دنبال كنٌد

Select > Feather > Feather 
Radius = 4 

  

  

  

  

 FFFF00#سپس فرگراند كالر را به رنگ 
 Paintbucketسپس ابزار . تغٌٌر دهٌد

Tool) (   را انتخاب كرده را با رنگ
 را اجرا 3سپس مجدد مرحله . زرد پر كنٌد

 
 

 



 

 

 Featherكنٌد با اٌن تفاوت كه اٌنبار 
Radius قرار دهٌد و فرگراند 1 را برابر با 

 تغٌٌر و FFFFFFكالر را هم به رنگ 
. --قسمت انتخاب شده را با رنگ سفٌد پر كنٌد

<--- 

 

سپس دز حالً كه لاٌه اي كه قسمتهاي انتخاب 
شده آن را با رنگ سفٌد پر كرده اٌم انتخاب 

را  )Ctrl+E(شده است دوبار كلٌدهاي مٌانبر 
بفشارٌد كه با اٌن كار سه تا از لاٌه هاي با هم 

تلفٌق مً شوند كه در كل سه لاٌه براي ما 
ٌكً بگراند، ٌكً لاٌه تشكٌل . باقً مً ماند

دهنده آتش و دٌگري لاٌه متن ما سپس براي 
 Blurكامل شدن كار از مجسموعه ابزارهاي 

Tool ابزار Smudge Tool را انتخاب 
.  كنٌد

 

و به وسٌله اٌن ابزار شعله هاي بالاي نوشته 
را به طرف بالا بكشٌد تا شعله ها تا حدودي 

 >.---شبٌه شعله هاي آتش شوند

 
 

 

سپس براي زٌبا تر شدن شعله هاي آتش باٌد 
 را روي آن اجرا كنٌم براي اٌن Liguifyفٌلتر 

...  كار باٌد اٌن مسٌر را دنبال كنٌد

Filter  >  Liguify  

) Ctrl+Shift+X(ٌا از كلٌدهاي مٌان بر 
 Twirlدر اٌن فٌلتر ابزار . استفاده كنٌد

Clockwise) (  را انتخاب كنٌد
Brush PressureوBrush Size را 
 قرار دهٌد و بوسٌله اٌن ابزار 50برابر با 

روي زبانه هاي آتش موجهاًٌ به طرف 
 Twirlراست اٌجاد كنٌد سپس ابزار 

Counter Clockwise Tool) (  را
در اٌن فٌلتر انتخاب كنٌد و اٌنبار بوسٌله اٌن 
ابزار زبانه هاي شعله آتش را كمً به طرف 

چپ موج دار كنٌد كه شكل شما شبٌه شكل 
 .روبرو شود

 
 
 
 
 

   

 

 

 بروٌد كه براي اٌن كار در پاٌٌن Add Layer Styleدر اٌنجا باٌد لاٌه متن خود را انتخاب كنٌد و به قسمت 

 را انتخاب كنٌد و آن را مانند Satinو گزٌنه . كلٌك كنٌد ) (Add Layer Styleقسمت لاٌه ها روي دكمه 
.  شكل زٌر تنظٌم كنٌد



 

 

 

.  رفته و آن را مانند شكل زٌر تنظٌم كنٌدGradient Overlayسپس به قسمت 

 

. كه در نتٌجه كار شما مانند شكل زٌر مً شود

 

 

 

هر . امٌدوارم از اٌن طرح خوشتان آمده باشد
گونه مشكلً را مً توانٌد در انجمنهاي 

 .فتوشاپ ساٌت مطرح نماٌٌد
 

 

 
 
 

 آموزش ساخت جعبه سه بعدي
 



 

 

 
 

 

  
در اٌن آموزش با نحوه ساخت ٌك جعبه 

 3D. سه بعدي آشنا خواهٌد شد
Package Box 
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 گام نخست شما از راه 

File<New ٌک صفحه جدٌد 

کلٌدهای مٌانبر (مٌسازٌد 

Ctrl+N( . ابعاد آنرا

 پٌکسل انتخاب 400*400

 کار خود Resolution. نماٌٌد

را بسته به کٌفٌت انتخاب نماٌٌد 

مثلا برای ساخت عکسهای 

اٌنترنتی از دقت 

72Pixels/inch استفاده می 

 کار خود را هم Mode. کنند

و .  بگذارٌدRGB Colorروی 

Contents کار خود را بر 

.  انتخاب نماٌٌدWhiteروی 

 را در پاٌان انتخابها OKدکمه 

. فشار دهٌد

  

 

  

  

  

  

 

 

خوب حالا به دو عکس برای ساخت 
 File<Openجعبه نٌاز دارٌم، از قسمت 

 از دستگاه Ctrl+Oو ٌا کلٌدهای مٌانبر 
خود آدرس دو تصوٌر را بدهٌد و آنها را 

اکنون نٌاز است اٌن دو . باز نماٌٌد
تصوٌر بر روی صفحه جدٌد شما قرار 
بگٌرن، برای اٌن کار ابتدا جداگانه هر 

.  ٌا انتخاب باٌد کردSelectعکس را 
از : اٌن دستور در برنامه بدٌن شکل است

 را انتخاب کنٌن و Select<Allقسمت 
دور .  را بزنٌنCtrl+Aٌا کلٌدهای مٌانبر 

تا دور تصوٌری که می خواهٌد به صفحه 
جدٌد انتقال دهٌد و با آن جعبه بسازٌن، به 

خوب ! شکل نقطه چٌن در حال حرکتن
اکنون باٌد از اٌن تصوٌر کپی برداری 

 و ٌا Edit<copyنماٌٌد، از بخش 
و .  را فشار دهٌدCtrl+Cکلٌدهای مٌانبر 

سپس بروی صفحه جدٌد خود اٌن نسخه 
 و ٌا Edit<Paste(. را بچسبانٌد

 را همزمان Ctrl+Vکلٌدهای مٌانبر 
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. )بزنٌن

در مورد تصوٌر دوم هم همٌن اعمال را 
تکرار نماٌٌد، اکنون دو تصوٌر روی 

. صفحه جدٌد شما آمده است

  

  

  

  

  

 

 

احتمال دارد عکسهای کپی شده بر روی 
صفحه نٌاز به تغٌٌر در ساٌز آنها باشد، 

 کردن Pasteبرای اٌن کا شما پس از 
تصوٌر بروی صفحه جدٌد ٌک لاٌه در 

 اضافه Layer1 به نام Layersبخش 
شده است، که الان انتخاب شماست ٌعنی 

اگر اٌن پنجره باز (. به رنگ آبی است
 را Window<Layersنٌست از 

برای . )انتخاب و تٌک کنار آنرا بزنٌد
تغٌٌر در ساٌز از قسمت 

Edit<Transform<Scale را 
انتخاب کرده و به اندازه دلخواه، مانند 

 .تصوٌر در بٌاورٌد

None Pic 

 

لازم به ذکر است که شما در بخش لاٌه 
باٌد چنٌن وضعٌتی داشته  )Layers(ها 

 Backgroundپاٌٌن ترٌن لاٌه : باشٌد
 مانند Layer2 و بعد هم Layer1سپس 
. شکل

حال نوبت به سه بعدی کردن جعبه رسٌد، 
اکنون لاٌه اول را انتخاب و در حالت 

فعال قرار دهٌد، از قسمت 
Edit<Transform<Perspective 

را انتخاب کنٌد، هشت نقطه دور تا دور 
تصوٌر نماٌان می شوٌد که با انتخاب 

نقطه پاٌٌنی راستی و حرکت کم به سمت 
بالا می توان شکل مورد نظر برای جعبه 

 Edit<Freeسپس از . را بدست آورد
Transform را انتخاب و اگر ساٌز نٌاز 

کلٌدهای مٌانبر (. به تغٌٌر است انجام دهٌد
Ctrl+T ( . در مورد شکل دوم هم همٌن

فقط با اٌن تفاوت . کارها را تکرار کنٌد
که اٌن بار نقطه پاٌٌنی گوشه چپ را بالا 

 .ببرٌد تا شکل پرسپکتٌو بگٌرد

 

 

 



 

 

 

وب، اکنون دو لاٌه را به هم بچسبانٌد تا 
... مماس هم شوند

و کمی می . ااما هنوز کار تمام نشده
. خواهٌم واقعی ترش کنٌم

  

 
   

 

 

می خواهٌم ساٌه را به کار بٌافزاٌٌم، 
کلٌک و  )Layer1(روی بالاترٌن لاٌه 

انتخابش کنٌن، اکنون از قسمت 
Layer<Merge Down را انتخاب 

 را بزنٌد، Ctrl+Eکنٌد ٌا کلٌدهای مٌانبر 
اٌن کار باعث مٌشود دو لاٌه در هم تلفٌق 

 Layer<Layerبعد به . شوند
Styles<Drop shadow رفته و 

. تنظٌمات آنرا بدٌن شکل انجام دهٌد
 )تنظٌمات(

حالا می خواهٌم ساٌه زٌرٌن را بزنٌم، به 
 بروٌد و آنرا Backgroundلاٌه 

 Layer<Newانتخاب کنٌد، و از 
Layer کلٌدهای مٌانبر  ( را بزنٌد

Shift+Ctrl+N (  و نام آنراShadow 
از جعبه ابزار خود که منوی . بگذارٌد

دست چپ باشد ابزار 

  Polygon Lasso را انتخاب 
و مانند شکل روبرو ساٌه ای . نماٌٌد

طراحی کنٌد و آنرا با ابزار سطل رنگ 

Paint bucket tool انتخاب و  
. رنگ مشکی کنٌد

  

 
 
 
 
 
 
 
 
 
 
 
 

   

 

 

) Deselect(برای خروج از انتخاب 
 را انتخاب Select<Deselectباٌد از 

 را Ctrl+Dکنٌن ٌا کلٌدهای مٌانبر 
ٌه ذره دٌگه می خواٌم واقعٌش . بزنٌن

کنٌم، از بخش 
Filter<Blur<Guassian Blur را 

 را Radius 5انتخاب نماٌٌد و عدد 
 .برای آن انتخاب نماٌٌد

 



 

 

   

 

 

خوب برای اتمام کار هم کمی روی 
Back groundآن افکت می دهٌم    .

 را انتخاب Back groundابتدا لاٌه 
ٌک لاٌه جدٌد به همان روش قبل . نماٌٌد

 بسازٌن، رنگ اٌن لاٌه را BGبه نام 
 Paintکامل سفٌد کنٌد البته بوسٌله ابزار 

bucket tool خوب حال از ،
Filter<Render<Lighting 

effects را انتخاب کنٌن و سپس در 
" five lights up"پنجره باز شده گزٌنه 

و اونجوری که باعث . انتخاب شود
خوشحالی شما مٌشه اونها رو چٌنش 

. کنٌن

  

  

 
 

   
 

! اٌنم از طرح پاٌانً ما ، امٌدوارم خوشتون اومده باشه 
 

 

  

 

 
 
 



 

 

 نحوه ساخت و اٌجاد توپ بٌلٌارد
 
 

 

 

  
نحوه اٌجاد توپ بٌلٌارد در 

. سطح مقاله حرفه اي. فتوشاپ
 )7فتوشاپ (
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پس از انجام دادن مراحل 

زٌر همچٌن طرحً را 
 خواهٌد داشت

 
 

 
 
  

 

   

اول از هر چٌز باٌد بگم 
نكات و ترفندهاي زٌر 

 مً 7مربوط به فتوشاپ 
و با كمً تغٌٌر در . باشد

 هم قابل اٌجاد 6فتوشاپ 
اٌن نوع آموزش . است

مرحله به مرحله ما را با 
 در 3Dابزار ساخت 

.  فتوشاپ آشنا مً كند

خوب در اٌن مرحله شما باٌد 
صفحه اي جدٌد مطابق شكل 

ساٌز ما . روبرو اٌجاد كنٌد
 . مً باشدInchesدر اٌنجا 

 
 

 
 

   

 

 

وقتً كه فاٌلتون رو اٌجاد 
كردٌد مطابق شكل روبرو 
ٌك لاٌه جدٌدي دٌگر اٌجاد 

در اٌن لاٌه ما باٌد . كنٌد
.  داٌره خود را رسم كنٌم

 Elipseاز منوي ابزار 
Tool رو انتخاب نماٌٌد و 
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>  . -اقدام به رسم داٌره كنٌد

دقت كنٌد كه قطر داٌره ما 
و .  سانتٌمتر باشد3حدود 

داٌره را سعً كنٌد در مركز 
.  صفحه قرار دهٌد

داٌره را به رنگ سفٌد تغٌٌر 
دهٌد، مانند شكل شماره 

)2   (FFFFFF 

 
 

 
) 2(شكل شماره 

 

 

خوب در اٌنجا ٌك بار كلٌد 
D را فشار دهٌد تا رنگ ها 

به صورت پٌش فرض در 
.  بٌاد

روي همون لاٌه اي كه 
هستٌد عدد ٌك را تاٌپ كنٌد 

دقٌقا در  )2(و مانند شكل 
مركز داٌره آن را مٌزان 

بعد از تاٌپ متن بر . كنٌد
روي لاٌه قبلً ٌا همون لاٌه 

دوم كلٌد راست بكنٌد و از 
منوًٌ كه باز مٌشه 

Rasterize Layer رو 
و بعد از اون . انتخاب كنٌد

هم روي لاٌه متنتون ٌعنً 
و . همون عدد ٌك كلٌك كنٌد

با فشار دادن كلٌدهاي تركٌبً 
Ctrl+E لاٌه متن و لاٌه 

شماره دو رو با هم دٌگه 
مانند شكل شماره . ادغام كنٌد

)3  (

آخر كار هم منوي لاٌه هاي 

 

 

 



 

 

 4شما باٌد مانند شكل شماره 
 .بشه

) 2(شكل 

 
) 3(شكل شماره 

 
) 4(شكل 

 

 

ٌك لاٌه جدٌد درست كنٌد و 
.  بزارٌد3اسمشم لاٌه شماره 

 3دقت كنٌد كه لاٌه شماره 
بٌن لاٌه شماره ٌك و دو 

 >. -----قرارا بگٌره

 

 
  

 

 

خوب تو اٌن مرحله باٌد 
از . رنگ توپ مشخص كنٌم

 Gradientمنوي ابزار 
tool رو انتخاب كنٌد و 

رنگ اون رو به اٌن صورت 
.  تغٌٌر بدٌد

 F0F7DFرنك سمت چپ 

 

 



 

 

و رنگ سمت راست 
FFD810. 

 

 

 

حالا لاٌه اي كه عدد رو 
روش تاٌپ كردٌم انتخاب مً 

 بعد از 2لاٌه شماره . كنٌم
اٌنكه انتخاب كردٌم باٌد به 

.  اٌن قسمت برٌم

Filter>Render>3D 
Transform  

 Sphereاز اونجا ابزار 
Tool رو بردارٌد و دقٌقا به 

دور داٌره سفٌد رنگً كه 
دارٌم ٌه داٌره بزرگتر تقرٌبا 
سه برابر داٌره قبلً رسم مً 

 > . ----كنٌم

بعد از اٌنكه داٌره رو رسم 
كردٌد از همونجا ابزار 

trackball Tool رو 
بردارٌد و مثل شكل شماره 

رو تصوٌر كلٌك كنٌد و  )3(
اون رو به طرف سمت چپ 
دقٌقا مثل شكل بچرخانٌد تا 
. تو اٌن موقعٌت قرار بگٌره

 رو OKخوب بعد از اٌن 
.  كلٌك كنٌد

باٌد كارمون مثل شكل شماره 
.   در بٌاد4

توجه كنٌد تو اٌن مرحله باٌد 
 Ellipticalابزار 

Marquee Tool كه 
شكلشو زٌر گذاشتم رو 
 به 2انتخاب كنٌد و رو لاٌه 

دور كارمون ٌه داٌره رسم 
كنٌم، اگه بزرگتر از 

طرحمونم در اومد اشكال 
اونو همٌن . )4شكل (نداره 

طور بزارٌد و مرحله زٌر 
.  رو انجام بدٌد

   

 

 
 

 
)trackball Tool (

 

 
) 3(شكل 
 



 

 

 
 
)  4(شكل 

 

 

حالا اگه ٌادتون باشه ٌه 
رنگ تولٌد كرده بودٌمو ٌك 

 3لاٌه و اسمشم لاٌه شماره 
خوب حالا اٌن لاٌه . گذاشتٌم

و توسط .  رو انتخاب كنٌد3
 از Gradient toolابزار  

چپ به راست رنگمونو به 
 .تصوٌر مٌدٌم

 

 
   

 

 

اٌنجا لازمه كه رنگ 
foreground رو تغٌٌر 

 paintو ابزار . بدٌم
brush بلور رو انتخاب 

كنٌد، توجه كنٌد كه بلور 
باشه و ساٌز اون رو هم رو 

.   بزارٌد300

ٌك لاٌه جدٌدم درست كنٌد و 
 بزارٌد و بعد 4اسمشم لاٌه 

لاٌه شماره دو رو كه متنمون 
روش تاٌپ شده انتخاب 

كنٌدو و قسمتً كه رنگ 
نخورده رو توسط اٌن 

ابزاري كه معرفً كردم 
دقٌقا مثل شكل . رنگ كنٌد

 ، از آخر هم اگه 3شماره 

 

 



 

 

كارتون دقٌق باشه باٌد مثل 
شماره چهار ٌه طرحً 

.  داشته باشٌد

خوب دوستان اٌن مقاله ٌه 
خورده سخت بود ولً 
امٌدوارم تا آخر كار با 

و با كمً . موفقٌت رفته باشٌد
حوصله و سلٌقه كاري ٌك 
طرحً مثل شكا زٌر مً 
تونٌد درست كنٌد، كه اٌن 

كار رو به عهده خودتون مً 
 .سپارم

 
 

 
) 3(شكل 

 
) 4(شكل 



 

 

 

 

 

دوستانً كه از اٌن مقاله مً خواهند در وبلاگ ٌا ساٌت خود استفاده كنند : توجه   
. ، چون براي ائلٌن بار است كه نحوه ساخت توپ بلٌارد آموزش داده مً شود

 .حق كپً راٌت را با درج لٌنك نوٌسنده و ساٌت فراموش نكنٌد
 

 
 
 

 ساخت افكت لاستٌكً بر روي اشكال و متون
 
 

 

 

  
در اٌن آموزش مً توانٌد افكتً را بروي 

متن انجام دهٌد كه متن شما به صورت نوشته 
 .اي لاستٌكً به نظر برسد

http://www.ashyaneeh.com/ 

سطح مقاله متوسط 
 
 

 
  

 

. اول از هر چٌز ٌه فاٌل جدٌد باز كنٌد
من در . به هر اندازه اي كه دوست دارٌد

 رو انتخاب 500x200اٌن كار اندازه 
.  كردم

  

No Pic 
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در مرحله دوم نوبت اٌنه كه نوشته اي رو كه 
مً خواهٌد تاٌپ كنٌد، فراموش نكنٌد كه 

 .رنگ متنتون باٌد مشكً باشه 

 
 

   

 

 

تو اٌن مرحله رو لاٌه متنمون دابل كلٌك مً 
.   ها باز بشهStyleكنٌم كه لاٌه مربوط به 

 برٌد و Bevel and Embossبه قسمت 
 .تنظٌماتشو مثل شكل روبرو انجام بدٌد

 
 

 
 

 

 Gradientتو اٌن قسمت باٌد به قسمت 
Overaly برٌد تنظٌماتشو مطابق شكل 

.  روبرو انجام بدٌد

  

  

 Colorبعد از اونجام مرحله بالا به قسمت 
Overaly برٌد تنظٌماتشو مثل شكل شماره 

  . زٌر انجام بدٌد2
 

 



 

 

 2شكل شماره 
 
 

 
آخرشم ٌه چٌز تو اٌن ماٌه ها  

 

 

 Drop و Inner Shadowاٌن قسمتم باٌد 
Shadow رو هم مثل شكل هاي روبرو به 

.  ترتٌب انجام بدٌد

   

  Inner Shadow) = 1(شكل 

 Drop Shadow) = 2(شكل 

 
) 1شكل (

 
 

 
) 2شكل (

 
 

   

 

A         S           H            Y          A        N        E          E          H 

 



 

 

 
 

 

 

 
 
 

 اٌجاد قاب عكس بر روي تصاوٌر
 
 

 

 

  
در اٌن آموزش نحوه اٌجاد قاب را براي 

 .عكس ٌاد مً گٌرٌد
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خوب اول كار باٌد عكس مورد نظري رو 
كه مً خواهٌد براش قاب بسازٌد رو در 

 .محٌط فتوشاپ باز كنٌد
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تو اٌن مرحله همزمان كلٌد هاي 
Ctrl+A ٌا از منو  Select گزٌنه All 

و بعد از اون هم مسٌر . رو انتخاب كنٌد
.  زٌر رو طً كنٌد

Select>Modify>Border  

 30 تا 15متناسب با عكستون عددي بٌن 
 .رو انتخاب كنٌد

 
 

 

. اٌنجام وقتشه كه ٌه لاٌه جدٌد بسازٌد
براي اٌن كار كلٌد هاي مٌانبر  

Ctrl+Alt+Shift+N 

و ٌا اٌنكه از قسمت لاٌه ها بر روي 

Create a New Layer)   (
. كلٌك كنٌد

بعد از اٌن هم لاٌه اٌجاد شده رو با رنگ 
و با كلٌك كردن بر روي . سفٌد بپوشانٌد

و با باز . لاٌه جدٌدي كه اٌجاد كرده اٌم
شدن استاٌل مربوط به لاٌه ها و انتخاب 

گزٌنه هاي روبرو، آنها را به ترتٌب انجام 
 )3 شكل 2  و شكل 1شكل (. خواهٌم داد

 

 
 



 

 

 
) 1(شكل 
 

 
) 2(شكل 
 

 
) 3(شكل 

 

 

آخر سر هم باٌد كاراتون مثل شكل هاي 
  .زٌر بشه

 



 

 

 
 

 
 

 
 

 

 
 
 



 

 

 نحوه تٌجاد انعكاس بر روي اشكال
 
 

 

 

  
در اٌن آموزش نحوه ساخت انعكاس رو بر روي 

 .اشكال ٌاد مٌگٌرٌد
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 ٌک File<Newگام نخست شما از راه 
کلٌدهای مٌانبر (زٌد مٌساصفحه جدٌد 

Ctrl+N( . پٌکسل 400*400ابعاد آنرا 
 .انتخاب نماٌٌد

 
 
No Pic 

 
   

 

 

حال تصوٌر مورد نظر را که می خواهٌد 
شکل انعکاسی پٌدا کند از قسمت 

File<Open و ٌا کلٌدهای مٌانبر 
Ctrl+Oمن ٌه .  آدرس دهٌد تا باز نماٌد

. کوزه رو برا اٌن کار انتخاب کردم

  

 
 

 

 
احتمال دارد عکسهای باز شده بر روی 
صفحه نٌاز به تغٌٌر در ساٌز آنها باشد، 

برای اٌن کار شما از قسمت 
Edit<Transform<Scale را انتخاب 

 .در بٌاورٌد کرده و به اندازه دلخواه

 
 
 
 
No Pic 

 
 
 
   

 

 

 
 Layer<Duplicateاکنون از قسمت 

Layer را انتخاب نموده، اگر خواستٌد 
 نماٌٌد، OKنامی برای آن انتخاب کنٌد و 

حا آنرا ٌک دور بچرخانٌد ٌعنی از 
Edit<Transform<Flip Vertical را 

سپس با استفاده از ابزار . بزنٌد
Move Tool تصوٌر برعکس را به زٌر 

 .تصوٌر اولٌه بکشانٌد
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اکنون برای زٌبا سازی از 

Edit<Transform<Distort را انتخاب 
 .نموده و مانند شکل زٌر تغٌٌر دهٌد

 
 

 

برای تغٌٌر اندازه مٌتوانٌد از 
Edit<Transform<Scale را انتخاب 

 .نموده و به اندازه دلخواه درآورٌد

 
 

 

 
 

حال باٌد از محو کاری استفاده کنٌم تا 
انعکاس ما واقعی به نظر برسد، ابزار 

Gradient Tool را انتخاب نموده 
ٌعنی . و تنظٌم رنگی آنرا مثل شکل بگذارٌد

اٌنکه دست چپ رنگ کار سفٌد است و 
 ٌعنی Transparentدست راست حالت 

حال . حالتی که هٌچ رنگی نداشته باشه
ماوس را از پاٌٌن ترٌن نقطه انعکاس تا 

بالاترٌن نقطه انعکاس بکشٌد و اکنون دکمه 
چپ ماوس را رها کنٌن، تا نتٌجه کار 

 :به شکل زٌر. اٌنگونه شود

 

 
 

 
 

 

 
در نهاٌت روی بالاترٌن لاٌه کلٌک و 

از قسمت اکنون انتخابش کنٌن، 
Layer<Merge Down  را انتخاب کنٌد

  



 

 

 را بزنٌد، اٌن Ctrl+Eٌا کلٌدهای مٌانبر 
. کار باعث مٌشود دو لاٌه در هم تلفٌق شوند

 
  

 

 
  

 

 
 
 
 

 روش ساخت شمشٌر در فتوشاپ
 
 

 

 

  
.  نحوه ساخت و اٌجاد شمشٌر در فتوشاپ

 
 سطح مقاله پٌشرفته
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 600x300ٌه فاٌل جدٌد به اندازه 

فراموش نكنٌد . پٌكسل رو اٌجاد كنٌد
 رو براي زمٌنه transparentكه 

. انتخاب كرده باشٌد
 

ابزار . ٌك لاٌه جدٌد اٌجاد كنٌد
rectangle رو بر دارٌد ٌك مستطٌل 

 پٌكسل اٌجاد 60 در 450به اندازه 
.  كنٌد

را براي  B6B4B4در اٌن مرحله 
foreground 514 وF4F براي 

background  انتخاب نماٌٌد 

بروي لاٌه اي كه ساختٌد كلٌك سمت 
راست كنٌد و از منوي باز شده بر 

.  كلٌك كنٌدRasterize layerروي 
با پاٌٌن نگه داشتن كلٌد كنترل و كلٌك 

بر روي لاٌه مورد نظر آن را در 
حالت انتخاب قرار دهٌد  

 gradient toolبا استفاده از ابزار 
  --->. به كارمون رنگ مٌدٌم

   

   

 از كارمون مٌگٌرٌم Duplicateٌه 
.  و مرحله زٌر رو انجام مٌدٌم

Edit/Transform/Flip 
vertically  

خوب بعد از انجام مرحله بالا دو تا 
لاٌه رو با هم دٌگه ادغام مً 

) Ctrl+G(.كنٌم
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 



 

 

 
رو لاٌه مون كلٌك مً كنٌم تا انتخاب 

 رو بر rectangularشه بعد ابزار 
مٌدارٌم و مطابق شكل در آخر 

مستطٌل اندازه ٌك ربع رو كپً مً 
  --->.گٌرٌم

 
   

 

 

خوب اٌنجا باٌد لاٌه اي رو كه در 
آخر سر اٌجاد كردٌم رو انتخاب كنٌم 

.  و مراحل زٌر رو انجام بدٌم

Edit/Transform/Perspective  

گوشه شمت راست مربع رو با حركت 
ماوس به بالا ٌا پاٌٌن مً برٌم تا 
 . كارمون مانند ٌه مثلث اٌجاد بشه

   

اٌنجا باٌد لاٌه قبل از اٌن مثلث رو 
انتخاب كنٌد و توسط ابزار 

rectangula مانند شكل رو برو 
اونو در خالت انتخاب قرار دهٌم و با 

 اضافه كارمون deletفشردن كلٌد 
از آخر كار هم دو لاٌه . رو حذف كنٌم

  )Ctrl+G(.رو با هم دٌگه ادغام كنٌد

   

   

  

 
 
 
 
 
 
 
 
 
 
 

 
  

 

 

  

 Selectتو اٌن مرحله به منوي 
 و از   رو انتخاب كنٌدAllبروٌد و 

بعد از اٌن . كارمون ٌه كپً مً گٌرٌم
 بروٌد و ٌه Chaneelsبه قسمت 

Channels جدٌد به نام Alpha1 
اٌجاد كنٌد و كامون رو كه ازش كپً 

.  كنٌدPasteگرفته بودٌم رو اٌنجا 

رفته  Selectدر اٌن لحظه به قسمت 
.  رو انتخاب كنٌدinverseو 

خوب به قسمت مونوي لاٌه ها 
رنگً رو كه اولٌن مرحله . بازگردٌد

واستون تعرٌف كرده بودم رو دوباره 
. اٌجاد كنٌد

 
 
 



 

 

  

  

  

  

تو اٌن مرحله باٌد مراحل زٌر رو 
. انجام بدٌد

Filter/Render/Lighting 
Effects 

  

 
 

   

 
   

 
  

 

 
بعد از اٌجاد افكت بالا از كارمون ٌه 

Duplicate مً گٌرٌم opacity 
 --->.  مٌزارٌم% 25اون رو 

  

 

 
  



 

 

 

 
. مراحل زٌر رو انجام بدٌد

Filer/Add Noise (5-10). 

Filter, Blur, Motion Blur, 
Angle 0 Distance 30. 

  

  

  

  

  

  

  

ٌه لاٌه جدٌد درست كنٌد و ابزار 
rectangular بر دارٌد و مطابق 

 >.....شكل مراحل رو طً كنٌد

  

  

  

رو لاٌه مون ٌه دابل كلٌك كنٌد تا 
و . پنجره مربوط به افكت ها باز بشه

تنظٌمات اون رو مطابق شكل پاٌٌن 
. انجام بدٌد

  

  

 

  

 

 

   



 

 

 
  

 

 
تو اٌن مرحله مٌتونٌم كارمون رو هم 

تغٌٌر اندازه بدٌم و بارٌك ترش كنٌم تا 
. طبٌعً تر از قبل هم در بٌاد

  

   

 

  

 

  
 

 
 
  

 

  

 

 



 

 

 
 
 

 (جلسه دوم(نحوه ساخت شمشٌر در فتوشاپ 
 
 

 

 

  
.  نحوه ساخت و اٌجاد شمشٌر در فتوشاپ

 
 سطح مقاله پٌشرفته
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 600x300ٌه فاٌل جدٌد به اندازه 

فراموش نكنٌد . پٌكسل رو اٌجاد كنٌد
 رو براي زمٌنه transparentكه 

.  انتخاب كرده باشٌد

رو بردارٌد و  Pen Toolsابزار 
. شكل روبرو رو طراحً كنٌد

   

   

   

لاٌه تون رو انتخاب كنٌد و با پاٌٌن 
 و كلٌك كردن Ctrlنگه داشتن كلٌد 

رو لاٌه اون رو به حالت انتخاب در 
.  بٌارٌد

   

   

   

   

   

   

 Channelبعد از اون به قسمت 
 جدٌد با Channelٌه . بروٌد

.  اٌجاد كنٌدAlpha 1عنوان 
.  مراحل زٌر رو طً كنٌد

Blur/Gaussian Blur 10, 
repeat at 5, then at 
2.5.  Deselect and 
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gaussian blur at 1.  

&  

Select/Modify/Contract = 
3  

   

   

   

قسمت هاي انتخاب شده را با رنگ 
9E9C9Cپر كنٌد   .

   

  

 
 
 
 
 

 
 
 
 

   

 

 

تو اٌن مرحله به قسمت لاٌه ها بر 
 رو فشار دهٌد تا Dكلٌد . مً گردٌم

رنگ ها به عالت پٌش فرض 
.  برگردند

.  فٌلتر زٌر رو اجرا كنٌد

Filter/Render/Lighting 
Effects  

   

   

   

   

   

   

.  تنظمات مطابق شكل زٌر

 
 
 
 
 
  



 

 

   

   

   

  

 
  

 

 
تو اٌن مرحله ٌه كپً از لاٌه مون 

و اونو برعكسش مً ... مً گٌرٌم
 --->) vertically(كنٌم 

تنظٌمات (. مراحل زٌر رو طً كنٌد
 ).طبق شكل روبرو

Image/Adjust for different 
effects 

  

  

 
 



 

 

 
 

   

 
   

 
 
 
 
  

 

 
مٌتونٌد ... باقً مراحل خٌلً آسونه 

با توجه با اشكال زٌر مراحل رو 
. طً كنٌد و كارتون رو تموم كند

  

 

 
 

 
 

 
  

 
D:مً دونم ٌه مقدار مشكل بود  ولً امٌدوارم مراحل رو به خوبً انجام داده باشٌد  .

 
 



 

 

 
  

 

  

 

 

 
 
 

 در فتوشاپ CD نحوه ساخت
 
 

 

 

  
در اٌن مقاله شما نحوه ساخت سً دي 

 .را مً آموزٌد
http://www.ashyaneeh.com/ 

  

 

طبق معمول ٌك فاٌل جدٌد اٌجاد نماٌٌد 
اندازه آن بستگً به طرح شما دارد 

 در 400من براي طرح خودم انداره 
  پٌكسل رو انتخاب كردم400
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 رو بر elliptical marqueeابزار 
دارٌد و مطابق شكل داٌره اي ترسٌم 

دقت كنٌد كه داٌره مورد نظر . كنٌد
. در مركز كادر قرار بگٌره

  

  

  

  

  

  

  

  

 ---->. ٌه لاٌه جدٌد باز كنٌد

  

  

  

  

  

 رو بر دارٌد gradient toolابزار 
و مطابق شكل روبرو رنگ اون رو 

... تنظٌم كنٌد

  

 
 
 
 

 
 
 

   

  

 

 

 

 

 
به كادرمون بر مً گردٌم و مطابق 

شكل ماوس را در مركز داٌره قرار 
... داده و به طرف چپ حركت مٌدٌم

در آخر هم كارمون مانند شكل روبرو 
. مٌشه

  

 



 

 

 

 

 Foregroundتو اٌن مرحله رنگ 
و مراحل زٌر . رو سبز قرار مٌدٌم

تنظٌمات طبق شكل (. رو انجام مٌدٌم
2(<---- 

Edit/Fade Fill    ( 1شكل  ) 

  

 
 
 

 
)  1شكل (

 
) 2شكل (

  

 

 

تو اٌن مرحله باٌد مركز كارمون رو 
... طبق شكا روبرو خالً كنٌم

 اضافه ها رو Deleteبا فشردن كلٌد 
. حذف مً كنٌم

. حالت انتخاب را غٌر فعال نكنٌد

 را سفٌد Foregroundرنگ 
بعد از .  بروٌدEdit/Fillبزارٌد و به 
اون هم به 

 Select/Modify/Contract 

  را براي اون انتخاب 20 رفته و 



 

 

و باز هم با فشردن كلٌد . كنٌد
Delete كار اٌن مرحله رو به پاٌان 

 .مٌدٌم

  

  

 

 
 

 

بر روي لاٌه مون دو بار كلٌك كنٌد 
. تا پنجره مربوط به لاٌه ها باز بشه

 رو انتخاب Bevelبعد از اون هم 
كنٌد و تنظٌمات اون رو مطابق شكل 

. انجام دهٌد

  

 
 

   

 

 

 
 

  ----------->آخر كار

 

 

 
 
 

 آموزش روتوش كردن عكس در فتوشاپ
 
 

 

 



 

 

 
 
 

  )Retouch (آموزش روتوش کردن عکس 
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شما در اٌن آموزش ٌاد خواهٌد گرفت که چگونه بتوانٌدلکه های موجود در عکستون رو از بٌن ببرٌد 
.  سطح اٌن مقاله متوسط مٌباشد, کاربرد اٌن آموزش بٌشتر در عکاسی و ترمٌم عکس های قدٌمی مٌباشد

 
از اول 

 
 

از آخر 
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:  طرز روتوش کردن  

 
   

 قسمت های مورد نظر رو Soft Brush لبه نرم Brushبشٌن و با ٌه  Quick Mask Modeاول از همه وارد 
.  رنگ کنٌد

.  خارج بشٌد Quick Mask Modeحالا از حالت 

 )  Ctrl+Shift+I ( بشه select برٌد تا قسمت داخل صورت Select < Inverseبه 

 
  

   

 برٌد و به تناسب عکستون شعاع و مقدار مخلوط شدن رنگها رو Filter < Noise <Dust & Scratchesبه مسٌر 



 

 

. با هم انتخاب بکنٌد
برای اٌن عکسمون من تنظٌمات بالا رو مناسب دٌدم  

 . بکنٌنDeselect قسمتى رو که انتخاب کرده بودٌد CTRL+D حالا با 



 

 

 
عکس نهاٌی در پاٌان کار 

 

 

 
 

 

 
 
 

 .طراحً دم موش سه بعدي
 
 

 

 

) 3d(آموزش ساخت دم موش 
  

  

 

 250x250ٌه فاٌل جدٌد در اندازه 
)  B9CCD9#(با رنگ زمٌنه 

ٌه لاٌه جدٌدباز کنٌد نام .اٌجاد کنٌد
.  بزارٌدtentacleلاٌه رو مٌتونٌد 

 marqueeو با استفاده از ابزار 
tool شکل روبرو را اٌجاد 
اندازه مستطٌل اٌجاد شده .  کنٌد
18x240و آخر کار هم .  می باشد

داخل اون رو با رنگ مشکی پر 
 .کنٌد

 



 

 

 

ٌک فاٌل جدٌد اٌجاد کنٌد و طبق 
مرحله اول باز هم مستطٌل را با 

اندازه های گفته شده اٌجاد ولی اٌنبار 
  پر FCFCFC#رنگ آن را با 

 .به شکل روبرو دقت کنٌد.  کنٌد
 

 

 . مراحل زٌر را طی کنٌد

Filter>Blur>Gaussian Blur 

radius قرار دهٌد4 را برابر با , 
خوب حالا وقتش رسٌده که دو لاٌه 
ای رو که دارٌم با هم دٌگه ادغام 

حالا ما ٌه لاٌه  )Ctrl+E(. کنٌم
بٌشتر ندارٌم با استفاده از کلٌد مٌانبر 

Ctrl+D لاٌه مون رو deselect 
 .می کنٌم

 

 

تو اٌن مرحله باٌد شکل مستطٌلمون 
 مراحل زٌر رو , کنٌمdistortرو 

 .انجام دهٌد

Edit>Transform>Distort 

رو هم   SHIFT+ALTکلٌد های 
زمان با هم بگٌرٌد و توسط ماوس 

مطابق شکل روبرو گوشه کادر 
مستطٌلمون رو به طرف راست 

حرکت مٌدٌم که با کمی دقت مطابق 
 .شکل روبرو اٌجاد مٌشه

 



 

 

 

فٌلتر زٌر رو بر روی شکلمون 
 . انجام بدٌد

Filter>Distort>Shear 

 .به شکل روبرو دقت کنٌد

  

 

 

 . فٌلتر زٌر رو انجام بدٌد

Filter>Artistic>Plastic 
Wrap 

 .مقادٌر زٌر رو اعمال کنٌد

Settings: Highlight 
Strenght : 9 
Detail : 9 
Smoothness : 2  
  

 

 

در اٌن مرحله دو کلٌک بر روی 
لاٌمون مٌکنٌم تا پنجره مربوط به 

 drop shadowلاٌه ها باز بشه و 
رو فعال می کنٌم و در نهاٌت مقادٌر 

 .زٌر را اعمال کنٌد

Blend Mode: Normal 
Color: Black 
Opacity: 30 % 
Angle: 90 
Distance: 2 
Spread: 0 
 
Size: 5 

تو اٌن مرحله کارمون دٌگه تموم 
 شده 

 



 

 

 

اٌنجا من اومدم ٌه مقدار کارمون رو 
 .به سلٌقه خودم رنگ کردم

 

 

وقتی با جارو دنبال ٌه موش کنی 
 (;. آخر سر هم همچٌن چٌزی مٌشه

امٌدوارم از اٌن آموزش لذت برده 
. باشٌد

حتی از اٌن آموزش مٌشه با اٌجاد 
چند نوع دٌگه از اٌن شکل رٌشه 

سعی مٌکنم . درخت هم اٌجاد کنٌد
آموزش ساخت رٌشه درخت رو هم 

 .تو ساٌت قرار بدم

 

      

      
 

 
 
 

 نحوه اٌجاد و ساخت الكترٌسٌته اتمً
 
 

 

 

  
نحوه ساخت و اٌجاد الکترٌسٌته اتمی 

 
 سطح مقاله متوسط

WwW.AsHyaNeEh.cOm 

 

   

ٌک صفحه جدٌد در اندازه 
500x500 اٌجاد کنٌد با رنگ 

 .  13354E#زمٌنه 

رو منو ابزار ابزار 
بردارٌد و با استفاده از ٌک برش 

کوچٌک مطابق شکل روبرو 
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 .همچٌن چٌزی اٌجاد کنٌد

 
   

 

 

 
تو اٌن مرحله توسط ابزار 

smudge که در شکل مقابل هم 
مشخص شده اون رو دارٌد و 

 رو اٌجاد کنٌد ٌه 2شکل شماره 
مقدار وقت گٌره ولی دقت کنٌد 

حالا دقٌقا مثل (چٌزه خوبی مٌشه 
 ما نشد زٌاد مهم 2شکل شماره 

  ).نٌست

   

   

  

 

 
 

 
) 2شکل (

 

 

  

اٌنجا باٌد ٌه مقدار کارمون طبٌعی 
تر بشه مراحل زٌر رو انجام بدٌد 

 در 3تا کارتون مانند اٌن شکل 
. بٌاد

 



 

 

Image> 
Adjustments> 
Brightness/Contrast  

خوب بعد از اٌن مرحله بالا ٌه 
 .کار دٌگم باٌد انجام بدٌد

Image> 
Adjustments> 
Hue/Saturation 

ٌه مقدار رنگ رو به سلٌقه 
 )تٌره تر(خودتون آبی کنٌد 

  

  

  

 
 )تنظٌمات(

 
 

 
)  3شکل (

 

 

 
 از duplicateتو اٌن مرحله ٌه 

لاٌه ای که دارٌم بگٌرٌد 
)Ctrl+J(  بعد از اون هم فٌلتر

. زٌر رو اعمال کنٌد

Filter>Brush 
Strokes>Spatter 

تنظمٌات رو هم مٌتونٌد طوری 
انجام بدٌد که به نتٌجه خوب که 

 .رسٌد بعد اعمال کنٌد

  

 
No Pic 

  



 

 

 

 
امٌدوارم از اٌن آموزش لذت برده 

. باشد

اٌن آموزش جهت آشناٌی شما با 
 dodge و smudgeابزار  

بود 

 ;)موفق باشد 

  

  

 

 
    

 
 

 
 
 

 نوع دوم )انرژي(نحوه اٌجاد انفجار 
 
 

 

 

  
 2اٌجاد انفجار 

 متوسط: سطح مقاله 
WwW.AsHyaNeEh.cOm 

 

 
اول از هر چٌز ٌه صفحه جدٌد در 

توجه .  باز کنٌد250x250اندازه 
کنٌد هنگام باز کردن فاٌل 

backgroundفعال شده باشه   .

 رو برای رٌست کردن Dکراکتر 
 رنگ فشار دهٌد

 
 
 
 
 کام.آشٌانه

 

   

.  فٌلتر زٌر رو اعمال کنٌد

filter > render > clouds  

   

  

 
   

 

 

  

. فٌلتر زٌر رو اعمال کنٌد

Filter > Pixelate > 
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Mezzotint 

البته فراموش نکنٌد که از منوٌی 
 longکه داخل فٌلتر بالا بود 

linesانتخاب کنٌد  . 

  

  

 
   

 

 

 
. فٌلتر زٌر رو اعمال کنٌد

Filter > Blur > Radial Blur 

Choose 100 
zoom 
and best. 

  

  

 

 
 

   

 

 

  

 رو Ctrl+Uاٌن مرحله آخری هم 
فشار دهٌد تا کادر مربوط به 

Hue/Saturation باز بشه بعد 
Colorize رو فعال کنٌد و رنگ 

رو ٌا به آبی و ٌا به زرد تغٌٌر 
. بدٌد

امٌدوارم اٌن آموزش هم مورد 
قبول شما کاربران عزٌز قرار 

 .گرفته باشه

 

 
 

  

 
 
 



 

 

 جلوه اي از كره خاكً در فضا
 
 

 

 

  
نحوه ساخت ٌک کره خاکی در فضا 

 سطح مقاله متوسط
http://www.ashyaneeh.com/ 

 
 
 
 
 
  

 

مطابق . ٌه فاٌل جدٌد با زمٌنه مشکی باز کنٌد 
شکل روبرو ٌک داٌره رسم کنٌد و رنگ 

. ترکٌبی آن را همانند روبرو قرار دهٌد
ٌه مقدار باٌد از طرف چپ کره ما روشن 

. باشه
 

  فاٌل. و ٌا اٌنکه فاٌل روبرو رو درٌافات کنٌد
 

 

زٌر فاٌل اٌجاد شده ٌه لاٌه جدٌد اٌجاد کنٌد 
 و باز هم با رنگ مشکی اون رو پر کنٌد

 
 

 

 مراحل زٌر را طی , lens flareاٌجاد 
.  کنٌد

Filter > Render > Lens Flare 

 ...تنظٌمات مطابق شکل روبرو
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.  اٌنجا باٌد ٌه مقدار به کارمون بلور بدٌم

Filter < Blur < Gaussian blur 

 
 

 

 .کار شما تا اٌن مرحله باٌد اٌن شکلی شده باشه

 
 

 

 رو بر eraser tool ابزار ,از منوی ابزار 
دارٌد و ٌه مقدار پشت کره خاکی رو خالی 

. کنٌد
که ٌه مقدار پرتو نور خودشو واقعی تر نشون 

 .بده

 
 

 

اگر با . امٌدوارم از اٌن آموزش لذت برده باشٌد
ٌه مقدار حوصله کارتون رو مثل عکس زٌر 

اٌنم . واقعی تر در بٌارٌد کارتون زٌبا تر مٌشه
 ;). بود اٌجاد جلوه ای از کره خاکی در فضا

 
 
 
  

 

 
 

 
 
 

 اٌجاد جلوه اي خشن تر از ابرها
 
 

 

 



 

 

  
جلوه ای خشن تر از ابرها 

 سطح مقاله متوسط
http://www.ashyaneeh.com/ 

 
 
 
 
 
  

 

فاٌل مربوط به ابر خود را باز 
 مانند روبرو. کنٌد

 
 

   

 

 

در اٌن قسمت مراحل زٌر را 
.  طی کنٌد

Image > 
Adjustments > 
Levels 

 
 

 

طبق شکل روبرو تنظٌمات 
.  را انجام دهٌد

 2شکل ... که نتٌجه اون 

 
 

 
 

 
 2شکل 
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. مراحل زٌر رو انجام بدٌد
.  تنظٌمات مطابق شکل روبرو

  

 
 

 

  ;)موفق باشٌد 

به همٌن سادگی ابرهای خود را 
 .خشن تر و واقعی تر نشان دهٌد

 
 در پاٌان 

 

 
 
 

 Pen Tool معرفً ابزار, ساخت آدمك
 
 

 

 

  
 Penمعرفی ابزار . ساخت آدمک 

Tool 
 سطح مقاله متوسط

http://www.ashyaneeh.com/ 

  

 

ٌه فاٌل جدٌد باز کنٌد و اون رو با 
 .رنگ مشکی پر کنٌد
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 را از منو ابزار Pen toolابزار 
 .بردارٌد

 
   

 

 

طبق عکس های روبرو شکل 
 .مقابل را رسم کنٌد

 
 1شکل 

 
 2شکل 



 

 

 
 3شکل 

 
 4شکل 
   

 

 

 را Point Toolاٌن مرحله ابزار 
بردارٌد 

گوشه کادری که ترسٌم کردٌد کلٌد کنٌد 
 )5شکل (.و ٌه مقدار به اون انهنا بدٌد

 
 



 

 

 
 5شکل 

 
  6شکل 

 

 

 .خوب اٌن مرحله رنگشو تغٌٌر بدٌد

 
 



 

 

 

ٌه لاٌه جدٌد اٌجاد کنٌد و طبق شکل 
هدف (روبرو دو تا مثلث اٌجاد کنٌد 

  )ساخت چشم

  

.  بگٌرٌدDuplicateاز مثلث ٌه 

(right click > Duplicate 
layer),  

 ...بعد از اون هم مرحله زٌر

(Edit > Transform > Flip 
Horizontal) 

 8شکل 

  
 

 7شکل 

 
  8شکل 

 

 

.  مرحله زٌر رو انجام بدٌد

(Right click > Blending 
options).   

 .کادر مروبوط به لاٌه ها را باز کنٌد

Outer Glow  (9 شکل) 
Inner Glow  ( 10شکل  ) 

  

  

  

 
  9شکل 



 

 

  

  

  

  

  

  

  

 ;) موفق باشد
کارمون به پاٌان رسٌد امٌدوارم لذت 

. برده باشد

هدف از اٌن آموزش فقط جهت آشناٌی 
 . بودPen toolبا ابزار 

 
 10شکل 
 
 

 
 شکل پاٌان کار

 
 

 
 
 

 

   

 

 

در ابتدا رنگ مشكلً كامل را براي رنگ زمٌنه خود 
 و 800: انتخاب نماٌٌد، سپس ٌك فاٌل جدٌد با اندازه عرض

 Background Color و با انتخاب گزٌنه 300: ارتفاع
 . اٌجاد نماٌٌدContentsبراي 

 

 

: مثلا(پس از اٌجاد فاٌل متن خود را تاٌپ نماٌٌد 
MajidOnline(  و رنگ سفٌد را به عنوان رنگ متن

 را بفشارٌد تا كل Ctrl+Aسپس كلٌد هاي . انتخاب نماٌٌد
 Layer < Align Toبعد به منوي . كار انتخاب شود

Selection رفته و گزٌنه Vertical Centers را 
دوباره به همان قسمت رفته و اٌن بار گزٌنه . انتخاب نماٌٌد

Horizontal Centersاٌن گزٌنه ( . را انتخاب نماٌٌد
 در قسمت Move Toolهاي هنگام انتخاب ابزار 

Option ابزار دٌده مً شود  :

 

 



 

 

( 

 

 را بفشارٌد تا از كل كار Ctrl+Shift+Cحال كلٌدهاي 
 Ctrl+Vكپً در حافظه كپً بردارد و سپس با فشردن كلٌد 

توجه داشته باشٌد كه اٌن لاٌه حتما زٌر (.  كنٌدPasteآنرا 
 . ). قرار داشته باشدBackgroundلاٌه متن و بالاي لاٌه 

 را بفشارٌد تا لاٌه جدٌد كه ساخته اٌد و Ctrl+Eحالا كلٌد 
. شوند )Merge( با هم ٌكً شوند Backgroundلاٌه 

توجه داشته باشٌد كه حتما باٌد لاٌه جدٌدي كه اٌجاد كرده (
اٌد را انتخاب كرده باشٌد تا با لاٌه زٌر خود ٌعنً لاٌه 

Backgroundسپس مً باٌست لاٌه متن  ). ٌكً شوند
خود را مخفً نماٌٌد تا بتوانٌد راحت تر كار خود را ادامه 

كه در كنار لاٌه قرار دارد دهٌد براي اٌن كار بر روي 
 .كلٌك نماٌٌد

 

 

 خودتان ٌك Backgroundدر اٌن مرحله شما باٌد به لاٌه 
 > Filterابتدا به منوي . سري افكتها اعمال نماٌٌد

Distort < Polar Coordinates  بروٌد و گزٌنه
Polar to Rectangular را انتخاب نماٌٌد و سپس OK 

  .كنٌد

 
براي اٌنكار به .  درجه بچرخانٌد90سپس طرح خود را 

 را Image < Rotate Canvas < 90 °CWگزٌنه 
 . انتخاب كنٌد

 

 

 را Wind رفته و گزٌنه Filter < Stylizeحالا به منوي 
 را Methodدر پنجره كه باز مٌشود گزٌنه . انتخاب نماٌٌد 

 گزٌنه Direction قرار دهٌد و در قسمت Windدر حالت 
From the Right2اٌن كار را باٌد .  را انتخاب نماٌٌد 

بعد از اٌنكه اٌن كارها را انجام دادٌد به . بار انجام دهٌد
 را انتخاب From the Leftهمان قسمت رفته و گزٌنه 

بعد از انجام .  بار انجام دهٌد2اٌن كار را نٌز باٌد . نماٌٌد
 Fromاٌن كارها دوباره به همان قسمت بروٌد و اٌن دفعه 

the Rightپس در كل شما مً باٌست .  را انتخاب نماٌٌد
 را بر روي اٌن لاٌه اما هر Wind بار ٌك افكت به نام 5

  .دفعه با مقادٌر متفاوت انجام دهٌد

براي راحتً كار مً توانٌد پس از انتخاب فٌلتر و : نكته
 استفاده نماٌٌد و Crtl+Fبراي اعمال دفعه دوم از كلٌدهاي 

براي اٌنكه بخواهٌد مقادٌر فٌلتر را تغٌٌر دهٌد كلٌدهاي 
Ctrl+Alt+Fرا بفشارٌد  . 

 

 

حالا باٌد عكس طرح خود را بچرخانٌد و مانند حالت اولش 
 Image < Rotateبراي اٌنكار بر روي گزٌنه. كنٌد

Canvas < 90 °CCWكلٌك نماٌٌد . 

 

 

 Filter < Distort < Polarدوباره به قسمت 
Coordinates بروٌد و اٌن بار گزٌنه Rectangular 

to Polarرا انتخاب نماٌٌد . 

 



 

 

 

 Filter < Blur را از قسمت Radial Blurسپس گزٌنه 
 :مقادٌر آنرا مانند زٌر تغٌٌر دهٌد. انتخاب نماٌٌد

Amount: 50 
Blur Method: Zoom 
Quality: Good  

 

حالا به لاٌه متن خود بازگرٌد آنرا فعال سازٌد تا نماٌش 
مً بٌنٌد كه بدلٌل سفٌد بودن رنگ آن با طرح . داده شود 

پس رنگ متن خود را به رنگ . شما تداخل پٌدا مٌكند
 .مشكلً كامل تغٌٌر دهٌد

 

 

براي اٌن كار مً . حالا از لاٌه متن خود ٌك كپً بگٌرٌد
 بروٌد و Layer < Duplicate Layerتوانٌد به قسمت 

ٌا اٌنكه بر روي لاٌه متن كلٌك كرده و آنرا كشٌده و بر 

 .رها كنٌدروي كلٌد 
 

 

: مانند(حالا بر روي لاٌه جدٌدي كه اٌجاد نمودٌد 
MajidOnline Copy(  دوبار كلٌك كنٌد تا پنجره افكتها

 را انتخاب نماٌٌد و Outer Glowسپس گزٌنه . باز شود
 :مقادٌر زٌر را به آنها نسبت دهٌد

Blend-Mode: Screen  
Opacity: 40%  
noise: 0%  
Color: White [#FFFFFF]  
Technique: Softer  
Spread: 0%  
Size: 20px  

Contour: Linear ( )  
Anti-aliased: On (checked)  
Range: 60%  
Jitter: 0%  

 

 

براي اٌنكه بهتر متوجه منظور من بشوٌد من در اٌن عكس 
مجٌدآنلاٌن را با رنگ قرمز نوشته ام اما شما در طرح خود با 

 .همان رنگ مشكً بنوٌسٌد

: مانند(سپس به لاٌه متن اولٌه خود بازگردٌد 
MajidOnline(  حالا كلٌدهايCtrl+T را بفشارٌد و 

سپس بر روي طرح خود كلٌد سمت راست ماوس را 
براي (.  را انتخاب نماٌٌد Flip Verticalبفشارٌد و گزٌنه 

 > Edit < Transformاٌن كار شما مٌتوانٌد از راه 
Flip Verticalپس از اٌنكار لاٌه متن . ) نٌز اقدام كنٌد

خود را به سمت پاٌٌن بكشٌد تا بالاترٌن نقطه اٌن لاٌه بر 
. پاٌٌن ترٌن نقطه لاٌه متنً كپً شده مماس شود

 )طرح متن شما حالت آٌنه اي پٌدا كند" اصطلاحا(

 

 

 انتخاب Text را بفشارٌد تا ابزار Tپس از اٌن كار كلٌد 
 بروٌد و بر روي Tool اٌن Optionشود سپس به قسمت 

در پنجره اي كه باز مٌشود ابتدا . كلٌك نماٌٌدكلٌد 
سپس تمامً مقادٌر .  نسبت دهٌدStyle را به Arcگزٌنه 

 Verticalوارد شده را صفر نماٌٌد بجز مقدار 
Distortion قرار دهٌد50- كه مقدار آن را مً باٌست . 

 



 

 

 

طرح شما پس از اعمال تمام مراحل تا اٌنجا مً باٌست 
 .مانند شكل روبرو شود

 

 

. حالا موقع آن رسٌده است تا طرح خود را رنگً نماٌٌم
براي اٌن كار مٌتوانٌد از امكان جالبً كه فتوشاپ براي ما 

اٌن امكان جالب . گذاشته است استفاده كنٌم
Hue/Saturationبراي اٌن كار بر روي كلٌد .  نام دارد

 قرار دارد كلٌك كنٌد و Layersكه در پاٌٌن پنجره 
 را Hue/Saturationدر منوًٌ كه باز مً شود گزٌنه 

توجه داشته باشٌد قبل از اٌنكه اٌن لاٌه را (. انتخاب نماٌٌد
. )اٌجاد نماٌٌد مً باٌست در بالاترٌن لاٌه خود قرار بگٌرٌد

 را چك Colorizeدر پنجره اي كه باز مً شود ابتدا گزٌنه 
 :سپس مقادٌر زٌر را وارد نماٌٌد. بزنٌد

Hue: 210 
Saturation: 100 
Lightness: 0 

 .حالا دٌگر طرح شما آماده شد
 );خسته نباشٌد 

 

 

در شكل رو برو ترتٌب قرار گٌري لاٌه ها را مً بٌنٌد لاٌه 
 هاي شما نٌز باٌد به همٌن ترتٌب قرار بگٌرند

 

  

 
 
 

 . را در فتوشاپ ٌاد مٌگٌرٌدchromeTextدر اٌن درس شما طرٌقه ساخت 

 مً باشد كه با كمً تفاوت 7توجه داشته باشٌد تمامً مراحلً كه در اٌن درس ذكر مً شوند بر حسب قسمتهاي موجود در فتوشاپ 
. دٌگر فتوشاپها نٌز همٌن قسمتها را نٌز در بر دارند



 

 

. اٌن مقادٌر فقط براي مثال مً باشد, شما خودتان مً توانٌد مقادٌر ذكر شده در اٌنجا را برحسب مورد نٌاز و علاقه خود تغٌٌر دهٌد 

اٌن آموزش از ساٌت مشابه خارجً درٌافت شده و با ٌكسري تغٌٌرات به زبان فارسً ترجمه شده است از شما تقاضا دارم چنانچه از اٌن 
.  آموزش در جاًٌ دٌگر مٌخواهٌد استفاده نماٌٌد حتما نام و آدرس اٌن ساٌت را نٌز قٌد نماٌٌد

 >>>طرح شما پس از طراحً مً باٌست مانند شكل روبرو شود 
  

 

   

 

 
 و 72dpi و با 200×200براي شروع كار ٌك فاٌل با اندازه 

 . اٌجاد نماٌٌدTransparent و RGBحالت رنگ 

 

 

 عكس شماره ٌك

 بر Ctrlسپس با پاٌٌن نگاه داشتن كلٌد . متن خود را تاٌپ نماٌٌد 
حال ٌك . روي لاٌه متن خود كلٌك نماٌٌد تا متن انتخاب شود

 595959#لاٌه جدٌد درست كنٌد و در آن لاٌه با شماره رنگ 
  .محل انتخاب شده را رنگ نماٌٌد

 

 عكس شماره دو

 در همان لاٌه اي كه قرار 262626#سپس با شماره رنگ 
 :  دهٌدStrokeدارٌد به محل انتخابً خود با مقادٌر زٌر 

Edit\Stroke 

With: 5px 

Location : Inside  

 

 عكس شماره سه

بعد از آن به قسمت . سپس ٌك لاٌه جدٌد اٌجاد نماٌٌد
Select\Modify\Contract را وارد نماٌٌد 12 بروٌد و مقدار 

اٌن مقدار بستگً به قطر متن شما دارد كه مً توانٌد آنرا به مٌل (
جال در لاٌه جدٌدي كه اٌجاد نمودٌد محل  . )خود تغٌٌر دهٌد

حال متن را از حالت انتخاب . انتخابً را با رنگ سفٌد پر نماٌٌد
 )Ctrl+D(در آورٌد 

 

 



 

 

 

 عكس شماره چهار

 رفته و مقدار Filtter\Blur\Gaussian Blurحال به قسمت 
5pxبعد حالت .  را وارد نماٌٌد)mode(  لاٌه را ازnormal به 

شكل شماره (بعد لاٌه متن خود را .  تغٌٌر دهٌدOverlayحالت 
 و كلٌك بر روي لاٌه متن Ctrlرا با پاٌٌن نگاه داشتن كلٌد  )دو

 رفته و بر روي Channelsآنرا انتخاب كنٌد و سپس به پنل 
 ).( كلٌك نماٌٌد Save selection as channelكلٌد 

ٌك لاٌه دٌگر  )Alpha1(بعد از روي لاٌه جدٌد كه ساخته شد 
 را گرفته و بر روي Alpha1براي اٌن كار لاٌه . درست نماٌٌد 

ٌا  (.  بكشٌد و سپس رها نماٌٌدCreate new channelكلٌد 
اٌنكه بر روي لاٌه كلٌد سمت راست ماوس را بفشارٌد و از 

 را انتخاب Duplicate channelمنوًٌ كه باز مً شود گزٌنه 
 )نماٌٌد

: حال عملٌات زٌر را بر روي اٌن لاٌه اعمال نماٌٌد

Filter\Blur\Gaussian Blur < 9 pixels 
Filter\Blur\Gaussian Blur < 6 pixels 
Filter\Blur\Gaussian Blur < 3 pixels 

Filter\Blur\Gaussian Blur < 1 pixel 

 

 

 دٌدن عكس در اندازه بزرگتر اٌنجا كلٌك كنٌد براي

لاٌه متن خود را انتخاب نماٌٌد و .  بازگردٌدLayresحال به پنل 
 رفته و مطابق Filtter\Render\Lighting Effectsبه قسمت 

 >>>شكل روبرو عمل نماٌٌد 
 

 

 پنج عكس شماره

 را پاٌٌن نگاه دارٌد و بر روي لاٌه متنتان Ctrlجالا دوباره كلٌد 
حال به گزٌنه . كلٌك كنٌد تا انتخاب شود

Select\Modify\Contract 1 را انتخاب نماٌٌد و مقدارpx 
 را بفشارٌد كه حالت Ctrl+Shift+Iحال كلٌدهاي . را وارئ كنٌد

 را بفشارٌد تا Deleteانتخابً شما بر عكس شود سپس كلٌد 
 را بفشارٌد تا لاٌه Ctrl+Dحال . اضافه هاي لاٌه پاك گردد

Deselectشود . 
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 دٌدن عكس در اندازه بزرگتر اٌنجا كلٌك كنٌد براي

 Create new fill or adjustment layerحال بر روي كلٌد

كلٌك نماٌٌد و از منوًٌ كه باز مً شود گزٌنه  )(
Curvesتنظٌمات پنجره محاوره اي كه باز .  را انتخاب نماٌٌد

 >>>مً شود را مطابق شكل روبرو تنظٌم كنٌد 
 

 

 دٌدن عكس در اندازه بزرگتر اٌنجا كلٌك كنٌد براي

 Create new fill or adjustmentسپس دوباره بر روي كلٌد
layer كلٌك كنٌد و دورباره گزٌنه Curves را انتخاب نماٌٌد و 

 >>>مقادٌر آنرا مانند شكل روبرو تنظٌم كنٌد 
 

 

 كار نهاًٌ

 .  ما تمام شده استchromeTextخب حالا دٌگر كار ساخت 

چنانچه ماٌل به تعوٌض رنگ باشٌد مً توانٌد لاٌه متن را انتخاب 
 گزٌنه Create new fill or adjustment layerنماٌٌد و از 

Hue/Saturation را انتخاب نماٌٌد و با چك مارك زدن گزٌنه 
colorize در پنجره Hue/Saturation رنگ مورد دلخواه 

. خود را انتخاب نماٌٌد

مثلا با وارد كردن اعداد زٌر مً توانٌد طرحً مانند شكل روبرو 
: اٌجاد نماٌٌد

Hue : 0 

Saturation : 57 

Lightness+ : 51 

 

  
 

 
 
 

 . در اٌن درس شما آموزش مً بٌنٌد كه چگونه ٌك نوشته زنگ زده درست كنٌد

.   رو ٌاد مً گٌرٌد و با ٌكً از كاربردهاي آن آشنا مً شوٌدChannelدر اٌن درس كار با لاٌه هاي 

مبناي كار در اٌن آموزش بر حسب . اٌن آموزش سطح متوسطً دارد كه با كمً دقت اكثر كاربران فتوشاپ مٌتوانند آنرا انجام دهند
.   مً باشد7فتوشاپ 

طرح شما پس از كامل شدن مٌباست مانند شكل زٌر شود  
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 اٌجاد 400x400ابتدا ٌك فاٌل جدٌد با اندازه 
 هاي استاندارد فتوشاپ Actionسپس از . نماٌٌد

براي درست كردن ٌك شكل زمٌنه باشٌد استفاده  )7(
 Rusted Metalمن در اٌن تمرٌن از . كنٌد

اگر فتوشاپ خود را كامل نصب (استفاده كرده ام 
 Textures كردن اكشن Loadكرده باشٌد با 

 Presets\Photoshopموجود در شاخه 
Actions مٌتوانٌد از دسته بندي Texture گزٌنه 

Rusted Metal را انتخاب نماٌٌد تا براي شما 
 )عكس زمٌنه را بسازد

 

 

سپس ابزار متن را انتخاب كنٌد و متن خود را تاٌپ 
سپس متن با كلٌك راست كردن بر روي لاٌه . نماٌٌد

 لاٌه Rasterize Layerمتن خود و انتخاي گزٌنه 
و سپس با . متن خود را از حالت متنً خارج كنٌد

 و كلٌك بر روي لاٌه ، متن Ctrlنگاه داشتن كلٌد 
 .خود را انتخاب نماٌٌد

 

 



 

 

 

 رفته و در آنجا كلٌد Channelsحال به پنل 
Save selection as channelرا بفشارٌد  .

در . حالا ٌك لاٌه جدٌد در پنل كانالها اٌجاد مً شود
 نامٌده مً شود كه Alpha1حالت عادي نام لاٌه 

شما با دوبار كلٌك كردن بر روي لاٌه نام آنرا به 
textحالا بر روي اٌن لاٌه كلٌك كنٌد و .  تغٌٌر دهٌد

 Create newآنرا بكشٌد و بر روي كلٌد 
channel رها كنٌد تا از روي لاٌه شما كپً گرفته 

 . قرار بدهٌدlightنام اٌن لاٌه را . شود

 

 

 را Filter/Blur/Gaussian Blurحالا گزٌنه 
بعد از .  را وارد نماٌٌد8سپس عدد . انتخاب كنٌد

OK كردن كلٌد Ctrl+Alt+F را بفشارٌد تا دوباره 
 را وارد 4همٌن افكت اجرا شود و اٌن بار عدد 

 نٌز انجام 1 و 2اٌن كار را براي اعداد . نماٌٌد
 بار باٌد اٌن افكت را بر 4پس در كل شما . دهٌد

حالا كلٌدهاي .  خود اعمال نماٌٌدlightروي لاٌه 
Ctrl+Shift+Lاٌنكار سبب مً شود تا .  را بفشارٌد

Levelحالا كلٌد .  كار بصورت اتوماتٌك تنظٌم شود
Ctrl+I را بفشارٌد و بعد از آن كلٌد Del را بزنٌد 

 Ctrl+Dخب حالا كلٌد . تا دور لاٌه ما حذف شود
 .را بفشارٌد

 

 

در آنجا بر روي . حالا به پنجره لاٌه ها بازگردٌد
 پر Texture خود كه آنرا با Backgroundلاٌه 

كرده اٌد كلٌك نماٌد و آنرا بكشٌد و بر روي كلٌد 
create new layer رها كنٌد تا ٌك لاٌه جدٌد 

حالا .  بگذارٌدrustنام لاٌه جدٌد را . اٌجاد شود
براي اٌنكار (مٌتوانٌد لاٌه متن خود را مخفً كنٌد 

بر روي عكس چشمً كه در سمت چپ لاٌه وجود 
حالا گزٌنه  )دارد كلٌك كنٌد

Filter/Render/Lighting Effects را انتخاب 
توجه داشته (. سپس مقادٌر زٌر را وارد نماٌٌد. كنٌد

 را فعال نماٌٌد بعد افكت را rustباشٌد ابتدا لاٌه 
 ) اعمال شودrustاجرا نماٌٌد تا افكت بر روي لاٌه 

Light Type: Spotlight 
Intensity : 35 
Focus : 64 
Gloss : -65 
Material : 0 
Exposure : 0 
Ambiance : 25 
Texture Channel : Light (را قبلا  اٌن لاٌه
 (در كانلها ساخته اٌد
White is high : Checked 
Height : 100 

توجه داشته باشٌد انتخاب مسٌر نور پردازي بر (
عهده خودتان است كه به عنوان مثال مٌتوانٌد مانند 

 . را بفشارٌدOKحالا كلٌد  )شكل عمل كنٌد

 



 

 

 
 ها ترتٌب قرار گٌري لاٌه

حالا تقرٌبا تمام كار را انجام داده اٌد فقط ٌكم زٌبا 
كار مانده است كه مٌتوانٌد آنها را بصورت زٌر 

 را پاٌٌن نگاه دارٌد و سپس بر Ctrlكلٌد . انجام دهٌد
 )كه آنرا مخفً كرده اٌد(روي لاٌه اصلً متن خود 

سپس كلٌدهاي . كلٌك كنٌد تا آنرا انتخاب كند
Ctrl+C و سپس Ctrl+V ًرا بفشارٌد تا از آن كپ 
توجه داشته باٌد شما همچنان مً باٌست (. بردارٌد
 كرده Pasteلاٌه اي را كه . ) باشٌدrustدر لاٌه 

 . بنامٌدeffectاٌد 

 

 

 دوبار كلٌك كنٌد تا پنجره Effectحالا بر روي لاٌه 
براي اٌن كار مٌتوانٌد از (. افكتهاي لاٌه باز شود

 اٌن كار را Layer Style و سپس Layerمنوي 
 را Drop Shadowحالا گزٌنه  ).انجام دهٌد

 :انتخاب نماٌٌد ومقادٌر آنرا مانند زٌر تغٌٌر دهٌد
Blend Mode : Linear Light 
Color : 4A1E06 
Angle : -97 
Distance : 0 
Spread : 0 
Size : 5 

 



 

 

 

 را انتخاب نماٌٌد و Outer Glowحالا گزٌنه 
 :مقادٌر زٌر را وارد نماٌٌد

Blend Mode : Multiply 
Opacity : 100 
Noise : 0 
Color : FF8820 
Technique : Softer 
Spread : 0 
Size : 10 

 

 

 را انتخاب Bevel and Embossسپس گزٌنه 
 :كنٌد و مقادٌر زٌر را وارد كنٌد

Style : Inner Bevel 
Technique : Softer 
Depth : 21 
Direction : Up 
Size : 65 
Soften : 0 
Angle : -97 
Altitude : 45 
Highlight Mode : Vivid Light 
Color : FF8006 
Opacity : 100 
Shadow Mode : Multiply 
Color : 000000 
Opacity : 15 

 

 

طرح شما آماده ...  را بفشارٌدOkحالا كلٌد ... خب
  ...خسته نباشٌد... شد

حالا اگر بخواهٌد مٌتونٌد به سلٌقه خودتون 
  );طرحتونو تزٌٌن كنٌد 



 

 

   

 
 
 

 
 

Scan Lines 
 .در اٌن آموزش شما طرٌقه انداختن خطوط موزونً را بر روي شكل آموزش مً بٌنٌد

. اٌن كار باعث مً شود كار شما حالت مدرنتر و جذابتر جلوه كند

همانطور هم كه در پاٌان آموزش گفته شده است شما مٌتوانٌد بسته به طرح خود رنگها ، حالات و ٌا درصد ضفافٌت لاٌه را تغٌٌر 
. دهٌد

: طرحً مانند شكل زٌر مد نظر ما مً باشد

 
  

 

   

  
 و 2عرض ( اٌجاد نماٌٌد 2x4ابتدا ٌك فاٌل جدٌد با اندازه 

 آنرا در حالت Backgroundحالت  )4ارتفاع 
transparentقرار بدهٌد . 

 

 



 

 

 

به اندازه اي كه به . سپس محٌط كاري را بزرگ نماًٌ كنٌد 
 را Pencil Toolحالا ابزار . آن كاملا تسلط داشته باشٌد

انتخاب كنٌد و مانند شكل روبرو بالا ٌا پاٌٌن كار ٌك نقطه 
 ) باشد3دقت كنٌد كه اندازه نوك قلم باٌد (.اٌجاد كنٌد

 

 

 را بفشارٌد تا كل كار انتخاب شود Ctrl+Aحالا كلٌدهاي 
 را انتخاب Define Pattern گزٌنه Editسپس از منوي 

كنٌد و در پنجره اي كه باز مٌشود ٌك نام مناسب براي 
Patternخود انتخاب كنٌد . 

 

 

 

 

 ها Pattern شكل شما به گروه OKپس از فشردن كلٌد 
  .اضافه مً شود

 .حالا در فاٌل عكس مورد نظر ٌك لاٌه جدٌد اٌجاد نماٌٌد
 

 

  . را انتخاب كنٌدFill رفته و گزٌنه Editسپس به منوي 

 را انتخاب كنٌد و در Pattern گزٌنه Useاز قسمت 
 طرحً را كه تبدٌل به Custom Patternقسمت 

Patternسپس كلٌد .  كردٌد را از لٌست انتخاب كنٌدOK 
 .ٌا بفشارٌد

 



 

 

 

 .طرح شما مانند شكل روبرو مً شود

 

 

 را از قسمت حالات لاٌه انتخاب كنٌد overlayسپس گزٌنه 
 ) مً باشدNormalدر حالت معمولً مقدار آن (

 

 

شما (. طرح شما آماده شده و مانند شكل روبرو مً شود
مٌتوانٌد بسته به طرح خود رنگ خطوط، حالت لاٌه، و ٌا 

درصد شفافٌت لاٌه را تغٌٌر دهٌد تا شكل مورد نظر حاصل 
 )شود

 

  

 

 

 خدا به نام



 

 

 

  )CTRL+N(.  اٌجاد کنٌدپس زمٌنه دلخواه و ابتدا ٌك فاٌل جدٌد با اندازه دلخواه

.  پٌکسل و پس زمٌنه تٌره رو  انتخاب کردم300 در 300من براي کارم 

 را نگه دارٌد و با استفاده از Shiftسپس ٌک لاٌه جدٌد اٌجاد نموده و  کلٌد 
 ٌک داٌره با اندازه دلخواه بر روي لاٌه Eliptical Marquee Toolابزار 

. جدٌدي که اٌجاد نمودٌد رسم کنٌد

 را Shift+F5 تغٌٌر دهٌد و سپس کلٌد E21F01 را به Foregroundرنگ 
.  را انتخاب کنٌدForeground Colorبزنٌد و 

Menu < Edit < Fill : Color : E21F01 

 مانند شکل

1 

 

حالا بر روي لاٌه جدٌدي که اٌجاد نمودٌد دوبار کلٌک کنٌد تا پنجره مربوط به 
وارد و مقادٌر روبرو را شوٌد  Inner Glowاستاٌلها باز شود و وارد کزٌنه 

 .کنٌد
2 



 

 

 

   طرح شما مٌباٌست مانند شکل روبرو شده باشد

   

 

 ٌک داٌره کوچک تر با رنگ سفٌد بر Elipse Toolسپس با استفاده از ابزار 
 .  درصد تغٌٌر دهٌد15اٌن لاٌه را به  Opacityروي داٌره قرمز رسم کنٌد و 

 

3 



 

 

 

 با MARQUEE TOOL و ٌا PEN TOOL و حالا با استفاده از ابزار 
 . اٌن لاٌه را برش کاري کنٌد تا براق شود )و ٌا همانند شکل(سلٌقه خودتون 

 همانند شکل

4 

 

 را انتخاب کنٌد و با 235676#و در آخر براي طراحً لوگوي فلش رنگ 
 . را ترسٌم کنٌدF ٌک PEN TOOLاستفاده از ابزار 

شکل نهاًٌ 

 

 ؛ بر روي همٌن لاٌه دوبار کلٌک کرده تا پنجره مربوط به Fبعد از ترسٌم 
 Gradient و Inner Glow و Inner Shadowگزٌنه . استاٌلها باز شود

Overlayرا انتخاب و مقادٌر را همانند من وارد کنٌد . 

5 



 

 

 

 

  پاٌان کار

شما پس از پاٌان اٌن . طرح روبرو ٌك نمونه از همٌن آموزش است 
 .آموزش طرحً مانند روبرو را خواهٌد داشت

 موفق و پٌروز باشٌد

 



 

 

 
 

 

 
 
 

 

 پٌكسل اٌجاد 300x300ابتدا ٌك فاٌل با اندازه 
رنگ   وForegroundسپس رنگ . نماٌٌد

Background را در حالت سٌاه و سفٌد قرار 
 را بفشارٌد تا به حالت Dٌا كلٌد (دهٌد 

پٌش فرض تبدٌل شود ٌا اٌنكه بر روي آٌكون 
 ).كوچك آن كلٌك كنٌد

1 

 

 گزٌنه Filter<renderسپس از منوي 
clouds را انتخاب كنٌد . 

2 

 

 Image < Adjustmentحالا از منوي 
در .  را انتخاب كنٌدColor Balanceگزٌنه 

 50و در مربع سوم عدد - 50مربع اول عدد 
 Tone Balanceسپس حالت . را وارد كنٌد

 تغٌٌر دهٌد و در آن مقدار Shadowsرا به 
دوباره مقدار .  قرار دهٌد50خانه سوم را 

Tone Balance را تغٌٌر دهٌد و در حالت 
Highlightsاٌن بار هم در خانه .  قرار دهٌد

 . را وارد كنٌد50سوم عدد 

3 



 

 

 

 filter < distort < ocean rippleحالا به 
 و 6 را برابر ripple sizeمقدار  .بروٌد
 قرار دهٌد و 14 را برابر magnitudeمقدار 
 . كنٌدOKسپس 

4 

 

در آخر هم براي اٌنكه تكستچر شما زٌبا تر شود از 
 Auto گزٌنه Image < Adjustmentمنوي 

contrastرا انتخاب كنٌد . 

 

 
 
 
 

    

  

 و مقادٌر زٌرا تغٌٌر Filter <Texture <Grain پٌکسل باز کرده سپس به منوی 250 * 200ٌک صفحه به اندازه 

 : دهٌد

Intensity = 100  

Contrast = 100  

Grain Type = Vertical 
 

> Filterسپس به منوی .  را به سٌاه تغٌٌر دهٌدBackground را به رنگ سبز و رنگ Foregroundرنگ 
Artistic <Neon Glowرفته و مقادٌر زٌرا تغٌٌر دهٌد . 

Glow Size = 5  

Glow Brightness = 15  

 . انتخاب کنٌدGlowرنگ سبز را برای 
 

 .  رفته و مقادٌر زٌرا تغٌٌر دهٌدFiler <Stylize< Glowing Edgesبه منوی 

Edge Width = 1  

Edge Brightness = 15  

Smoothness = 1  

 : در نهاٌت شکل شما به صورت زٌر خواهد بود

   

 

 

 



 

 

  
  

 
 
 

 

    

  

 

سپس به .  اٌجاد كنٌد480x100در ابتدا ٌك فاٌل با اندازه 
 \ Preferences رفته و از آنجا گزٌنه Editمنوي 

Guides & Gridسپس در قسمت .  را انتخاب كنٌد
Gridline  every و سپس 20 عدد Pixel را انتخاب 

حالا .  را وارد كنٌد1 نٌز مقدار Subdivisionsبراي . كنٌد
براي .  را بفشارٌد تا به محٌط فتوشاپ بازگردٌدOKكلٌد 

 رفته و از آنجا گزٌنه View به منوي Gridفعال سازي 
Show \ Grid را انتخاب كنٌد و ٌا از كلٌد مٌانبر 

+'Ctrl+Altاستفاده كنٌد . 

 

 

 Right ٌك بار Rectangle Toolحالا بر روي ابزار 
Clickاز منوًٌ كه باز مٌشود گزٌنه .  كنٌدRounded 

Rectangle Toolرا انتخاب كنٌد . 

  

 پٌكسل 30 را به Radius ابزار مقدار Optionدر قسمت 
. تغٌٌر دهٌد

 

 خانه عمودي مربعً رسم 3 خانه افقً و 5حالا به تعداد 
 خود را Foregroundتوجه داشته باشٌد كه رنگ (. كنٌد

 )در حالت مشكً قرار دهٌد

 

 

 Subtract from ابزار گزٌنه Optionحالا از قسمت 
Shapeبا انتخاب اٌن گزٌنه شما هر شكلً .  را انتخاب كنٌد

براي تفهٌم بٌشتر از . را كه بكشٌد از شكل قبلً كم مٌكند 
 خانه عمودي و 1وسط شكلً كه در قبل اٌجاد كردٌد مقدار 

 .  خانه افقً ٌك مربع رسم كنٌد3

 

 

 

حالا باٌد از روي اٌن طرحً كه رسم كرده اٌد چند ... خب 
اما قبل از كپً برداري بر روي . تاي دٌگر هم كپً بردارٌد

 Right Clickلاٌه اي كه شكل در آن وجود دارد ٌك بار 
 Shape 1اگر نام لاٌه را عوض نكرده باشٌد نام آن (كنٌد 
.  را انتخاب كنٌدRasterize Layerو سپس گزٌنه  )است

 را V را انتخاب كنٌد ٌك كلٌد Move Toolحالا ابزار 
 را پاٌٌن نگاه داشته Alt+Shiftدر حالً كه كلٌد . بفشارٌد

با اٌن كار از روي . اٌد لاٌه را ٌك خانه سمت راست بكشٌد
اٌن كار را دوبار دٌگر انجام . لاٌه شما ٌك كپً بر داشته شد

 لاٌه جدٌد اٌجاد 3حالا .  تا شود4دهٌد تا تعداد شكلهاي شما 

 

 



 

 

 را بفشارٌد Ctrl+Eبه بالاترٌن لاٌه بروٌد و كلٌد . شده است
اٌن كار باعث مٌشود كه لاٌه انتخابً با لاٌه قبل خود 

Mergeبار دٌگر انجام دهٌد تا تعداد 2اٌن كار را .  شود 
در اصل شما دو لاٌه (لاٌه هاي شكل شما فقط ٌكً شود 

 Shape و دٌگري لاٌه Backgroundدارٌد ٌكً لاٌه 
1(  

 

 

براي اٌنكار از وسط . حالا باٌد حلقه هاي مٌانً را اٌجاد كنٌم
حلقه هاي قبلً ٌك مستطٌل دٌگر با استفاده از ابزار 

Rounded Rectangle Tool خانه عمودي 1 با اندازه 
اٌن كار را باٌد .  خانه افقً مانند شكل روبرو رسم كنٌد5و 

حالا تمام . انقدر ادامه دهٌد تا تمام حلقه ها به هم متصل شوند
لاٌه هاًٌ كه براي شكل اٌجاد شد را از روشً كه در مرحله 

 كنٌد و سپس همه آنها را Rasterize Layerقبل گفته شد 
 لاٌه دارٌم كه ٌكً لاٌه 3حالا ما فقط . به هم بچسبانٌد

Background ًماست ٌكً لاٌه مرحله قبل ٌعن Shape 
 و ٌكً دٌگر لاٌه اٌست كه از اٌن مرحله حاصل شد و نام 1

 . استShape 2آن 

 

 

مٌتوانٌد آنرا غٌر فعال .  ندارٌد Gridاكنون دٌگر نٌازي به 
حالا بر روي لاٌه .  را بفشارٌدCtrl+Alt+'كلٌد هاي  . كنٌد

Shape 1 خود دوبار كلٌك كنٌد تا پنجره Styleباز شود  .
 را انتخاب Inner Glowدر پنجره اي كه باز شد گزٌنه 

  .كنٌد و سپس تنظٌمات آنرا مانند شكل روبرو تغٌٌر دهٌد



 

 

 

 را تٌك بزنٌد و Bevel and Embossسپس گزٌنه 
 .تنظٌمات آنرا مطابق شكل روبرو تغٌٌر دهٌد

 

 
1شكل    

 
2شكل   

طرح .  را بفشارٌد تا به محٌط فتوشاپ برگردٌدOkحالا كلٌد 
حالا بر روي . )1شكل (شما مانند شكل روبرو شده است 

كه در همان لاٌه اي كه افكتهاي مرحله قبل را شكل 
 Right Clickاعمال كرده اٌد نماٌش داده مٌشود ٌك بار 

 Copy Layer Styleاز منوًٌ كه باز مٌشود گزٌنه . كنٌد
 رفته و بر روي Shape 2سپس به لاٌه . را انتخاب كنٌد

 كنٌد و از منوًٌ كه باز مٌشود گزٌنه Right Clickلاٌه 
Paste Layer Style را انتخاب كنٌد تا افكتهاًٌ كه بر 

روي لاٌه اول انجام داده بودٌد بر روي لاٌه دوم نٌز انتقال 
 . مٌشود2با اٌن كار طرح شما مانند شكل . پٌدا كند

 

 

 تغٌٌر دهٌد و 830000# را به Backgroundرنگ 
 Distort \ Ocean بروٌد و گزٌنه Filterسپس به منوي 

Rippleمقدار .  را انتخاب كنٌدRipple Size و Ripple 
Magnitude قرار دهٌد و كلٌد 9 را OKاٌن .  را بفشارٌد

پس از انجام اٌن (كار را بر روي هر دو لاٌه انجام دهٌد 
فٌلتر براي اعمال آن بر روي لاٌه دٌگر براي راحتً كار 

 را بفشارٌد تا آخرٌن افكتً كه اعمال Ctrl+Fكافٌست كلٌد 
  )كرده اٌد را بر روي لاٌه حاضر نٌز اعمال كند

 

 

 Noise \ Add بروٌد و گزٌنه Filterحالا دوباره به منوي 
Noiseمقدرا .  را انتخاب كنٌدAmount 14 را برابر 

 را در حالت Distributionقرار دهٌد و حالت 
Gaussianدر آخر هم گزٌنه .   قرار دهٌد

Monochromaticمانند مرحله قبل اٌن .  را تٌك بزنٌد
 .افكت را بر روي لاٌه دٌگر نٌز اعمال نماٌٌد

 



 

 

 ;(فقط نٌاز به كمً تزٌٌن دارد . حالا دٌگر طرح ما آماده شد  

 

 

     

  

 
 
 

 

    

  

  
 پٌکسل با زمٌنه اي سفٌد ۲۸۰ در۱۲۰صفحه اي را به اندازه 

 خود را به اٌن رنگ Forgroundسپس رنگ .باز کنٌد
F7AB5F و Backgroung را به F7DB7Fتغٌٌر دهٌد . 

 

  

براي اٌجاد .  تغٌٌر دهٌدtipٌک لاٌه جدٌد بسازٌد و نام آنرا به 
 را New <Layer رفته و گزٌنه Layerلاٌه جدٌد به منوي 

سپس در پالت لاٌه ها بروي لاٌه جدٌد کلٌک . انتخاب مً کنٌد
سپس با استفاده از ابزار انتخاب .  تغٌٌر دهٌدtipکرده و آنرا به 

 پٌکسل انتخاب مً ۷۹در۲۳مربع شکل محٌطً را به اندازه 
پس از انتخاب محٌط انتخاب شده را با رنگ . کنٌد

Foregroundپر کنٌد   .
 را Noise < Add Noiseبعد به منوي فٌلتر رفته و گزٌنه 

 ,Amout= 5: انتخاب کرده و موارد زٌرا تغٌٌر دهٌد
Distribution= Gaussian و Monochromatic را از 

 .حالت انتخاب خارج مً کنٌم

 

 

 تغٌٌر paperدوباره ٌک لاٌه جدٌد ساخته و نام آنرا به 
توسط ابزار انتخاب مربع شکل، مربعً را به اندازه . مٌدهٌم

 پٌکسل اٌجاد کنٌد و محٌط انتخاب شده را با رنگ ۱۶۶ در۲۳
 رفته و Editبراي اٌنکار مً توانٌد به منوي . سفٌد پر کنٌد

 را Ok انتخاب کرده Fill < Contents < Whiteسپس 
بعد از آن پاٌٌن محٌط انتخاب شده را را به بالا . کلٌک کنٌد

 .فٌلتر سٌگار وصل مً کنٌد
 

 



 

 

 

 paper و tipبعد از آنکه مراحل قبل را تمام کردٌد لاٌه هاي 
بعد از آن، اٌن فاٌل .کنٌد )ادغام( mergeرا به هم 

gradientرا دانلود کرده و آنرا نصب کنٌد . 

:  روش نصب
) Zip(بعد از اٌنکه فاٌل را دانلود کردٌد آنرا از حالت فشرده 

 Gradientسپس فتوشاپ را باز کرده ابزار  . خارج سازٌد
 ابزار بروٌد در Optionرا انتخاب كنٌد و سپس به قسمت 

 بر روي فلش كوچكً كه در بالا و Gradientقسمت انتخاب 
سمت راست پنجره وجود دارد كلٌك كنٌد سپس بروي گزٌنه 

Load ًکلٌک کرده و آدرس فاٌل خود را نوشته و آنرا باز م 
 .کنٌد

 

  

 را انتخاب کرده و کمً قبل و کمً Gradientبعد از نصب 
 .بعد از محٌط اتنخاب کشٌد تا شکل شما به صورت زٌر شود

 modeسپس آنرا از حالت انتخاب خارج ساخته بعد به گزٌنه 
  . انتخاب مً کنٌدMultiplyرفته و آنرا به حالت 

 

بعد از آن ٌک لاٌه جدٌد دٌگري را ساخته و طبق شکل با 
براي . انتخاب ابزار سلکتشن مربع شکل شکلً را مً کشٌد

 > imageعوض کردن رنگ نخ دور سٌگار به منوي 
adjust > hue/satursation رفته و colorize را فعال 

  . آنرا پر خواهٌد کرد )طلاًٌ(کرده و باستفاده از رنگ زرد 

 

حالا نوبت به کشٌدن توتون سٌگار رسٌده، براي اٌنکار ٌک 
لاٌه جدٌد ساخته و طبق شکل قسمت بالاًٌ سٌگار را انتخاب 

سپس به منوي .  آنرا پر کنٌد9E5F36کرده و سپس با رنگ 
Filter < Noise < Add Noise رفته و اندازه ها را به 

 .صورت زٌر تغٌٌر خواهٌد داد

Amount=26, Distribution=Gaussian و 
Monochromaticرا انتخاب کنٌد  .

سپس به سلٌقه خود قسمتً از اٌن رنگ را پاک کنٌد، در نهاٌت 
 .شکل شما به صورت زٌر خواهد شد

 



 

 

 

  

 
 
 

 

    

  

 

سپس کلٌد .  پٌکسل باز کنٌد۳۰۰×۳۰۰صفحه ای را به اندازه 
Dبه منوی فٌلتر رفته و گزٌنه .  را فشار دهٌدRender < 

Cloudsرا انتخاب کنٌد . 

 

  
 رفته و نمودار را به image<adjustments<curvesبه 

 .صورت شکل روبرو تبدٌل کنٌد

 

  

.  را نتخاب کنٌدColor Range رفته و Selectبه منوی 
البته اٌن مقدار ( تغٌٌر دهٌد ۲۰۰ را به fuzzinessمقدار 

و گزٌنه  )بستگی به صورت ابری که شما ساخته اٌد دارد
Selectرا به حالت انتخاب قرار دهٌد . 

 

  



 

 

  
 تغٌٌر دهٌد ۲ رفته و مقدار را به Select < Featherبه 

توجه داشته .  بروٌدFilter<Render<Cloudsسپس به 
 .باشٌد شکل خود را از حالت انتخاب خارج نسازٌد

 

  

 > Filter < Render و سپس به Select < Inverseبه 
Difference Cloudsبه .  بروٌد

Image<Adjustments<Hue&Saturation رفته و 
 :سپس مقدار زٌرا تغٌٌر دهٌد

Hue = 146, Saturation = 50, Lightness = -7 و 
Colorizeرا انتخاب کنٌد . 

 

  
 رفته و مقدار Filter < Noise < Add Noiseبه 

)Uniform,Monochromatic, 20( سپس . را تغٌٌر دهٌد
 . بروٌدFilter < Texture < Craquelureبه 

 

  

 را برگزنٌد، بعد به Inverse رفته و Selectبه منوی 
Image< Adjustments <Hue&Saturation بروٌد و 

: مقدار زٌرا تغٌٌر دهٌد
Hue = 202 ,Saturation = 61, Lightness = 8 و 

Colorizeسعی کنٌد تا رنگ به صورت (.  را انتخاب کنٌد
 )آبی تبدٌل شود

 

 

 رفته و مقدارها را Filter <Distort <Ocean Rippleبه 
.   تغٌٌر دهٌد۱۰ و ۲به 

. بعد از اتمام اٌن مراحل شکل را از حالت انتخاب خارج سازٌد
 .در پاٌان شکل شما شبٌه شکل روبرو خواهد بود

 

 

 > Filterاگر هم دوست داشته باشٌد می توانٌد با رفتن به 
Distort < Spherizeشکل را به صورت کره تبدٌل کنٌد  .

پس از آنکه اٌن فٌلتر را اعمال کردٌد با انتخاب ابزار سلکت 
داٌره ای، داٌره ای را به اندازه کره زده و سپس با فشار دادن 

 سلکت را وارونه کرده Shift + Ctrl + Iٌک زمان کلٌدهای 
در پاٌان شما کره ای .  را فشار دهٌدDeleteو سپس کلٌد 

 .همانند شکل زٌر خواهٌد داشت
 

 



 

 

 
 

 
 
 

 

    

  

  
من دراٌنجا . ابتدا ٌك فاٌل جدٌد با اندازه دلخواه اٌجاد نماٌٌد

 . را انتخاب كرده ام640×480اندازه 

 

 

 را انتخاب كنٌد و Horizontal Text Toolسپس ابزار 
رنگ مورد نظر خود را نٌز . متن خود را تاٌپ نماٌٌد

براي واضح بودن طرح بهتر است از ٌك . انتخاب كنٌد
 .استفاده كنٌد ) 150ptمثلا (فونت تو پر با اندازه بزرگ 

 

  

سپس بر روي لاٌه كلٌد سمت راست ماوس را بفشارٌد و 
حالا لاٌه را .  را انتخاب كنٌدRasterize Layerگزٌنه 
drag كنٌد و بر روي كلٌد Creat a new layer رها 

 .كنٌد تا ٌك لاٌه جدٌد اٌجاد شود
 

 

حالا دو لاٌه را با هم لٌنك كنٌد بدٌن صورت كه در پنجره 
لاٌه ها، در آن خانه اي كه كنارش ٌك عكس چشم وجود 

بدٌن صورت ٌكً از لاٌه هاي ما در اٌن . دارد كلٌك كنٌد

حالا كلٌد . دارددارد و دٌگري شكل خانه شكل 
 Free را با هم بفشارٌد تا حالت Ctrl+Tهاي 

Transform سپس كلٌد هاي .  انتخاب شود
Ctrl+Shift+Alt را با هم نگاه داشته و بر روي گره 

سمت راست پاٌٌن شكل كلٌك كنٌد و آنرا به سمت راست 
سپس كلٌدها را . تا حدي كه شكل متن به هم نخورد، بكشٌد

رها كنٌد و بر روي گره وسط بالا كلٌك كنٌد و آنرا به 
 Enterپس از رسٌدن به شكل مطلوب كلٌد . پاٌٌن بكشٌد
 .را بفشارٌد

 

 

حالا لاٌه ها را از حالت لٌنك بودن با ٌكدٌگر خارج كنٌد 

سپس بر روي لاٌه متن  )كلٌك كنٌدبر روي شكل (
در پنجره . زٌرٌن دوبار كلٌك كنٌد تا پنجره افكتها باز شود

 را تٌك Bevel and Embossاي كه باز مٌشود گزٌنه 
نٌاز به تغٌٌري در تنظٌمات ( را بفشارٌد OKبزنٌد و كلٌد 

 انتخاب Arrow Toolمطمئن شوٌد كه ابزار  )آن ندارٌد
 9حالا .  را بفشارٌدVشده است اگر اٌنطور نٌست كلٌد 

اٌن نكته را ٌاد ( را بفشارٌد Down Arrowبار كلٌد 
 همان كلٌدهاي Down Arrowآورد شوم كه منظورم از 

تا لاٌه مقداري پاٌٌن  )مكان نما بر روي صفحه كلٌد است
 .آٌد

 

 

 Up بار كلٌد 9 را پاٌٌن نگاه دارٌد و Altحالا كلٌد 
Arrowبا .  كه بر روي صفحه كلٌد شما است را بفشارٌد
 . پٌكسل اٌجاد مٌكنٌد1 لاٌه جدٌد هر ٌك با فاصله 9اٌنكار 

 

 



 

 

  

... همٌن بود; (تمام شد دٌگه منتظر چً هستٌد .. خب
فقط ٌك نكته رو ... امٌدوارم كه بدردتون خورده باشه

عرض كنم كه  براي اٌنكه كارتون راحت تر باشه و بتونٌد 
بعدا روي متن كار كنٌد تمام لاٌه هاًٌ كه اٌجاد شده را 

ٌكً كنٌد براي اٌنكار همه آنرا را با هم لٌنك كنٌد و سپس 
 . را بفشارٌدCtrl+Eكلٌد 

 

  
فقط من ... اٌن هم از طرح بوجود آمده از تمرٌن اٌن جلسه

 (;ٌكم اونو تزٌٌنش كردم

 

 
   

  

 
 
 

 

    

  

 

  طراحً Resolutionطبق معمول ٌك فاٌل جدٌد با 
اندازه آن بستگً .  اٌجاد نماٌٌد72dpiمخصوص وب ٌعنً 

 پٌكسل را 300*209من در اٌنجا اندازه . به طرح شما دارد
 .انتخاب كرده ام

 

 

اگر اٌن پنل در پنلهاي موجود ( بروٌد Channelsبه پنل 
 رفته و از آنجا گزٌنه Windowشما پٌدا نمٌشود به منوي 

Channelكه در سپس بر روي كلٌد  ). را انتخاب كنٌد
 Create a newكلٌد (. پاٌٌن پنل وجود دارد كلٌك كنٌد

channel (  سپس ابزارText را انتخاب كنٌد و متن مورد 
 Ctrl+Dو پس از اتمام كلٌد هاي . نظر خود را تاٌپ نماٌٌد

 .را بفشارٌد تا متن شما از حالت انتخاب خارج شود

 

 



 

 

 

 رفته و گزٌنه Filterسپس به منوي 
Distort  <  Ripple...  مقادٌر آنرا به . را انتخاب كنٌد

 . را بفشارٌدOKهمان حالت پٌش فرض رها كنٌد و كلٌد 
 

 

 > Blur رفته و گزٌنه Filterسپس به منوي 
Gaussian  Blurمقدار .  را انتخاب كنٌدRadius آنرا 

 . قرار دهٌد6برابر 

 

 

 را بفشارٌد تا پنجره مربوط به Ctrl+Lحالا كلٌدهاي 
ٌااٌنكه از منوي .  نماٌش داده شودLevelتنظٌمات 

Images گزٌنه Adjustment و سپس گزٌنه Levels را 
مقادٌر آنرا به ترتٌب از سمت چپ به راست . انتخاب كنٌد

 :برابر مقادٌر زٌر قرار دهٌد

Input Levels: 120, 1.00 , 140 

 

 

 را پاٌٌن نگاه داشته اٌد بر روي Ctrlحالا در حالً كه كلٌد 
اضافه كردٌد كلٌك  )Channels(لاٌه اي كه در پنل كانالها 

 RGBسپس بر روي لاٌه . كنٌد تا متن داخل آن انتخاب شود
اٌن لاٌه بالاترٌن لاٌه موجود در پنل (. كلٌك كنٌد

Channelsاست .( 

 بازگردٌد و ٌك لاٌه جدٌد با كلٌك Layersسپس به پنل 

 را بفشارٌد تا Dحال كلٌد . اٌجاد كنٌدكردن بر روي 
سپس . رنگهاي پالت شما به حالت پٌش فرض تبدٌل شوند

 را بفشارٌد تا محلً كه انتخاب Alt+Backspaceكلٌدهاي 
 را Ctrl+Dحالا كلٌد . شده است با رنگ مشكً پر شود

 .بفشارٌد تا محدوده از حالت انتخاب خارج شود

 



 

 

 

كه در پاٌٌن پنل لاٌه ها وجود دارد سپس بر روي كلٌد 
 Dropكلٌك كنٌد و سپس از منوًٌ كه باز مٌشود گزٌنه 

Shadowمقادٌر آنرا مانند شكل روبرو .  را انتخاب كنٌد
 .تنظٌم كنٌد

 

 

 را انتخاب كنٌد و مقادٌر آنرا Inner Shadowسپس گزٌنه 
 .مانند شكل روبرو تنظٌم كنٌد

 

 

 را انتخاب كنٌد و مقادٌر آنرا Inner Glowسپس گزٌنه 
 .مانند شكل روبرو تنظٌم كنٌد

 



 

 

 

 

 بروٌد و سپس Bevel and Embossسپس به گزٌنه 
 Glossحالت . تنظٌمات آنرا مطابق شكل روبرو تغٌٌر دهٌد

Contour را نٌز مطابق شكل زٌر تغٌٌر دهٌد و ٌا اٌنكه 
 .فاٌل آنرا از از اٌنجا درٌافت كنٌد

 

 Bevel and را از همان قسمت Textureسپس گزٌنه 
Emboss براي .  را انتخاب كنٌدPattern اٌن قسمت بر 

 وجود دارد كلٌك كنٌد Patternروي فلشً كه در كنار شكل 
سپس در سمت راست و بالاي منوًٌ كه باز مٌشود ٌك فلش 

بر روي آن فلش كلٌك كنٌد حالا . كوچك دٌگر وجود دارد
كه در حالت عادي آخرٌن گزٌنه اي ( Texture Fillگزٌنه 

را  )است كه در منوًٌ كه باز مٌشود نماٌش داده مٌشود
 موجود در لٌست را Patternحالا اولٌن . انتخاب كنٌد
.  انتخاب كنٌد

 

 

 

 را انتخاب كنٌد و مقادٌر آنرا مانند شكل Stainحالا گزٌنه 
 .روبرو تغٌٌر دهٌد

 

 

 را Color Overlayحالا به عنوان آخرٌن كار گزٌنه 
 .انتخاب كنٌد و تنظٌمات آنرا مطابق شكل روبرو تغٌٌر دهٌد

 

  



 

 

 
 
 

 خدا به نام

ً آموزش ساخت  افكت پلاسماٌ

 . اون رو سٌاه قرار بدٌن Background colorو #  747474 اون رو برابر Foreground Color اٌجاد كنٌن و 400 در 400ٌك صفحه جدٌد در اندازه 

: تا اٌنجا طرحتون باٌد اٌن شكلً از آب در بٌاد .  فٌلتر رو دوباره روش اجرا كنٌن Ctrl+F رو روش اعمال كنٌن و با كلٌدهاي Filter<Render<Cloudsحالا فٌلتر 

 

: حالا فٌلترهاي زٌر رو روش اعمال كنٌن 

 

Filter<Artistic<Plastic Wrap 

highlight Strength : 9 

Detail : 1 

Smoothness : 15 



 

 

 

 

Filter<Sketch<Chrome 

Detail : 0 

Smoothness : 0 

 



 

 

 

 : رو بزنٌن و تنظٌمات اون رو مثل شكل انجام بدٌن Ctrl+Uحالا كلٌدهاي 

 

.  تغٌٌر بدٌن Color Dodge اون رو به Modeحالا از لاٌه ٌه كپً بگٌرٌن و 

: ترتٌب لاٌه هاتون باٌد مثل تصوٌر زٌر بشه . كم كنٌن  % 50 اون رو تا Opacityحالا از اٌن لاٌه جدٌد ٌك كپً بگٌرٌن و 

 

. منتظر بعدي باشٌن . دٌگه تموم شد 



 

 

 

 
 
 
 

 

    

  

  
 800*600در ابتدا ٌك فاٌل جدٌد اٌجاد با اندازه 

 .و با رنگ زمٌنه مشكً اٌجاد كنٌد

 

 

سپس مطابق شكل روبرو با استفاده از ابزار 
Rectangle Tool ٌك مستطٌل بارٌك عمودي  

 . اٌجاد كنٌد000CFFبا شماره رنگ 
 

 

سپس لاٌه اٌجاد شده را كه در آن همٌن مستطٌل 
  كنٌد Duplicateآبً رنگ شما قرار دارد را  

براي اٌن كار لاٌه مورد نظر را گرفته و بر (
 بكشٌد و Create a new layerروي كلٌد 

 بار انجام دهٌد تا تعداد 3اٌن كار را  )رها كنٌد
 5 مجموعا Backgroundلاٌه هاي شما با لاٌه 

حالا لاٌه هاي اٌجاد شده را به ترتٌب . لاٌه شود
 Ctrl+Tبراي چرخاندن كلٌدهاي (زٌر بچرحانٌد 

 و در Optionرا بفشارٌد و بعد در قسمت 
 ) مقادٌر زٌر را وارد كنٌدRotateقسمت 

 درجه 45:  شده Duplicateاوٌل لاٌه 
 درجه 90:  شده Duplicateدومٌن لاٌه 
 درجه 135:  شده Duplicateسومٌن لاٌه 

 

 



 

 

) Backgroundبه جز لاٌه (حالا تمام لاٌه ها 
براي اٌنكار ابتدا آنها را (.  كنٌدMergeرا با هم 

 ) را بفشارٌدCtrl+Eلٌنك كنٌد به هم و بعد كلٌد 

 

 رفته و گزٌنه Filterحالا به منوي 
Blur<Gaussian Blur را انتخاب كنٌد و 
 وارد كنٌد و Radius را براي مقدار 13عدد 
OKكنٌد . 

 

 

 Distort<Twirl گزٌنه Filterاٌن بار از منوي 
 Angle را براي 337را انتخاب كنٌد و عدد 

 .وارد كنٌد
 

 

حالا بر روي لاٌه دوبار كلٌك كنٌد تا پنجره 
 Bevel and Embossگزٌنه . افكتها باز شود

را فعال كنٌد و آنرا به همان حالت رها كنٌد و 
 . را بفشارٌدOKكلٌد 

 

 

حالا از روي همٌن لاٌه ٌك لاٌه دٌگر اٌجاد كنٌد 
)Duplicateو بعد از انتخاب لاٌه جدٌد  )  كنٌد

 رفته و گزٌنه Editبه منوي 
Transform<Flip Horizontal را انتخاب 

  .كنٌد



 

 

 

حالا طرح شما آماده شده است به هر روشً كه 
كاري كه من كردم ; (ماٌلٌد اون رو تزٌٌن كنٌد 
 .رو در شكل روبرو مٌبٌنٌد

 

  

 
 
 

 

 

 
 
Photoshopدر برخً موارد در نرم افزار  .  اتفاق مً افتد كه شما كارهاي تكراري انجام مً دهٌد  

در انتها براي آن ٌك فٌلتر به كار .  درجه بچرخانٌد90 تصوٌر را باز كنٌد ، رنگ همه آنها را پررنگ تر كنٌد و و همگً آنها را 50به طور مثال فرض كنٌد مً باٌست 
. ببرٌد  

 
! حال فرض كنٌد تمامً اٌن اعمال اگر بخواهد توسط خود شما انجام شود چقدر طول خواهد كشٌد   
 
Action براي چنٌن مواقعً ، امكانً را در نظر گرفته با نام Photoshopنرم افزار  اٌن قسمت ، از كارهاي انجام شده شما ، تنها ٌك بار الگو برداري مً كند و مً تواند  . 

! آن هم فقط با فشردن ٌك كلٌد . عٌن همان اعمال را دوباره انجام دهد  
 

... حال بٌاٌٌد در عمل اٌن را مشاهده كنٌم   
 
. به مثالً كه من براي شما گفتم فكر كنٌد  
. اولٌن تصوٌر را باز مً كنٌم  

Action ٌك شاخه جدٌد با نام دلخواه باز مً كنٌم تا Actionسپس در پالت  من نام اٌن شاخه را  ( هاي ما در اٌن شاخه ذخٌره شوند  MajidOnline   : ) گذاشتم



 

 

 

Actionسپس ٌك  توجه كنٌد كه اٌن نام را متناسب با عملكرد آن .  جدٌد با نام دلخواه بسازٌد Action :  انتخاب نماٌٌد  
توجه كنٌد كه من نام ***  Color-Rotate-Filter .  را براي آن انتخاب كردم  

 

Action توسط شما ، Recordبلافاصله پس از فشار دادن كلٌد  . از حالا به بعد هر عملً كه شما انجام دهٌد ضبط خواهد شد.  شروع به ضبط شدن مً كند  
 
Color Balance گزٌنه Image<Adjustmentsبه طور مثال ، براي اولٌن كار ، از منوي  .  را انتخاب مً كنٌم و آن را به كار مً برٌم  
Actionبه شكل توجه كنٌد كه پس از انجام عمل ما ، ٌك عنوان به  :  اضافه كرده است  



 

 

 

توجه كنٌد كه پس از هر عمل انجام شده ، گزٌنه مربوط به آن به .  درجه تصوٌر و استفاده از ٌك فٌلتر را انجام مً دهٌم90حال اعمال بعدي ٌعنً چرخاندن  Action اضافه 
: مً شود   

 

Stopدر انتهاي كار ، براي متوقف كردن عمل ضبط ، دكمه  از اٌن پس هر زمان كه ٌك تصوٌر را باز كنٌد ، مً توانٌد تنها با انتخاب .  را فشار دهٌد Action خودتان و 
Playفشار دادن دكمه  .  ، آن اعمال را به صورت خودكار مشاهده فرماٌٌد  

 

Actionدر انتها ٌادآوري مً كنم كه ٌك  به . لذا مً توانٌد براي انجام اعمال بسٌار دقٌق از اٌن عملكرد استفاده نماٌٌد.  مقادٌر دقٌق اعمال شما را در خود نگهداري مً كند
: تصوٌر توجه كنٌد كه جزئٌات كار را به چه صورت ذخٌره كرده است   



 

 

 

Action ها در Photoshop استفاده از . اٌن نوع عملكردها محدودٌت آنچنانً ندارند و بسٌار انعطاف پذٌر مً باشند.  كاربرد بسٌار زٌادي دارند Action در كارهاي 
. طراحً و وٌراٌش مً تواند در زمان بسٌار صرفه جوًٌ كند  
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 اٌجاد کنٌد با اندازه دلخواه که من در اٌنجا ابتدا ٌک فاٌل جدٌد

را300.300ساٌز   انتخاب کردم  زمٌنه اٌن فاٌل را سفٌد انتخاب کنٌد 

اپاٌٌنر  ctrlسپس کلٌد سپس نوشته خود را با رنگ سٌاه تاٌپ کنٌد 

 لاٌه متن خود ٌک بار کلٌک کنٌد تا نوشته شما به صورت نگه دارٌد و روي

 channelکلٌک کنٌد تا به قسمتchannelانتخاب شده در آٌد سپس روي تب 

)اٌن کلٌک کنٌد که با )save selection as channelروي وارد شوٌد سپس 

 کار در قسمتchannelٌکchannelبه نامalpha 1اٌن ساخته مٌشود روي

 channelاٌن نکته لازم به ذکر هست که نرم افزار فوتوشاپ کلٌک کنٌد البته

 در قسمتchannelبا هر بار درست کردن ٌکchannelبراي آن ٌک کلٌد مٌانبر

 بصورت اختصاص مً دهدctrl+3.ctrl+2.ctrl+1.....مٌانبر که در اٌنجا کلٌد

 ctrl+4.     alpha 1روي مٌباشدحالا باٌد مسٌرهاي زٌر را برalpha 1کنٌد اجرا

 ابتدا مسٌر زٌر را اجرا کنٌد ...Filter > Blur > Gaussian Blurمقدار وRadiusرا

Image > Rotate Canvas > 90
o
 CW دهٌد سپس مسٌر زٌر3عدد  را دنبال کنٌد 

درجه مً چرخد سپس مسٌر زٌر را دنبال کنٌد90شما که با اٌن کار کار  

 ...Filter > Stylize > Windو از قسمتwind      methodرا انتخاب کنٌد و از



 

 

 قسمتfrom the left      directionرا انتخاب کنٌد سپس مسٌر زٌر را دنبال

درجه برگردد90تا دوباره کار شما  Image > Rotate Canvas > 90
o
 CCWکنٌد 

 سپس براي ادامه کار باٌد به قسمتlevels بروٌم براي اٌن کار مسٌر زٌر را دنبال

 کنٌد..Image > Adjustments > Levelsٌا از کلٌد مٌانبرctrl+lاستفاده کنٌد و آن

 .را مانند شکل روبرو تنظٌم کنٌد
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 حالا کلٌدctrlداشته و روي را پاٌٌن نگهalpha 1     channelاٌن کلٌک کنٌد تا

 channelپنل به حالت انتخاب در آٌد سپس دوباره بهlayerلاٌه برگشته و

)ٌک بار )Create a New Layerرا انتخاب کنٌد و سپس روي 
 Backgroundدکمه

 لاٌه جدٌد اٌجاد شود کلٌک کنٌد تا بعد از لاٌه بک گراند و پاٌٌن لاٌه متن شما ٌک

 کنٌد سپس مسٌر زٌر را دنبال...Select > Feather ٌا شما مٌتوانٌد از کلٌدهاي

 استفاده کنٌد مٌانبر روبرو(Ctrl+Alt+D)مقدار وFeather Radius دهٌد سپس8عدد 

 foreground colorروبرو را  به رنگ(FF0000 #)ابزار تغٌٌر دهٌد سپس

) را انتخاب کرده و مناطق انتخاب شده را با رنگ قرمز )Paintbucket Tool 

  پر کنٌد
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  به قسمت مجددCHANNELباز گشته و دکمهctrlو بر روي را پاٌٌن نگه داشته

 alpha 1 ,   channel به صورت سلکت شده در آٌد سپس کلٌک کنٌد که آن   

 لاٌه ها بروٌد و لاٌه اي که آن را در قسمت قبل با رنگ قرمز پر دوباره به قسمت

)کلٌک کنٌد )Create a New Layerکرده اٌد را انتخاب کنٌد سپس روي دکمه 

 که انتخاب کرده اٌد ٌک لاٌه جدٌد اٌجاد شود سپس مسٌر زٌر را تا بالاي لاٌه اي

 دنبال کنٌد...Select > FeatherوFeather Radiusسپس  قرار دهٌد4را برابر با 

 foreground colorرنگ را  به(FFFF00 #)ابزار تغٌٌر دهٌد سپس

)رنگ زرد راانتخاب کرده و مناطق انتخاب شده را با )Paintbucket Too 

را دوباره اجرا کنٌد با اٌن تفاوت که3پر کنٌد سپس مجدد مرحله  اٌنبار 

(# FFFFFF)را هم به رنگforeground color قرار دهٌد و1را برابر با  
Feather Radius 

  شما مانند تغٌٌر و قسمت انتخاب شده را با رنگ سفٌد پر کنٌد در نهاٌت کار



 

 

 

 شود شکل روبرو مً

 

  

4 

 لاٌه اي که قسمتهاي انتخاب شده آن را با سفٌد پر کرده اٌم سپس در حالً که

 مٌانبر انتخاب شده است دوبار کلٌدهاي(CTRL+E)اٌن کار سه را بفشارٌد که با

 با هم تلفٌق مً شوند که در کل سه لاٌه براي ما مً ماند تا از لاٌه هاي ما

  لاٌه تشکٌل دهنده آتش و دٌگري لاٌه متن ما سپس براي ٌکً بک گراند ٌکً

 ابزارهاي کامل شدن کار از مجموعهBlur ToolابزارSmudge Toolرا انتخاب کنٌد

      شعله هاي بالاي و بوسٌله اٌن ابزار

 بالا بکشٌد تا شعله ها تا حدودي شبٌه شعله هاي آتش نوشته را به طرف

 شما به صورت شکل روبرو شود شود بصورتً که کار
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 براي زٌباتر شدن شعله هاي آتش باٌد فٌلتر سپسLiquifyکنٌم را روي آن اجرا

 باٌد اٌن مسٌر را دنبال کنٌد براي اٌن کار...Filter > Liquifyٌا از کلٌدهاي مٌانبر

( )Twirl Clockwise Toolاٌن فٌلتر ابزار استفاده کنٌد در(Ctrl+Shift+X) 

را   Brush SizeوBrush Pressure  قرار دهٌد و بوسٌله اٌن50را برابر با 
 انتخاب کنٌد

 هاي آتش موجهاًٌ به طرف راست اٌجاد کنٌد سپس ابزار ابزار روي زبانه

)انتخاب کنٌد و اٌنبار بوسٌله را در اٌن فٌلتر )Twirl Counter Clockwise 
Tool  

  شکل شما اٌن ابزار زبانه هاي شعله آتش را کمً به طرف چپ موج دار کنٌد که

 شود شبٌه شکل روبرو
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 خود را انتخاب کنٌدو به قسمت در اٌنجا باٌد لاٌه متنAdd a layer styleبروٌد که

)کلٌک کنٌد )Add a layer styleپاٌٌن قسمت لاٌه ها روي دکمه براي اٌنکار در 

 و گزٌنه...Satinتنظٌم کنٌد را انتخاب کنٌد و آن را مانند شکل زٌر

 

 سپس به قسمتGradient Overlayکنٌد رفته و آن را مانند شکل زٌر تنظٌم



 

 

 

  شما مانند شکل روبرو مٌشود که در نتٌجه کار

   

  

 

  مقالات در اٌنجا کار ما به پاٌان مً رسد همٌشه اٌن را به خاطر داشته باشٌد که

  اٌنجور مقالات آموزشً ٌک شروعً براي ٌک کار و پروژه آموزشً مخصوصا

 کار با خود شماست هٌچ وقت به اجراي قطعً و بدون تغٌٌر مٌباشد که ادامه

 نکنٌد من پٌشنهاد مٌکنم که براي بار اول اٌنطور مقالات را اٌن مقالات بسنده

 قدم دقٌقا همانطور که در مقاله ذکر شده انجام دهٌد و پس از مو به مو و قدم به

 شدٌد و آن را ٌک بار تجربه کردٌد در متغٌرهاي آن دست ببرٌد اٌنکه به کار مسلط

 آنها را تغٌٌر دهٌد ٌا حتً افکتهاي بٌشتري که به ذهن شما و مانند سلٌقه خود

مٌرسد که کار را  ً   زٌباتر مٌکند روي کار اجرا کنٌد با اٌن کار شما به کارهاي خٌل
 

 
 
 

 



 

 

 

 

  پٌکسل 1024×768ابتدا ٌک فاٌل جدٌد اٌجاد کنٌد با اندازه 

(0099FF)سپس ٌک لاٌه جدٌد اٌجاد کرده و آن را با رنگ  

   پر کنٌد سپس از منويFILTERفٌلترهای و از مجموعه

  PIXELATEفٌلترColor Halftoneاٌن را برگزٌنٌد سپس

  روی لاٌه  اجرا کنٌد که فٌلتر را با تنظٌمات پٌشفرض

  مٌشود نتٌجه مانند شکل روبرو.

  
 

 

 

   برای ادامه کار به منويFILTERمجموعه رفته و از از

 فٌلترهایBLURفٌلترRadial Blurفٌلتر انتخاب کنٌد ودر اٌن

ومقدار67برابر ٌا راBlur MethodراZOOMو مقدار Amount 

 QualityراGOODروی کار خود انتخاب کنٌد واٌن فٌلتر را

 اجرا کنٌد سپس مجدد به منويFILTERمجموعه رفته و از

 فٌلترهایStylizeفٌلترGlowing Edgesکنٌد را انتخاب

Smoothnessومقدار2با را برابر Edge widthفٌلتر مقدار در اٌن 

قراردهٌد و اٌن4را برابر با  فٌلتر را روی کار خود اجرا کنٌد 

 روبرو مٌشود که نتٌجه کار مانند شکل

  
 



 

 

 

 

Artisticفٌلترهای رفته و از مجموعهFILTERبه منوي  

 فٌلترPlastic Wrapمقدار رابرگزٌنٌدودر اٌن فٌلتر

قرار9با را برابر Detail و14را برابر با   Highlight Strengeمقدار 

قرار دهٌد و7را برابر با   ومقدارSmoothnessفٌلتر را اجرا کنٌد 

  سپس مجدد به منويFILTERفٌلترهای رفته واز مجموعه

  BLURفٌلترRadial Blurمقدار برگزٌنٌد سپسAmountبرابر را

Blur MethodراSpinروی قرار دهٌدوفٌلتر را قراردهٌد و19با   

  کار شما مانند شکل روبرو کار خود اجرا کنٌد که نتٌجه

  مٌشود.

  
 

 

 

  

 

 منوي بهFILTERرفته و از مجموعه فٌلترهایDistortفٌلتر

و5با را برابر Distortionمقدار را برگزٌنٌد در اٌن فٌلترGlass 

قرار دهٌد سپس3را برابر با  مقدارSmoothnessاز مجموعه 

Scalingمقدار را برگزٌنٌدوTiny LenseحالتTextureحالتهای 

درصد قرار100را برابر با  دهٌد و اٌن فٌلتر را با تنظٌمات 

 کنٌد سپس از منوي داده شده روی کار خود اجرا

OpacityمقدارFADEرا برگزٌنٌد ودر پنجرهFade GlassگزٌنهEdit 

درصدقرار دهٌد وحالت66با را برابرMODEراOverlayبرگزٌنٌد  

 روبرو مٌشود و نتٌجه کار مانند شکل.

  

 



 

 

 

 

 منوي بهFILTERرفته و از مجموعه فٌلترهایRenderفٌلتر

 Lightning Effectsرا با همان را انتخاب کنٌد واٌن فٌلتر

 خود اجرا کنٌد تنظٌمات پٌش فرض روی کار

WAVEفٌلترDistortومجموعه فٌلترFILTERسپس از منوي 

 تنظٌمات پٌش فرض اٌن فٌلتر را را انتخاب کنٌد و با همان

 کنٌد روی کار خود اجرا

Fade Waveگزٌنه رفته و اٌنبارEditمنوي سپس مجدد به 

درصد قرار60را برابر با  مقدار را برگزٌنٌد وOpacityدهٌد 

 و از حالاتModeحالتLightenکار را برگزٌنٌد که در نتٌجه

 مٌشود شما مانند شکل روبرو.

  
 

 

 

 طرح به کار حالت پرسپکتٌو سپس باٌد برای زٌبا تر شدن

 بدهٌم برای اٌن امر به منويEDITمجموعه رفته و از

 TransformگزٌنهPerspectiveشکل و پرسپکتسو را مانند

 کنٌد روبرو تنظٌم.

  

  

  
 



 

 

 

 

 تقرٌبا به اتمام رسٌده است در اٌن مرحله کار شما

 رنگ طرح خود را تغٌٌر دهٌد در صورت تماٌل شما مٌتوانٌد

ADJUSTMENTمجموعه وIMAGEبرای اٌن کار به منوي 

 گزٌنهHue/Saturationسلٌقه خود را برگزٌنٌد و آنرا برابر

 کنٌد تنظٌم.
 

 

 
 
 

 كره زمٌن آموزش اٌجاد

  

 سلام

در اٌن آموزش شما به قسمتهاًٌ از فتوشاپ نٌاز پٌدا مٌكنٌن كه شاٌد تا به حال با اونها سر . اٌن آموزش ممكنه براي بعضً از شما با آموزشهاي دٌگه ساٌت فرق داشته باشه 
پس فكر مٌكنم اٌن آموزش علاوه بر آموزش اٌجاد اٌن طرح زٌبا نكته هاي دٌگه اي رو هم با . قسمتهاًٌ مفٌد و جدٌد كه كمتر كسً از اونها استفاده مٌكنه . و كار نداشتٌن 

 .خودش به همراه داشته باشه 

: پس اگه موافقٌن شروع كنٌم 

  

.  رستارت كنٌن D پٌكسل اٌجاد كنٌن و رنگاتون رو با زدن دكمه 750 پٌكسل در 750اول از همه ٌك سند جدٌد در اندازه 

 Height و Widthبراي گزٌنه هاي .  قرار بدٌن Fixed Size رو برابر Style مقدار Option رو انتخاب كنٌن و در نوار Elliptical marquee toolحالا ابزار 
. حالا داٌره اٌجاد شده رو به وسط صفحه هداٌت كنٌن . رو انتخاب كنٌن و ٌك بار روي صفحه، كلٌك كنٌن  ) px ( پٌكسل 750مقدار 

:  بزارٌن و فٌلترهاي زٌر رو روش اعمال كنٌن Waterحالا ٌك لاٌه جدٌد اٌجاد كنٌن و نام اون رو 

Filter --> Render --> Clouds 

Filter --> Distort --> Spherize {Amount : 100 ---- Mode : Normal} 

 :حالا لاٌه جدٌدتون رو با كلٌد بر روي گزٌنه ي زٌر قفل ظاهري كنٌد 



 

 

 

: حالا مسٌرهاي زٌر رو هم دنبال كنٌن و تنظٌمات اونا رو هم انجام بدٌن 

Filter --> Blur --> Gaussian Blur {Radius : 20} 

Image --> Adjustments --> Hue/Saturation {Colorize : تٌك زده شود ---- Hue : 218 ---- Saturation : 25 ---- Lightness : -20} 

 :تا اٌنجاي كار طرح شما باٌد مثل طرح زٌر شده باشه 

 

: همٌن طور  كه محٌط داٌره رو در حالت انتخاب دارٌن روي اٌن لاٌه جدٌد فٌلترهاي زٌر رو اعمال كنٌن .  بذارٌد Landحالا ٌه لاٌه جدٌد اٌجاد كنٌن و اسم اون رو 

Filter --> Render --> Clouds 

Filter --> Distort --> Spherize {Amount : 100 ---- Mode : Normal} 

 :حالا به مسٌر زٌر برٌن و مقدارهاي زٌر رو براي اون در نظر بگٌرٌن 

Image --> Adjustments --> Brightness/Contrast 

Contrast : 100 

Brightness : 30صفر تا  بٌن   شكل رو طبٌعً مٌكنه انتخاب كنٌن هر عددي كه بٌشتر -
( قسمتهاي سٌاه رنگ آبها رو تشكٌل مٌدن: نكته   . ) 

انتخاب كنٌن و اونا رو  ) Magic wandمثلا ( و قسمتهاي سٌاه طرح رو با هر ابزاري كه دوست دارٌن  ) Ctrl+Dبا كلٌد هاي  (حالا طرح رو از حالت انتخاب خارج كنٌن 
 . پاك كنٌن Deleteبا زدن تكمه 



 

 

:  اعمال كنٌن Land كلٌك كنٌن و اٌن فٌلترها رو هم روي لاٌه Land رو نگه دارٌن و روي لاٌه Ctrlخوب ، حالا كلٌد 

Filter --> Render --> Clouds 

Filter --> Render --> Difference Clouds 

با اٌن كار شما پستً و بلندٌهاي داخل خشكً رو .  فٌلتر بالا رو چند بار روي لاٌه اعمال كنٌن تا ٌك شكل تقرٌبا موزونً در بٌاد Ctrl+Fحالا با چهار پنج بار زدن كلٌدهاي 
 . اٌجاد مٌكنٌن 

: حالا مسٌر زٌر رو دنبال كنٌن و تنظٌمات اون رو انجام بدٌن 

Edit ---> Fade Difference Clouds { Opacity : 50 ---- Mode : Normal} 

 : رو براي خروج از حالت انتخاب بزنٌن و به مسٌر زٌر برٌن و تنظٌماتش رو مثل شكل انجام بدٌن Ctrl+Dحالا كلٌدهاي 

Filter --> Render --> Lighting Effects 

 

.  در آخرٌن قسمت رو بردارٌن White is highٌادتون باشه تٌك قسمت 

.  محٌط داٌره رو انتخاب كنٌن Water و كلٌك بر روي لاٌه Ctrl بزارٌن و با نگه داشتن كلٌد Cloudsحالا ٌه لاٌه جدٌد اٌجاد كنٌن و اسم اون رو 

: حالا اعمال زٌر رو باٌد روي اٌن لاٌه انجام بدٌن 

Filter --> Render --> Clouds 

Filter --> Render --> Difference Clouds 

 . رو فشار بدٌن تا رنگها برعكس بشه Ctrl+Iكلٌدهاي 

Image --> Adjustments --> Brightness/Contrast { Brightness : -30 ---- Contrast : 95 } 

 )عكس اول : راهنماًٌ  (. ظاهر لاٌه رو مثل دفعه قبل قفل كنٌن 

Filter ---> Blur ---> Motion Blur {Angle : 0 ---- Distance : 120} 

Filter ---> Blur ---> Gaussian Blur {Radius : 4} 



 

 

Filter --> Distort --> Spherize {Amount : 50 ---- Mode : Normal} 

Mode لاٌه رو به Screen تغٌٌر بدٌن . 

Image --> Adjustments --> Brightness/Contrast {Contrast : 60 ---- Brightness : 0} 

Opacity برسونٌن 60% لاٌه رو به . 

.  رو براي خروج از حالت انتخاب بزنٌن Ctrl+Dحالا كلٌدهاي 

:  رو انتخاب كنٌن و به مسٌر زٌر برٌن waterلاٌه 

Filter --> Render --> Lighting Effects 

 . تغٌٌر بدٌن None كه اون رو باٌد به Texture Channelتنظٌمات اون رو همٌن جوري كه تغٌٌر داده بودٌن بزارٌن باشه به غٌر از قسمت پائٌن ٌعنً 

.  رو اعمال كنٌن Lighting Effects هم اٌن فٌلتر آخري ٌعنً Cloudsبراي لاٌه 

: حالا به مسٌر زٌر برٌن و اندازه هاي زٌر رو براش وارد كنٌن 

Image ---> Canvas Size {Width : 800 px ---- Height : 800 px : Relative : نمٌخواد تٌك --- Anchor :(  مركزي) پٌش فرض  } 

 .حالا لاٌه بكگراند رو با رنگ سٌاه پر كنٌن 

  ):   (اگه خراب كردٌن فقط ٌكم بخندٌن ، بعدش دوباره شروع كنٌن  (تا اٌنجا باٌد طرحتون اٌنجوري شده باشه 

 

 ٌه ماسك اضافه Add layer Mask قرار بدٌن و به اٌن لاٌه جدٌد مثل شكل با كلٌد بر روي گزٌنه land ٌه كپً بگٌرٌن و اٌن كپً رو زٌر خود لاٌه landحالا از لاٌه 
: كنٌن 



 

 

 

پس مسٌرهاي زٌر رو دنبال . اعمال بشه  )قسمت سفٌد روي لاٌه  (در اٌن حالت شما بدون اٌنكه روي لاٌه ها كلٌك كنٌن باٌد به كارتون ادامه بدٌن تا عملٌات بر روي ماسك 
: كنٌن 

Filter ---> Render ---> Clouds 

Image --> Adjustments --> Brightness/Contrast {Contrast : 70 ---- Brightness : 0} 

 :پس حالا مسٌرهاي زٌر رو دنبال كنٌن . كلٌك كنٌن تا بقٌه عملٌات روي خود لاٌه انجام بشه  )روي خود عكس لاٌه  (حالا باٌد روي اٌن لاٌه اي كه داراي ماسك هستش 

Image --> Adjustments --> Hue/Saturation {Colorize : تٌك زده شود ---- Hue : 139 ---- Saturation : 25 ---- Lightness : 0} 

 : كلٌك كنٌن و ادامه كار landحالا روي لاٌه 

Image --> Adjustments --> Hue/Saturation {Colorize : تٌك زده شود ---- Hue : 35 ---- Saturation : 40 ---- Lightness : -30} 

 . تغٌٌر بدٌن Screen اٌن لاٌه رو به Modeحالا 

: حالا لاٌه بكگراند رو انتخاب كنٌن و اعمال زٌر رو روش انجام بدٌن 

Filter ---> Noise ---> Add Noise { Amount : 70 ---- Distribution : Uniform ---- Monochromatic : تٌكش رو بردارٌن} 

Edit ---> Fade Add Noise ---> { Opacity : 50 ---- Mode : Dissolve } 

Filter ---> Blur ---> Gaussian Blur { Radius : 1} 

Image --> Adjustments --> Brightness/Contrast {Contrast : 90 ---- Brightness : -35} 

 :ٌك لاٌه جدٌد روي بكگراند اٌجاد كنٌن و ادامه كار رو روي اون انجام بدٌن 

Filter ---> Render ---> Clouds 

Mode اٌن لاٌه رو به Screen و Opacity تغٌٌر بدٌن 50% اون رو به . 

:  رو بزنٌن و تنظٌمات اون رو مثل زٌر انجام بدٌن Ctrl+U بشه و بعد از اون كلٌدهاي merge رو بزنٌن تا اٌن لاٌه با لاٌه بكگراند Ctrl+Eحالا كلٌدهاي 



 

 

{Colorize : شود تٌك زده ---- Hue : 238 ---- Saturation : 15 ---- Lightness : -15} 

 .خسته نباشٌد، حالا تونستٌن كره زمٌن رو اٌجاد كنٌن 

: و اٌنم طرح نهاًٌ 

 

: مثل عكس پائٌن . شما مٌتونٌن با ٌكم دستكاري لاٌه ها و اضافه كردن افكتهاي مختلف به طرحتون رنگ و رو بدٌن 

 

 

 

 تغٌٌر نام عکسها

 را انتخاب File Browser رفته و گزٌنه Windowبراي اٌنکار شما مً توانٌد به منوي .  تغٌٌر نام بٌش از دو عکس در ٌک زمان هست۷ٌکً از امکانت خوب فتوشاپ 
پس از اٌنکه اٌن پنجره باز شد مسٌر فاٌل خود را مشخص مً کنٌد سپس عکسهاًٌ که باز شد بروي عکسهاًٌ که مً خواهٌد نام آنها را تغٌٌر دهٌد کلٌک کرده سپس . کنٌد

. بعد از آن پنجره همانند شکل زٌر باز خواهد شد.  را انتخاب مً کنٌدBatch Renameکلٌک بروي ٌکً عکسها کلٌک راست کرده و گزٌنه 



 

 

 

. اٌن بخش شامل دو قسمت مً باشد
۱-۲ (Destination Folder -: در اٌن قسمت شما مشخص مً کنٌد که آٌا اٌن تغٌٌر نام در همانFolder باشه و ٌا در Folderجدٌد  .

۲-۲ (File Naming -:در اٌن بخش هم نوع نماٌش اسم عکسها را انتخاب مً کنٌد .
.  مً توانٌد به اٌن لٌنک مراجعه کنٌد دوستمان آقاي سعٌد باقري توضٌح مفصلً از اٌن موضوع نوشتنFile Browserبراي اطلاع بٌشتر در مورد 

 

ساخت فتو گالري  

: ٌکً دٌگر از امکانات جالب اٌن برنامه ساخت گالري عکس هستش
. گذاشت )Folder(براي ساخت فتوگالري ابتدا باٌد عکسهاي که دوست دارٌد در گالري خود بگذارٌد را در ٌک پوشه - ۱
اٌن .  بعد از اٌنکه اٌن مراحل را طً کردٌد صفحه همانند شکل زٌر خواهٌد داشتFile < Automate < Web Photo Gallery: سپس مراحل زٌر را طً کنٌد- ۲

.  بخش مً باشد۴پنجره شامل 

 

-۴ ( Site :
۱ (Style -:که هر کس ٌه نمونه اي را مً پسندد. در اٌن بخش شما مً توانٌد نحو نماٌش فتو گالري خود را انتخاب کنٌد .
۲ (E-mail -: در اٌنجا هم مً توانٌد اٌمٌل خود را بنوٌسٌد .
۳ (Extension -: در اٌنجا هم نوع فاٌل خود را مشخص مً کنٌد که به چه صورتً باشد .

۲-۴ (Folders :
۱ (Brows -:در اٌن بخش آدرس پوشه عکس هاي خود را مشخص مً کنٌد .
۲ (Include all Subfolders -: با انتخاب اٌن بخش شما مشخص مً کنٌد آٌا پوشه هاي داخل آن پوشه هم شامل هست ٌا نه
۳ (Destination -:در اٌن جا هم شما مسٌر ذخٌره شده فاٌل رو انتخاب مً کنٌد .

۳-۴ (Options :در اٌن بخش اطلاعات مربوط به عکسها رو مً نوٌسٌد .

۱-۳-۴ (Banner -:
. در اٌن بخش شما نام صفحه خود را مشخص مً کنٌد:- Site Name )الف
. در اٌنجا هم نام عکاس را مً نوٌسٌد:- Photographer )ب



 

 

. در اٌن قسمت اطلاعات مربوط به تماس خود را مً نوٌسٌد:- Contact Info )ج
. در اٌن قسمت تارٌخ ، نوع فونت و اندازه فونت هاي مربوط به اٌن بخش را انتخاب مً کنٌد:- Date, Font , Font Size )د، ه، و

۲-۳-۴ (Large Image -:
. در اٌن قسمت نوع نماٌش عکس را از نظر اندازه مشخص مً کنٌد:- Resize Image )الف
در اٌن بخش هم مشخص مً کنٌد که اندازه در کدام بخش از عکس تغٌٌر کند، در طول، ٌا عرض و ٌا هر دو آنها :- Constrain )ب
. در اٌن بخش هم کٌفٌت عکس را مشخص مً کنٌد:- JPEG Quality )ج
. تغٌٌر مً کند )JPEG Quality(اٌن بخش خود بخود با تغٌٌر مرحله قبلً :- File Size )د

.  اٌن بخش را به فتوشاپ بسپارٌد تا به صورت اتوماتٌک درست کندResize Imageتوجه اگر دوست دارٌد مً توانٌد با غٌر فعال کردن گزٌنه ** 

در اٌن بخش شما مشخص مً کنٌد که آٌا اطراف عکش شما کادر درست بشه ٌا نه؟ :- Border Size )ه
. در اٌن قسمت شما مشخص مً کنٌد که براي عنوان عکسها از چه عنوانً استفاده شود:- Titles Use )و

. اٌن هم همانند بخش قبلً مشخص مً کنٌد که از چه فونت و ساٌزي براي اٌن مشخصات استفاده شود:- Font, Font Size )ز، ح

۳-۳-۴ (Thumbnails  -:
. در اٌنجا اندازه عکسها را در صفحه اول مشخص مً کنٌد:- Size )الف
. در اٌن بخش مشخص مً کنٌد در چند ستون عکسها باشه:- Columns )ب
. در اٌن بخش هم مشخص مً کنٌد در چند ردٌف عکسها قرار بگٌرند:- Rows )ج
. در اٌن بخش هم اندازه مرز خطوط را مشخص مً کنٌد:- Border Size )د
. اٌن بخش هم مانند دو بخش قبلً عنوان مشخص مً کنٌد از چه عناوبنً براي اٌن صفحه استفاده شود:- Title Use )ه

. اٌن بخش هم مانند دو بخش قبلً اندازه فونت و ساٌز آنرا براي اٌن صفحه مشخص مً کنٌد:- Font, Font Size )و، ز

۴-۳-۴ (Custom Colors -:
. اٌن بخش مربوط به رنگ متن مً باشد:- Text )الف
. اٌن بخش هم مربوط به لٌنکها مً باشد:- Link )ب
. اٌن بخش هم مربوط به بنر آن مٌباشد:- Banner )ج
. در اٌن بخش مشخص مً کنٌد که لٌنکهاي فعال را به چه رنگً مشخص کند:- Active Link )د
. در اٌن قسمت هم مشخص مً کنٌد لٌنکهاي دٌده شده به چه رنگً نشان داده شود:- Visited Link )ه

۵-۳-۴ (Security -:اٌن بخش مربوط به امنٌت مً باشد .

۴-۴ (Preview -:اٌن بخش هم به شما نشان مٌدهد که صفحه گالري شما به چه صورتً خواهد بود  .

  

 

 

 

 
 

  

 



 

 

 

 

پٌکسل اٌجاد 800-600ابتدا ٌک فاٌل جدٌد با پس زمٌنه سٌاه به اندازه 

قسمتی [ ]Elliptical Marquee Toolکنٌد سپس به وسٌله ابزار 
سپس رنگ .را به شکل داٌره در وسط صفحه انتخاب کنٌد

foreground color  را به[FFDE00] و رنگbackground 
colors    را به[FFDE00] تغٌٌر دهٌد و به منویfilter رفته و از

را انتخاب کنٌد که نتٌجه Cloudsفٌلتر Renderمجموعه فٌلترهای 
.  مانند شکل روبرو مٌشود 

  

   

   

   

 

 

سپس روی لاٌه خود دو بار کلٌک کنٌد که با اٌن کار پنجره 
layerstyle فعال مٌشود در اٌن پنجره قسمتouter glow را انتخاب

.  کرده و اٌن قسمت را مانند شکل زٌر تنظٌم کنٌد

 

 را فعال ساخته و ان را مانند شکل بالا inner shadowسپس قسمت 
 .تنظٌم کنٌد



 

 

 

 

را پاٌٌن نگه داشته اٌد ٌک بار ctrlسپس روی لاٌه اول در حالی که کلٌد 
کلٌک کنٌد که با اٌن کار محدوده داٌره ما به حالت انتخاب در   می آٌد 

اٌجاد  []create new layerسپس ٌک لاٌه جدٌد با زدن دکمه 
کنٌد و اٌن لاٌه را با درگ کردن به زٌر لاٌه اول و بالای 

انتقال دهٌد سپس قسمت انتخاب شده را با رنگ backgroundلاٌه   
سٌاه پر کنٌد  

   

  

 

 

رووی لاٌه جدٌد که در مرحله قبل ساختٌم دو بار کلٌک کرده و در 
را فعال سازٌد  و آن را مانند outer glowقسمت layer styleپنجره 

:  شکل زٌر تنظٌم کنٌد 

 

را انتخاب کنٌد و به روش گفته شده ٌک لاٌه جدٌد layer 1سپس لاٌه 
اٌجاد کنٌد  که اٌن لاٌه باٌد در بالای لاٌه اولٌه شما اٌجاد شود سپس در 

حالی که محدوده داٌره شما به حالت انتخاب در آمده است به منوی 
filter رفته و از مجموعه فٌلترهایrender فٌلترDifference 

Clouds را انتخاب کنٌد و سپس دو کلٌد های مٌانبر[ctrl+f] را دو بار
دو بار مجدد روی Difference Cloudsبفشارٌد با اٌن کار فٌلتر 

را بفشارٌد با اٌن )ctrl+l(طرح شما اجرا مٌشود سپس دو کلٌد مٌانبر 



 

 

فعال مٌشود و اٌن پنجره را مانند شکل زٌر تنظٌم levelsعمل پنجره
: کنٌد

 

 

  

 

 

فٌلتر Distortرفته و از مجموعه فٌلترهاfilterبرای ادامه به مونوی 
Spherize را انتخاب کنٌد در اٌن فٌلتر مقدارAmmount 

قرار دهٌد و فٌلتر را روی NormalراModeقرار دهٌد و حالت 100را
طرح خود اجرا کنٌد  

  

 

 

به normalلاٌه جاری را از حالت modeسپس در قسمت لاٌه ها 
color Dodge تغٌٌر دهٌد  سپس ٌک لاٌه جدٌد اٌجاد کنٌد و در حالتی

رفته و گزٌنه selectکه قسمت داٌره ای سلکت شده است به مونوی 
inverse را انتخاب کنٌد که اٌن کار با زدن سه کلٌد مٌانبر

)shft+ctrl+i(  هم عملی مٌشود اٌن عمل باعث مٌشود  که قسمتهای
رفته و از filterانتخاب نشده به حالت انتخاب در آٌند سپس به مونوی 

را برگزٌنٌد سپس مجدد به clouds فٌلتر renderمجموعه فٌلترهای 
فٌلتر renderرفته و از از مجموعه فٌلترهای filterمونوی 

Difference Clouds را انتخاب کنٌد سپس دو بار کلٌدهای مٌانبر
)ctrl+f(  را بفشارٌدسپسmode اٌن لاٌه را مانند قبل از normal به

color Dodge  تغٌٌر دهٌد

  
   



 

 

 

در اٌنجا تغرٌبا کار شما به پاٌان مٌرسد شما مٌتوانٌد برای زٌباتر شدن کار خود بر حسب صلٌغه خود ٌک سری 
 

افکتهای دٌگر هم روی کار خود اجرا کنٌد مانند طرحی که من در پاٌٌن قرار داده ام 
 

خسته نباشٌد 
  

 

  
 

 

 

 

 

  )))Notesکاربرد ابزار  (((



 

 

 

.... ٌعنً ٌك نفر كار طراحً ، ٌك نفر اجرا ، ٌك نفر رنگ آمٌزي ، افكت و . در بسٌاري از مواقع گرافٌست ها طرح هاي خودشان را به صورت دسته جمعً درست مً كنند
براي اٌن كار لازم بود تا مواردي در آن طرح بر روي كاغذ نوشته شود و سپس گرافٌست بعدي آن را مً خواند و توضٌحاتً را كه لازم داشت بداند ، از . را انجام مً دهد
.  آنها مطلع مً شد

 
فرض كنٌد دو گرافٌست در دو مكان . در شركتها دٌده مً شد كه خٌلً از اٌن كاغذ بازي ها انجام مً شود آن هم به خاطر اٌنكه توضٌحاتً لازم بود كه به ٌكدٌگر بدهند

!  مختلف بودند و باز فرض كنٌد چه مقدار كاغذ براي توضٌحات اضافه باٌد استفاده مً شد 
 

دٌگر لازم نبود بر .  را ساخت كه در حقٌقت همان كاغذ ها بودند اما به صورت دٌجٌتالNotesًابزار .  آمد و ٌك راه حل بسٌار مناسب براي اٌن كار پٌدا كردAdobeخوب 
سپس گرافٌست بعدي كه اٌن كار . روي كاغذ توضٌحات نوشته شوند و شما مً توانستٌد به همراه فاٌل و در واقع درون آن توضٌحات لازم را با استفاده از همٌن ابزار بنوٌسٌد

.  را دٌد مً توانست با خواندن توضٌحات شما اگر مطلبً بود آن را متوجه شود
 

:  به تصوٌر زٌر دقت كنٌد 



 

 

 

...  خوب مً بٌنٌد كه به راحتً مً شود اٌن توضٌحات را براي دٌگران ساخت 
 

...  اما ٌك مورد دٌگر 
 

مثلْا به جاي اٌنكه بر روي كاغذ كارهاًٌ را كه رٌٌسش گفته بر روي آن . اٌنها را مً تواند شخص براي خودش هم بنوٌسد... اٌن توضٌحات لزوماْ نباٌد براي دٌگران باشند 
...  طرح انجام دهد بنوٌسد ، آنها را با استفاده از همٌن ابزار ٌادداشت كنٌد 

 
...  اما تفاوت آن اٌن است كه به صورت صوتً مً باشد نه نوشتاري .  هم دقٌقاْ همٌن كار را انجام مً دهدAudio Annotationدر انتها ٌادآوري مً كنم كه ابزار 

 
.  خوب امٌدوارم با توضٌحات من ، علت وجود اٌن ابزار را متوجه شده باشٌد

موفق باشٌد 

 

 

 



 

 

 كنٌم و بقٌه تصوٌر تقرٌبا محو بشن zoomاٌنم ٌه اموزش براي اٌنكه روي ٌه قسمتً از تصوٌرمون 
 
 عكس مورد نظر را بازكنٌد -1

  
 
 .از لاٌه عكس، دو كپً اٌجاد كنٌد-2

  



 

 

 
قسمتً را كه مٌخواهٌد در عكس واضح باشد با .  بروٌدFilter<--- Extractدرحالٌكه آخرٌن لاٌه در حالت انتخاب است به منوي - 3

و قسمت خارج اٌن ناحٌه رو با استفاده از   ) بگذارٌد10ساٌز قلم را حدود ( انتخاب كنٌدEdge highlighter toolاستفاده از ابزار 
 .  را بزنٌدOK پر كنٌد و سپس Fill Toolابزار 

  
 
 . بروٌد و مقادٌر آن را به صورت زٌر تغٌٌردهٌدFilter<---- Radial blurبه منوي - 4

Amount = 30 
Blur Method = Zoom 
Quality = Good 
  

 
 ):اكنون طرح مورد نظر شما آماده شده است- 5

 
 

 

 سلام



 

 

 . گفتم تا وقت دارم کار رو ٌه افکت دٌگه که تو فتوشاپ انجام دادم رو هم بهتون بگم

 رو روی  Background contents پٌکسل باز کنٌد و 500ٌک صفحه با عرض و ارتفاع -۱

Transparentقرار بدٌن  .

: بعد اٌن مسٌرها رو برٌد

Filter<-Render-<Clouds 

Filte<-Blur-<Motion Blurاٌن تنظٌمات رو ثبت کنٌد           :Distance: 999    Angle: 0 

Filter-<Stylize-<Find Edgesبعد روی لاٌه راست کلٌک و  layer Duplicateرو انتخاب می کنٌم  .

   

Edit-<Transform-<Rotate 90cw و مد لاٌه رو روی     darkenقرار مٌدٌم  .

ctrl+Eرو فشار بدٌن تا لاٌه ها ادغام بشن    .

Filter-<Stylize-<Glowing  

 : اٌن تنظٌمات رو ثبت کنٌد

Edge Width: 1 

Edge Brightness: 20 

Smoothness: 3  

تصوٌر                        :            تا اٌنجا اٌن تصوٌر رو دارٌم

2 -Image-<Adjustement-<Brightness/Contrast 

 Brightness: 0:   تنظٌمات

               Contrast: +40 

Image-<Adjustement-<Hue/Saturation 

  هستٌد و colorizeمطمئن شوٌد روی 

 Hue: 180:  تنظٌمات

               Saturation :100 

                 Lightness: 0  

 Edit-<Transform-<Perspective:  مٌدٌمPerspectiveبه شکل حالت - 3

               تصوٌر اٌن مرحله 

Duplicate layer و اٌن مسٌر رو مٌرٌم   :

 Filter-<Blur-<Gausian Blur 

 Radius 4.4: تنظٌمات

  تغٌٌر مٌدٌم Screenمد لاٌه رو به 



 

 

ctrl+E برای ترکٌب لاٌه ها 

:  و لاٌه پاٌٌن رو انتخاب می کنٌم و اٌن مسٌر رو مٌرٌمDuplicate layerدوباره 

Filter-<Render-<Lighting effects 

                تنظٌمات  

.  ٌه مقدار تصوٌر رو در لاٌه بالاٌی ٌه پاٌٌن می کشٌمMove تغٌٌر مٌدٌم و با ابزار lighten و مد لاٌه رو به opacity =50%به لاٌه بالاٌی مٌرٌم و  

                         

 

 

 

 . تاٌٌد مٌكنٌدFEATHER 0 رو با MAKE SELECTION فرم مورد نظر رو مٌكشٌد و در پاٌان رو كار راست كلٌك كرده و PEN TOOLبا ابزار . 1



 

 

 

.  به صورت زٌر تغٌٌر مٌدهٌدDROP SHADOW مٌروٌد و مقدار LAYER OPTIONSو به قسمت  )d5c4a1( در ٌك لاٌه جدٌد قسمت سلكت شده را رنگ مٌكنٌد 2
 

 
 
: چٌزي كه الان باٌد داشته باشٌد چٌزي شبٌه اٌن هست. 3
 



 

 

 
 
: كنٌد و جهت هاي قرار گٌرٌشونو كمً تغٌٌر دهٌد )DUPLICATE (ctrl+j بار 3حالا لاٌه رو . 4
 

 
 
 روي لاٌه كپً شده كلٌك كنٌد و با رنگ CTRLو با نگه داشتن  )ctrl+j(از عكسً كه انتخاب كردٌد ٌك كپً بگٌرٌد . حالا مٌخواهٌم ٌك عكس رو بٌن سندها قرار دهٌم.5

.  كمً اونو بزرگ كنٌد و لاٌه اصلً عكس رو در وسط لاٌه كپً شده قرار دهٌدSHIFT رو بزنٌد و با نگه داشتن CTRL+Tحالا . سفٌد اونو رنگ كنٌد
 



 

 

 
 
اگر كمً زاوٌه قرار گٌرٌشون هم تغٌٌر دهٌد باور پذٌر تر .كنٌد و آنها را بٌن سندها قرار دهٌد  )DUPLICATE (ctrl+j بار 3 كنٌد و لاٌه را MERGEحالا دو لاٌه را .6

. مٌشوند
 

 
 
:  رو بزنٌد و اون را به صورت زٌر تغٌٌر دهٌدCTRL+Bبعد از آن كه عكس را انتخاب كردٌد . حالا ٌك عكس مٌخواهٌم كه روي سندمان قرار گٌرد. 7



 

 

 

 
 
.  گفته شد تغٌٌر دهٌد5عكس رنگ شده رو همانطور كه در قسمت . 8
 

 
 

: چٌزي كه تا الان باٌد داشته باشٌد همچٌن شكلً است.8.1
 

 
 
). f5efe1( بكشٌد و داخلش را رنگ كنٌد A4 رو بزنٌد و ٌك مستطٌل به صورت ٌك ورق M. ٌك لاٌه جدٌد درست كنٌد. 9
 



 

 

 
 

به اٌن صورت .  لاٌه اٌجاد شده تان رو بزك كنٌدOLD PAPERحالا با استفاده از براشهاي .10
 

 
 

. رو روي سند بزنٌم تا دست آلمانً ها به اطلاعات محرمانه ما نٌوفتد )آٌزنهاور(حالا مٌخواهٌم مهر تاٌٌد فرمانده . تا اٌنجا كار سندهاي مهرمانه به پاٌان رسٌده
 



 

 

 را فشار دهٌد حالا روي لاٌه نوشته راست كلٌك كنٌد و CTRL+RETURN رو بنوٌسٌد بعد TOP SECRET رو بزنٌد و كلمه T باز كنٌد و 400*400ٌك سند .1
RASTERIZE TYPEرو بزنٌد  .

 

 
 
2.CTRL حالا به اٌن فٌلتر بروٌد.  رو نگه داشته و روي لاٌه كلٌك كنٌد :
 

 
 

. انقدر اٌن فٌلتر رو بزنٌد تا جاًٌ كه تٌرگٌها و روشنً هاًٌ كه مٌخواهٌد بدست آورٌد: نكته
: و بعد به اٌن فٌلتر.3
 

 
 
: و بعد از اون هم اگه خواستٌد به اٌن فٌلتر بروٌد. 4
 

 
 
.  بروٌد و تغٌٌرات زٌر رو انجام دهٌدIMAGE<ADJUSTMENT<BRIGH/CONTو بعد به قسمت . 5

 )اونجاهاًٌ كه مٌخواهٌد خرده بشه تٌره تر كنٌد(.تغٌٌرات بستگً به تٌرگٌها و روشنً هاي نوشتتون داره: نكته
 

 
 
:  برٌدCOLOR RANGE به SELECTحالا از . 6
 

 
 
: و جوري درجه كم و زٌاد كنٌد كه جاهاًٌ كه مٌخواهٌد خرده بشه تٌره تر باشد و سلكت شود. 7
 



 

 

 
 

: بعد به فٌلتر زٌر برٌد!! . )اون دل نه اٌن دل (. رو بزنٌدDEL بزنٌد تا سلكت ها معكوس شود و بعد CTRL+Iحالا . 8
 

 
 
..: چٌزي كه بدست آمده باٌد اٌنجوري باشد وگرنه.  بگذارٌد و تاٌٌد كنٌد1و مقدارش رو روي . 9
 

 
 .............................

 
: دٌگه مٌتونٌد اٌنجوري كارتون رو تموم كنٌد: بً :حالا با كمً ذوق و سلٌقه و بٌكاري و بً پولً و هزار تا 

 
...!! اٌنم نتٌجه اٌن آموزش كه به هٌچ درد هم نمٌخوره

 



 

 

 
 

Artwork 



 

 

 
 

  FASHIST.ORG -- MAJIDONLINE.COM: منبع

 

 

 

 : 1نكته 
: چگونه ٌك قسمت از ٌك سند را كه از چند لاٌه تشكٌل شده كپً كنٌم *

اما اگر شما بخواهٌد از تمام .  را مً فشارٌد آن منطقه تنها از لاٌه انتخابً كپً مً شود Ctrl+Cوقتً منطقه اي از ٌك سند را انتخاب كنٌد و براي انجام عمل كپً كلٌدهاي 
.  اٌن كار را انجام دهٌد Ctrl+C به كلٌدهاي Shiftاجزاي لاٌه ها در آن قسمت در ٌك لاٌه جدٌد كپً داشته باشٌد مً توانٌد با افزودن كلٌد 

 
 

 : 2نكته 
: اسناد خود را در كنار هم مشاهده كنٌد *

ٌعنً تصاوٌر ٌكً پس از . وقتً تعدادي سند را باز مً كنٌد فوتوشاپ آنها را به صورت جلوي هم نماٌش مً دهد  )زمان زندگً داٌناسورها  (در ابتداي تارٌخ فوتوشاپ 
 تصوٌر باز شده خود را كنار هم قرار دهٌد كافٌست از منوي 4اما اگر بخواهٌد به طور مثال .  نام دارد Cascadingدٌگري در جلوي هم باز مً شوند كه اٌن روش 



 

 

Windows منوي Documents را باز كرده و گزٌنه Tile را انتخاب كنٌد  .
 

 

 : 3نكته 
: حالت ارائه طرح به مشتري در فوتوشاپ *

دلٌل اٌن امر اٌن است كه مشتري بلافاصله . زمان آن فرا رسٌده كه طرح نهاًٌ خود را به مشتري نشان دهٌد اما دوست ندارٌد مشتري بداند كه شما با فوتوشاپ كار كرده اٌد 
و معناي اٌن حرف اٌن است كه پس همساٌه من هم مً تواند اٌن طرح را بدون صرف هزٌنه براٌم  ))با فوتوشاپ كار مً كنٌد ؟ همساٌه من هم اٌن برنامه را دارد  ((: مٌگوٌد 

مشاهده مً .  را بزنٌد Tab را در صفحه كلٌد دو بار فشار داده و ٌك بار كلٌد Fبراي اٌنكه بتوانٌد از حالت ارائه تصوٌر در فوتوشاپ بهره بگٌرٌد مً توانٌد كلٌد . انجام دهد 
. كنٌد كه دور طرح را زمٌنه اي سٌاه پوشانده و منوها حذف شده اند

 
 

 : 4نكته 
: رفت و آمد بٌن اسناد *

.  بٌن اسناد رفت و آمد كنٌد Ctrl+Tabاگر با بٌش از ٌك سند كار مً كنٌد مً توانٌد با فشردن كلٌدهاي 
 
 

 : 5نكته 
: مشاهده لاٌه فعال و مخفً كردن بقٌه لاٌه ها *

 Layers و كلٌك روي آٌكن چشم در پالت Altاٌن كار را مً توانٌد با فشار كلٌد . اگر سند چند لاٌه اي دارٌد مً توانٌد تنها لاٌه اي را كه روي آن كار مً كنٌد مشاهده كنٌد 
. براي مشاهده مجدد تمامً لاٌه ها اٌن كار را دوباره تكرار كنٌد . لاٌه مورد نظر انجام دهٌد 

 
 

 : 6نكته 
: اٌجاد انتخابهاي داٌره شكل *

 در زمان رسم داٌره Altشما مً توانٌد با نگاه داشتن كلٌد . زمانً كه ٌك داٌره رسم مً كنٌد فوتوشاپ داٌره را به طور پٌش فرض از نقطه اي كه كلٌك مً كنٌد رسم مً كند 
.  استفاده كنٌد Shiftاگر مً خواهٌد داٌره شما كاملا گرد باشد مً توانٌد از كلٌد . ، داٌره را از مركز رسم نمائٌد 

 
 

 : 7نكته 
: حذف راهنماهاي خط كشً *

اگر در طرحتان ده ها راهنما براي خط كشً دارٌد و اكنون قصد حذف كردن آنها را دارٌد لازم نٌست آنها را ٌكً ٌكً به بٌرون از محٌط سند درگ كنٌد ، بلكه مً توانٌد از 
.  را انتخاب كنٌد Clear Guides گزٌنه Viewمنوي 

 

چٌدمان 

 

اگر برای عکس گرفتن به عکاسی رفته باشٌد که حتما رفتٌن متوجه شدٌن که آقای عکاس باشی عکس شما رو به تعدادی که سفارش دادٌن در ٌک صفه کنار هم و با دقت بالا 
و بعد شروع مٌکنه به قٌچی کردن عکس ها   )البته عکاس باشی های مدرن  (پرٌنت گرفته 

  )چٌدمان عکس ها به تعداد دلخواه و فاصله دقٌق (شما هم می تونٌن اٌن کار رو به راحتی با فشار دادن ٌک دکمه تو برنامه فتوشاپ انجام بدٌن 
 گزٌنه Automate و از لٌست بٌرون رونده Fileبعد از منوی . برای شروع کار عکس مورد نظر رو تو برنامه فتوشاپ باز کنٌن 

Picture Pachage رو انتخاب کنٌن ٌه پنجره باز مٌشه  .
. قسمت های که ضرورت داره توضٌح مٌدم 

Page Size =  تو اٌن قسمت مٌتونٌن ساٌز عکس رو انتخاب کنٌد .
Layout =  اٌنجا هم تعداد دلخواه رو انتخاب کنٌن .

Content =  در اٌن قسمت از لٌست گزٌنهCustom Text را انتخاب کنٌد   .
Custom Text =  داخل اٌن کادر متن ٌا شماره سرٌالی رو که دوست دارٌن رو عکس حک بشه رو تاٌپ کنٌن .

Font =   اٌنهم که معلومه چٌه
Font Size =  اٌنهم که ...

Color =   رنگ دلخواه را انتخاب کنٌد
Opacity =  شدت رنگ
Position =   در اٌن قسمت مٌتونٌن مشخص کنٌن که نوشته شما در کدام قسمت از عکس حک بشه

. امٌدوارم خوشتون اومده باشه  )تموم شد  (
. قسمت های رو که توضٌح ندادم کاربرد زٌادی نداره حداقل برای من نداشته : نکته 
.  به طور خودکار شروع به چٌدمان عکسها با حک کردن نوشته مٌکنه OKبعد از تنظٌمات : نکته 



 

 

. وٌا پرٌنت . بعد سٌو کنٌد  )تو آموزش قبلی ٌاد دادم  (. بهد از اتمام کار در پالت لاٌه ها دو لاٌه می بٌنٌد که اونا رو به هم بچسبونٌن 
موفق باشٌد 

 

 

 . اما روش ساختن ٌک سٌاره سرد در محٌط فتوشاپ

من علاقه زٌادی به  . اٌن کار منو ٌاد پلوتون سٌاره ای که بٌشترٌن فاصله رو نسبت به زمٌن داره مٌندازه

!!! پلوتون دارم

.  اونو سٌاه انتخاب کنٌدbackground باز کنٌد و 400x400ٌک صفحه با اندازه - 1

.  برٌد و اٌن تنظٌمات رو انجام بدٌنFilter < Noise < Add Noiseبه اٌن قسمت - 2

                                

3  -Duplicate the layer رو با راست کلٌک روی لاٌه انتخاب و Filter < Blur < Gaussian Blur رو روی 

 0.5pxقرار بدٌن  .



 

 

                      

4 -Image < Adjustments < Levelsو اٌن تنظٌمات رو اعمال کنٌد  .

                     

5 -Filter < Blur < Gaussian Blur 2 روpxقرار بدٌن  .

6 -blending mode رو از پالت لاٌه ها روی Lightenقرار بدٌن  .



 

 

                      

7 -Image < Adjustments < Hue/Saturation ٌادتون  ( انتخاب 250-50-0 و تنظٌمات رو به ترتٌب روی

.  تا لاٌه ها ادغام بشنLayer < Merge Downو   ) رو گذاشته باشٌنcolorizeباشه تٌک 

                      

همزمان با ( ٌک داٌره رسم کنٌد ellipse tool رو فشار بدٌن و با ابزار dکلٌد . حالا ٌک لاٌه جدٌد بسازٌد- 8



 

 

) shift+alt فشردن 

.  و کلٌک روی لاٌه داٌرهCtrl کنٌد بوسٌله نگه داشتن selectحالا داٌره خودتون رو - 9

                       

10 -Filter < Render < Clouds بعد .   اٌن قسمت در شکل سٌاره شما تاثٌر داره

 Image < Adjustments < Levelsو تنظٌمات زٌر  :

                      

11 -Filter < Distort < Spherize 100( و ,%Normal . (



 

 

                       

12 -Select < Inverse  و بعد )Select < Feather (2px و دوبار روی  Delete اٌن مرحله برای اٌنه  .  بزنٌد

.  رو فشار بدٌنCtrl + Dو کلٌد . که لبه های داٌره نرم تر بشه

                     

13 -Filter < Brush Strokes < Accented Edgesو تنظٌمات زٌر رو انجام بدٌن  .



 

 

                                         

14 -Image < Adjustments < Hue/Saturation قرار بدٌن205-40-0 و تنظٌمات رو به ترتٌب  .

                     

15 -Duplicate the layer  رو انتخاب و Filter < Blur < Radial Blur  و اٌن تنظٌمات رو اعمال کنٌد 

 100,Zoom,Best اٌن فٌلتر رو دوبار اعمال کنٌد و بعد blending mode رو روی Overlayقرار بدٌن  .

Layer < Merge Down باٌد الان دو تا لاٌه داشته باشٌم.  تا دو لاٌه بالاٌی ادغام بشن .



 

 

                     

 blending modeبعد .  بزاٌد10px  رو روی Filter < Blur < Gaussian Blur و Duplicate the layerدوباره - 16

.  بزارٌد و جای اٌن لاٌه رو با لاٌه زٌری عوض کنٌدColor Dodgeرو روی 

                     

  



 

 

  

  

 :مقدمه

تنها باٌد توجه داشته باشند که اٌن بارکرد ها قابل شناساٌی برای دستگاه های بارکد .دوستان باٌد به ٌاد داشته باشند که ساختن ٌک بار مد ساده تر از آن است که فکر می کنند
. نٌست و به قول معروف تزٌٌنی است

: آموزش

.  را انتخاب کنٌدFilter\noise\addnoiseسپس . پٌکسل اٌجاد کنٌد75 در 150ابتدا ٌک فاٌل با اندازه  .1

. تنظٌمات زٌر را برای آن انجام دهٌد

 

Amount: 100% 
Distribution:Gaussian 
MonoChromic is Checked 

.  را انتتخاب کرده و تنظٌمات زٌر را برای آن انجام دهٌدFilter\Blur\Motion Blurسپس .2

 

Angle:90 
Distance:999 pixel 

.  رفته و تنظٌمات زٌر را انجام دهٌدImage\Adjustment\levelسپس به .3

 

Input Level= 105;1.00;200 

ٌا با استفاده از ابزار انتخاب مستطٌل .  پٌکسل را وارد کنٌد5 بروٌد و مٌزان Select\Modify\Contractبه گزٌنه .  را زده تا همه تصوٌر انتخاب شودCtrl+aحال .4
.  را بزنٌد تا گوشه های تصوٌر پاک شودDelete را انتخاب کنٌد و Select Inverseسپس بر روی تصوٌر کلٌک راست کرده و . کوچکتری انتخاب کنٌد

 

. حال مطاابق تصوٌر قسمتی از پاٌٌن اٌن بارکد را انتخاب می کنٌم و پاک می کنٌم.5

 



 

 

  

. می نوٌسٌم )استفاده از صفر فراموش نشود(سپس درون ان قسمتی که پاک کرده اٌم شماره ای را به صورت دلخواه .6

 

. نمونه ای از کار را مشاهده می کنٌد

 

  

 

 

 اٌن آموزش شامل سه مرحله مٌباشد  

  مرحله اول

 باز مٌکنٌم  ترانس پارنتبرای شروع کار ٌک فاٌل با اندازه دلخواه و با بک گراند -1

 تبدٌل مٌکنٌم screenرا به   blending modeبعد به پانل لاٌه ها مراجعه کرده و -2

 را انتخاب drop shadow,inner shadow,inner glow  را انتخاب کرده و در صفحه باز شده blending optionبا راست کلٌک کردن روی پالت لاٌه ها گزٌنه-3
. مٌکنٌم

  کلٌک کرده وتنظٌمات را مطابق شکل انجام مٌدهٌمدوبار drop shadow روی -4



 

 

 

  مطابق شکل تنظٌمات را انجام مٌدهٌمinner shadow برای گزٌنه -5



 

 

 

 مٌباشد inner glowحال نوبت  -6



 

 

 

 .کلٌک مٌکنٌم ok کلٌک مٌکنٌم بعد روی new style  کلٌک کرده و در قسمت پاٌٌن منوی باز شده روی گزٌنهstyles روی گزٌنه windows اکنون در منوی -7

 قسمت دوم

 تصوٌری را که مٌخواهٌم قطرات آب روٌش ظاهر شود را باز مٌکنٌم- 1

 

  مٌگذارٌمabدر پالت لاٌه ها  ٌک لاٌه جدٌد اٌجاد مٌکنٌم و نام اٌن لاٌه را -2

  را انتخاب کرده و اٌن تنظٌمات را انجام مٌدهٌم brushابزار - 3

Broush size: 13px 

Mode: Normal 

Opacity: 100% 

Flow: 100%. 

 .رنگ  باٌد الزاما سٌاه باشد



 

 

 روی تصوٌر اشکالی شبٌه قطرات آب رسم مٌکنٌم-4

 

 که قبلا درست کرده بودٌم کلٌک مٌکنٌم  style مراجعه کرده و روی styles دوباره به قسمت-5

 

 

 حالت قطره شبٌه سازی شده است تقرٌبا

 . کلٌک مٌکنٌم تا قطره به حالت انتخاب شده دربٌاٌد ab روی لاٌه ctrlحالا ضمن نگه داشتن   -6

 اکنون لاٌه بک گراند را انتخاب کرده و اٌن مسٌر را طی مٌکنٌم     - 7

FILTER>DISTORT>SPHEARIZE 

 و اٌن مقادٌر را وارد مٌکنٌم -8

Amount:100% 

Mode:Normal 

  

  

 بزرگ انتخاب نکنٌد قطرات آب را : توصٌه



 

 

 مرحله سوم

 بوجود آورٌم blending option برای تبدٌل اٌن قطره آب به ٌخ باٌد تغٌٌراتی را در

 کلٌک مٌکنٌم bevel and embossپس روی - 1

   را انتخاب کرده و تنظٌمات را مطابق شکل انجام مٌدهٌم textureسپس - 2

 

 



 

 

 

 . مٌکنٌمok کلٌک کرده و  new style روی styles حال در قسمت  -3

 

 دلخواه نظٌر روش قبلی مٌباشد نحوه اعمال به تصاوٌر

 

 

 آموزش ساخت گوشه هاي پاره

  

. تصوٌر مورد نظر را باز کنٌد )1

. قسمتً از آن را انتخاب کنٌد )2

.  قرار بگٌرٌدQuick Maskدر حالت  )3

4 (Filter<Brush Stork<Spatter 15 و 15 را با اندازه هاي )اجرا کنٌد )ٌا اندازه مناسب .



 

 

.  لبه هاي تصوٌر را به آرامً رنگ کنٌد، تا حالت سوخته پٌدا کندAir Brush و با ٌک قلم موي نرم در ٌک اندازه مناسب و حالت 663300رنگ  )5

.  را فشار دهٌدDeleteو  )Sellect<Inverse( را اجرا کنٌدCtrl+Shift+Iبه حالت استاندارد برگردٌد و  )6

همچنٌن مً توانٌد .  را با سلٌقه خودتان اعمال کنٌدFilter<Texture<Texturizeبه اٌن منظور .  بدهٌدTextureدر صورتٌکه بخواهٌد مً توانٌد به تصوٌرتان  )7
. کمً هم ساٌه به شکل بدهٌد

: نتٌجه )8

 

  

  

 

 چشم کرٌستالی

  

 
  

.  اٌجاد کنٌدTransparent با پس زمٌنه 100*100ٌک لاٌه جدٌد با اندازه .1

رنگ . مثل قهوه ای روشن و قهوه ای تٌره. اٌن دو رنگ باٌد به هم شبٌه باشند و از ٌک خانواده ولی ٌکی روشن و دٌگری تٌره. برای رنگ چشم دو رنگ انتخاب کنٌد. 2
.  انتخاب کنٌدBackground و رنگ روشن را برای پٌش زمٌنه ٌا Foregroundتٌره را برای 

. لاٌه اصلی را با رنگ سفٌد پر کنٌد. 3

.  ٌک مستطٌل بکشٌد و آن را با رنگ تٌره تر پر کنٌد مانند شکل زٌرrectangle marqueeبا استفاده از ابزار . 4



 

 

 

.  را بزنٌدCtrl+I بروٌد و ٌا Image<Adjustment<Invert: به مسٌر . 5

:  بار بر روی لاٌه اعمال کنٌد با مشخصات زٌر3 بروٌد و آنرا Filter<Stylize<Windبه مسٌر . 6

Method :Wind 
Direction :From the Left 

.  را بزنٌدCtrl+I بروٌد و ٌا Image<Adjustment<Invert: دوباره به مسٌر . 7

: ٌک لاٌه جدٌد اٌجاد کنٌد و بعد آنرا انتخاب کنٌد و با رنگ روشنتر آنرا پر کنٌد مانند شکل زٌر. 8

 

.  را برای آن وارد کنٌد4.5 بروٌد و مقدار Filter<Blur<Gaussian Blurبه مسٌر . 9

.  بروٌدLayer<Merge Visibleبه مسٌر . 10

.  را بزنٌدCtrl+I بروٌد و ٌا Image<Adjustment<Invert: دوباره به مسٌر . 11

:  بار بر روی لاٌه اعمال کنٌد با مشخصات زٌر3 بروٌد و آنرا Filter<Stylize<Windدوباره به مسٌر . 12

Method :Wind 
Direction :From the Left 

.  را بزنٌدCtrl+I بروٌد و ٌا Image<Adjustment<Invert: باز هم به مسٌر . 13

:  برٌد و تنظٌمات زٌر را اعمال کنٌد Filter<Blur<Motion Blurبه مسٌر . 14
Strength :30 

Angle :0 

 

.  بروٌدImage < Rotate Canvas < 90 degrees CCWبه مسٌر . 15

. اول انتخاب کنٌد و بعد کپی& اٌن تصوٌر را کپی کنٌد . 16

. فعلا اٌن تصوٌر را رها کنٌد



 

 

 

 قسمت دوم

.  اٌجاد کنٌدTransparent با پٌش زمٌنه 200*200ٌک لاٌه با اندازه . 1

.  کپی کردٌد را در اٌن لاٌه بچسبانٌد16تصوٌری را که در قسمت اول و در مرحله . 2

.  بروٌدLayer<Merge Visibleاٌن لاٌه ای را که کپی کرده اٌد بصورت شکل زٌر ارنج کنٌد و به مسٌر . 3

 

. ٌک لاٌه جدٌد اٌجاد کنٌد و آنرا به زٌر لاٌه فعلی که تصوٌر در آن قرار دارد جا به جا کنٌد.4

: نٌمه بالاٌی لاٌه جدٌد را با رنگ سٌاه پر کنٌد و نٌمه پاٌٌن آنرا با سفٌد پر کنٌد مانند تصوٌر زٌر . 5

 

! مانند تصوٌر زٌر  )بر روی لاٌه با تصوٌر رنگی(ٌک انتخاب اٌجاد کنٌد . 6
 را نگه داشته اٌد محدوده دوم را Shiftبرای اٌنکار ابتدا اولٌن محدوده را انتخاب کنٌد بعد در حالی که . شما مٌتوانٌد همزمان دو محدوده انتخاب ٌا بٌشتر داشته باشٌد: نکته 

.. به شکل زٌر دقت کنٌد. نٌز انتخاب کنٌد



 

 

  

.  را وارد کنٌد2 بروٌد و بعد برای شعاع مقدار Filter<Blur<Gaussian Blurبه مسٌر . 7

 

.  بروٌدLayer < Merge Visibleبه مسٌر . 8

 Rectangular to Polar:  بروٌد و اٌن تنظٌمات را اعمال کنٌد Filter<Distort<Polar Coordinatesبه مسٌر . 9

 
. روی اٌن تصوٌر کمی کار شده است

 

 :افکت های اضافی 

: لنز براق 

.  را نگه داشته و بعد محدوده را انتخاب کنٌدShiftبرای اٌنکار . ٌک انتخاب داٌره ای کامل بر روی لاٌه اٌجاد کنٌد. 1



 

 

 

:  نصف محدوده انتخاب را ساکت کنٌد مانند تصوٌر زٌر ALT انتخاب کنٌد کنٌد و بعد با فشردن Rectangular Marquee (selection) Toolابزار . 2

 

.  بر روی محدوده انتخاب بکشٌدLinear Gradient Toolٌک لاٌه جدٌد اٌجاد کنٌد و با ابزار .  رنگها را به حالت پٌش فرض برگردانٌدDبا فشار دادن .3

 

.  تغٌٌر دهٌدScreenحالت لاٌه جدٌد را به . 4



 

 

 
. رنگها در تصوٌر بالا کمی تغٌٌر کرده اند

!  کار ما تمام شد 

 Info@PersianGraphist.com: چنانچه مشکلی داشتٌد به انجمن مربوطه مراجعه کنٌد ٌا با من تماس بگٌرٌد 

 

 

 

Color mode = RGB  ، 400*400ابتدا ٌک فاٌل در اندازه های  .  و با بک گراند سفٌد باز کنٌد   

 

mailto:Info@PersianGraphist.com
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 را با هم  shift + ctrl + N    را طی کرده و ٌا کلٌد های   layer  =>  new =>layerبرای اٌن کار مسٌر . ٌک لاٌه جدٌد اٌجاد کنٌد 

.  فشار دهٌد و ٌا برروی  دکمه موجود در پانل لاٌه کلٌک کنٌد 

 

  

 

  

   استفاده  می کنٌد ، اٌن فٌلتر وجودPhotoshop csدر صورتٌکه از   .  transform Filter=> Render=> 3d :مسٌر مقابل را طی کنٌد 

. نخواهد داشت و شما باٌستی فاٌل زٌر را داونلود و در داٌرکتورٌه فٌلتر فتوشاپ خود کپی کنٌد 

  .فاٌل زٌپ شده :  کٌلوباٌت      فرمت 100:        حجم 3D Transform: داونلود فاٌل 

  

.  سپس ابزار مکعب  را از منوی اٌن فٌلتر انتخاب و مکعب مربع مناسبی رسم کنٌد   

   

http://www.majidonline.com/images/Tutorials/3D-Transform.rar


 

 

.کلٌک کرده و آنقدر بر روی مکعب خود کار کنٌد تا شکل حاصل به صورت زٌر درآٌد     trackball tool  بر روی    

 

   باشد ابعاد مکعب را به گونه ای تنظٌم کنٌد که جهت دٌد تاس شما بهترٌن حالت را داشته در اٌن قسمت شما باٌد 

 

  را بفشارٌد   Ctrl + I  ٌا کلٌدهای.   کلٌک کنٌد image=> Adjust=> Invert   لاٌه اول را انتخاب ، بر روی   

 

       :حال تنظٌمات زٌر را اجرا کنٌد . را بفشارٌد Ctrl + Uٌا کلٌد های .   کلٌک کنٌد image=> adjust=>hue/saturation  بر روی  

 

 . البته تنظٌمات اٌن قسمت را می توانٌد با صلٌقه خودتان تغٌٌر دهٌد - 

 



 

 

 .کنٌد   )نامرئی( ، بک گراند و  لاٌه اول را  غٌر قابل مشاهده layer  در پانل  با کلٌک بر روی 

 

 .لاٌه ای جدٌد اٌجاد کنٌد 

 

 : رفته و تنظٌمات آن را در هر بار مطابق ٌکی از تنظٌمات زٌر کامل کنٌد View=> New guideشش بار  به مسٌر  

 Horizontal 100 px           Horizontal 200 px            Horizontal 300 px  

    

 Vertical 100 px               Vertical 200 px                Vertical 300 px  
 

 .         را انتخاب و تنظٌمات را مطابق شکل زٌر وارد  کنٌد    eliptical marquee tool ، toolbarاز قسمت  

    
 

 eliptical marquee tool لاٌه اٌجاد شده ، داٌره هاٌی با استفاره از ابزار  6در اٌن مرحله شما باٌستی در هر ٌک از  

: رسم کنٌد ؛ بطورٌکه نحوه قرار گٌری آنها به ترتٌب همانند شکل زٌر باشند 

 

 .دقت کنٌد که داٌره ها بٌن خطوط فرضی رسم شده ، قرار گٌرند -  

 

  لاٌه رو انتخاب 6در اٌن قسمت برای راحتی کار با استفاده از روشی که گفتٌم ، اقدام به نامرئی کردن لاٌه ها کنٌد و فقط ٌکی از آن  

  فراخوانی کنٌد و تنظٌمات آن را   Layer<=  Layer style =>Inner shadow: را از مسٌر  Inner shadowو قابل مشاهده کنٌد ؛ 

 . را کلٌک کنٌد  ok در آخر گزٌنه .مطابق شکل وارد کنٌد 
 



 

 

 
  ok   فراخوانی کرده و تنظٌمات را مطابق شکل وارد کنٌد و در نهاٌت Layer <= Layer style <= satin  را از مسٌر   Satinحال  

.     را کلٌک کنٌد 

 

 

  

 Copy layer:    بر روی لاٌه ای که عملپات را روی آن انجام داده اٌد راست کلٌک کرده و گزٌنه  layerدر اٌن مرحله شما باٌد در پانل 

 style  را انتخاب کنٌد و سپس با راست کلٌک کردن بر روی لاٌه های دٌگر و انتخاب paste layer style   آن را به ساٌر لاٌه ها اعمال  

 .نماٌٌد 
 

 . بعد از انجام دادن موارد بالا شما باٌد تغٌٌراتی در لاٌه ای  که می خواهٌد در ناحٌه بالای تاس قرار گٌرد اعمال نماٌٌد 

.  تاٌی رو انتخاب کردم 5به عنوان مثال من بعد .   را طبق شکل زٌر بر روی آن لاٌه اعمال نماٌٌد 13برای اٌن کار شما مرحله 

 



 

 

 

 .  بعد تاس را مورد استفاده خواهٌد قرار داد 6 بعد از 3دقت کنٌد که شما فقط -   
 به همه لاٌه ها به غٌر از لاٌه مکعب و لاٌه انتخابٌه شما ، خاصٌت  نامرئی اعمال  (. بعد مورد نظر خود کلٌک کنٌد 3   بر روی ٌکی از 

 .  )    کنٌد 

حال لاٌه خود را با استفاده از اٌن دستور چنان تغٌٌر دهٌد  .   را بر گزٌنٌد perspective  گزٌنه  Edit => transformاز منوی  – 

لازم به ذکر است که همه موارد موجود در منوی  .     که درقسمت مورد نظرتان گنجاٌش و نشستی مناسب داشته باشد 

Edit =>Transform     می توانند در اٌن قسمت شما را ٌاری کنند  .

 .اٌن مرحله را برای دو لاٌه دٌگر نٌز عمل نماٌٌد  - 

 

 . انتخاب کنٌد View  را از منوی Clear Guide   برای خاموش کردن تقسٌم بندی صفحه ، گزٌنه  

.    در پاٌان ، کار شما مشابه شکل زٌر خواهد بود 
 



 

 

 

. هر گونه نظر ، پٌشنهاد و پرسش در مورد اٌن آموزش دارٌد ، می توانٌد به پست الکترونٌکی زٌر ارسال نماٌٌد 

Doste_bihamta@yahoo.com   

 امٌن بی رشک

 

 

 چشم های قاتل

 

اگر دوست دارٌد تصاوٌر دوستان خود و ٌا هر تصوٌر انسانی را تبدٌل به ٌک عکس وحشتناک و مانند قاتل های خٌالی بازی ها کنٌد با من در اٌن مقاله همراه شوٌد فقط 
شوخی بود بروٌم سر مقاله  ):ٌادتان نرود اٌن کار را با عکس هر آشناٌی کردٌد به خودش نشان ندهٌد در غٌر اٌن صورت هر چی شد پای خودتون 

  

خب در مرحله اول تصوٌر مورد نٌاز خود را باٌد باز کنٌم و در محٌط فتوشاپ بٌاورٌم برای مثال من تصوٌر زٌر را انتخاب کردم 

mailto:Doste_bihamta@yahoo.com


 

 

 

مرحله دوم اٌن است که شما تا جاٌی که ممکن است روی چشم فرد زوم و بزرگنماٌی می کنٌد البته نه آنقدر که کنترل کار از دستتان خارج شود دقٌقا مانند شکل زٌر 
بزرگنماٌی کافی است 

 

 پٌکسل شروع به محو کردن وسط چشم می شوٌم و باٌد کار شما تا الان به صورت زٌر شده باشد 9  را بر می دارٌم و با رنگ سفٌد و با ساٌز Brushاکنون ابزار 

 

برای شروع اٌن کار . برای نشان دادن خون زٌر چشمان. خب حالا  تنها کافی هست ٌه کم چاشنی به کارمان اضافه کنٌم برای اٌن کار بهترٌن رنگ، رنگ قرمز است
مانند تصوٌر زٌر ابزار نماٌان شده در تصوٌر را انتخاب کنٌد 



 

 

 

: من برای اٌن کار رنگ و ساٌز  زٌر را پٌشنهاد می کنم

color: #FF0000 
size: 9px 

خب حالا شروع می کنٌم زٌر چشمان را خونی کردن البته نه  به صورت منظم بلکه به صورت نامنظم و بسٌار طبٌعی باٌد در اٌن بخش عمل کرد در اصل مهمترٌن بخش 
. کار ما اٌن بخش است

 هر  چه زٌر چشم قرمز تٌره تر شود بسٌار بهتر می باشد کار شما الان مانند تصوٌر زٌر شده است

 

امٌدوارم ار اٌن مقاله استفاده کنٌد فقط توجه کنٌد زٌاد رنگ قرمز را تا پاٌٌن گونه ها نکشٌد و تا همان دور چشم کافی است فقط فراٌند ساٌه خٌلی مهم است که دور چشم پر 
رنگ تر از زٌر آن باشد 

موفق باشٌد 
حمٌد رضا محمد کاظمی 

 

 

 
  

 قطره آب آموزش اٌجاد
  

 .با عرض سلام خدمت جمٌع مجٌدآنلاٌنً هاي با صفا و بامرام 
البته من اٌنو از تو ٌه ساٌت خارجً دٌده بودم و چون انگلٌسٌم هم خوب نٌست با . اٌن آموزشً كه در خدمتتون هستٌم مربوط مٌشه به اٌجاد قطره آب بر روي مكانهاي مختلف 



 

 

  .من از عكسهاي همون آموزش استفاده مً كنم تا وضعٌت نهاًٌ رو ببٌنٌن . توجه به چٌزاًٌ كه مً تونستم بخونم ترجمه كردم 

 .امٌدوارم شما هم بتونٌن از اٌن آموزش استفاده كنٌن 
  

 
 .  اول از همه چٌز طرحتونو باز كنٌن و ٌه منطقه از اون رو با هر ابزار و به هر شكلً كه دوست دارٌن انتخاب كنٌن 

  

 
  

 
 . بار فٌلتر زٌر رو اجرا كنٌن 2رو براي كپً گرفتن از منطقه انتخابً فشار بدٌن و همونطور كه انتخاب رو در اختٌار دارٌن بر روي لاٌه اٌجاد شده  Ctrl+Jحالا كلٌدهاي 

Filter--> Distort --> Spherize 
  

 
  

 
.  به طرحتون بدٌن تا حالت ساٌه داخلً قطره آب رو به وجود بٌارٌن inner shadowشما باٌد كمً .  باز بشه layer styleحالا روي همٌن لاٌه دابل كلٌك كنٌد تا پنجره 

 ). حتما امتحان كنٌن . در اٌن قسمت طبق آموزش ساٌه باٌد سٌاه باشه اما ساٌه ماٌل به رنگ سفٌد رنگ هم تاثٌر جالبً داره  (
  



 

 

 
  

 
براي بلور دادن به اٌن لاٌه سٌاه هم مسٌر زٌر رو دنبال كنٌن . براي اٌن كار از لاٌه قطره ٌه كپً بگٌرٌن و اونو با رنگ سٌاه پر كنٌن . حالا باٌد به قطرتون ٌه مقدار ساٌه بدٌن 

 ). ترتٌب لاٌه ها دقت شود  (. و به مقدار دلخواه اونو تنظٌم كنٌن 
Filter--> Blur--> Gaussian Blur 

  

 
  

 
ٌه لاٌه جدٌد اٌجاد كنٌن و ٌه انتخاب داٌره اي شكل كوچٌك روي قطرتون انجام بدٌن و به اون مثل تصوٌر گرادٌنت سفٌد رنگ . حالا باٌد ٌه حالت انعكاس روي قطره اٌجاد كنٌم 

 .بدٌن 
  



 

 

 
  

 .حالا برٌن توي آشپزخونه و ٌه چاًٌ دبش براي خودتون برٌزٌن و بٌاٌن از طرحتون لذت ببرٌن 
  

 :اٌنم طرح نهاًٌ كه توسط همون ساٌت اٌجاد شده 
  

 
  

 :مصنوعً شدن  )ٌكم نه زٌاد(البته چون ٌكم عجله اي بود داٌره هاش ٌكم . اٌنم تصوٌر اٌجاد شده توسط بنده حقٌر 
 كردم ٌكً از ساٌه داخلً خاكستري و در ٌكً از ساٌه داخلً سٌاه استفاده توجه داشته باشٌن كه من در

  



 

 

 
  

 

 

Aqua pill 

 

 . را در فتوشاپ ٌاد مٌگٌرٌدaqua pillدر اٌن درس شما طرٌقه ساخت 

توجه داشته باشٌد تمامً مراحلً كه در اٌن درس ذكر مً شوند بر حسب قسمتهاي موجود در 
.  مً باشد كه با كمً تفاوت دٌگر فتوشاپها نٌز همٌن قسمتها را نٌز در بر دارند7فتوشاپ 

, شما خودتان مً توانٌد مقادٌر ذكر شده در اٌنجا را برحسب مورد نٌاز و علاقه خود تغٌٌر دهٌد 
. اٌن مقادٌر فقط براي مثال مً باشد

اٌن آموزش از ساٌت مشابه خارجً درٌافت شده و با ٌكسري تغٌٌرات به زبان فارسً ترجمه شده 
است از شما تقاضا دارم چنانچه از اٌن آموزش در جاًٌ دٌگر مٌخواهٌد استفاده نماٌٌد حتما نام و 

.  آدرس اٌن ساٌت را نٌز قٌد نماٌٌد

 >>>طرح شما پس از طراحً مً باٌست مانند شكل روبرو شود 
  

 

   

 

 . پٌكسل اٌجاد نماٌٌد110×50در ابتدا ٌك فاٌل با اندازه 

 . سپس ٌك لاٌه جدٌد اٌجاد نماٌٌد 
 .  وارد نماٌٌدForeground Color راه به عنوان 338FCE#شماره رنگ 

 . آنرا مانند زٌر تنظٌم كنٌدOption را انتخاب نماٌٌد و سپس rectangle toolحال ابزار 

 



 

 

 



 

 

حال در گوشه اي از صفحه ٌك بار كلٌك كنٌد تا شكل مورد نظر رسم 
 .گردد

 

بعد از رسم شكل بر روي لاٌه همٌن شكل دوبار كلٌك كنٌد تا پنجره 
 Layer\Layer هاي لاٌه باز شود و ٌا از منوي Effectمربوط به 

Style گزٌنه drop Shadowدر پنجره اي كه باز .  را انتخاب كنٌد
 رفته و مقادٌر آنرا به Drop Shadowمً شود ابتدا به قسمت 

 .ترتٌبً كه در شكل روبرو مً بٌنٌد تغٌٌر دهٌد

 

 رفته و مقادٌر آنرا نٌز به ترتٌب Inner Shadowسپس به قسمت 
 .شكل روبرو تغٌٌر دهٌد

 

 .دهٌد مطابق شكل زٌر تغٌٌر  بروٌد و مقادٌر آنرا نٌز Inner Glowبعد از آن به قسمت 



 

 

 



 

 

 

 رفته و مقادٌر آنرا مانند Bevel and Embossسپس به قسمت 
 .شكل روبرو تغٌٌر دهٌد

  و بازگشت به محٌط فتوشاپ طرح شما آماده شده است و مانند شكل زٌر مً باشدOKحال پس از فشردن كلٌد 

 
 

  
 

 
 

 

 



 

 

Gel Button 

 

در اٌن آموزش شما نحوه ساخت ٌك كلٌد بصورت ژله اي را ٌاد خواهٌد 
اٌن آموزش سطح مقدماتً دارد و ساختن اٌن كلٌد مستلزم كار با . گرفت

 و PSDبراي راحتً كار دوستان فاٌل . استاٌلهاي فتوشاپ مً باشد
 شده در قسمت درٌافت ZIP اٌن آموزش بصورت ٌك فاٌل ASLفاٌل 

 .برنامه قرار گرفته است كه مٌتوانٌد آنرا درٌافت كنٌد

  ZIP بصورت ASL و PSDفاٌل 
  

 

   

  

    

  

 

سپس شماره رنگ .  اٌجاد نماٌٌد194x50در ابتدا ٌك فاٌل با اندازه 
96B0C5 را به عنوانforeground colorسپس  ابزار .  انتخاب كنٌد

rounded rectangle tool را انتخاب نماٌٌد و مقدار radius آنراه 
20pxقرار دهٌد و كلٌد مورد نظر خودتان را با اندازه دلخواه رسم كنٌد . 

 

  

 Rasterize كلٌك كنٌد و گزٌنه rightسپس بر روي لاٌه اٌجاد شده 
Layerو بعد دوباره بر روي لاٌه .  را انتخاب كنٌدright كلٌك كنٌد و 
و ٌا اٌنكه بر روي لاٌه ( را انتخاب كنٌد Blending Optionsگزٌنه 

 )دوبار كلٌك كنٌد
 

 

 كلٌك كنٌد و inner shadowحالا در قسمت استاٌلها ابتدا بر روي 
  :سپس مقادٌر آنرا مانند زٌر تغٌٌر دهٌد

Blend Mode : Normal  
Colour : FFFFFF  
Opacity : 60%  
Angle : 90  
Distance : 10px  
Spread : 0%  
Size : 0px  

 

 
 gradientشكل 

 

 كلٌك كنٌد و مقادٌر آنرا gradient overlayحالا بر روي گزٌنه 
  :مطابق زٌر تغٌٌر دهٌد

Opacity : 60%  
Style : linear  
Colour : from 999999 to FFFFFF 

 

 

  : را انتخاب كنٌد و تنظٌمات زٌر را انجام دهٌدstrokeحالا گزٌنه 

Size : 1px  
Posisiton : outside  
Blend Mode : Normal  
Colour : 4C555D 

 

 

  : را فعال سازٌد و مقادٌر زٌر را وارد كنٌدinner glowاٌن بار گزٌنه  

Size : 5px  
Opacity : 60%  
Colour : B3C0D0  

 

 را انتخاب كنٌد و مقادٌر زٌر drop shadowبراي آخرٌن كار گزٌنه 
  : را بفشارٌد OKرا وارد كنٌد و پس از آن كلٌد 

Untick 'Use global Angle' 
Angle : 120  
Distance : 0px 
Spread : 2px  
Size : 5px 

 

  

http://www.majidonline.com/modules.php?name=Downloads&d_op=getit&lid=33


 

 

 

حالا طرح شما آماده شده است و فقط باٌد متن خود را بر روي آن 
 .بنوٌسٌد

 
 

 
 

 
  



 

 

  

 

 

Golf Ball In Photoshop 

 !در اٌن آموزش شما با نحوه ساختن ٌك توپ گلف در محٌط فتوشاپ آشنا خواهٌد شد

  

  

    

  

 

 . ابتدا ٌك فاٌل جدٌد بسازٌد و پشت صحنه آن را مشكً رنگ كنٌد

 ٌك داٌره رسم كنٌد و داخل circular marqueeبا استفاده از ابزار
 .آن را با رنگ سفٌد پر كنٌد

 

 

 پٌكسل و با پشت صحنه 20*20حالا ٌك فاٌل دٌگر با اندازه 
Transparent باز كنٌد و سپس با همان ابزار circular 

marquee ٌك داٌره در آن رسم كنٌد و داخل آن را با رنگ سٌاه 
 .پر كنٌد

 

 

 .  وارد كنٌدDimples رفته و نام را Edit: Define patternبه 

.  به فاٌل اصلً بازگردٌدو ٌك لاٌه جدٌد بسازٌد

 كنٌد تا داٌره Ctrl+Clickدر لاٌه اي كه داٌره را رسم كردٌد 
  را Fill پنجره Shift+Deleteانتخاب شود و سپس با فشردن 

. ظاهر نماٌٌد
 تغٌٌر دهٌد و  نقشً را كه ساختٌد از Pattern  را به Useحالا 

  انتخاب كنٌدModeلٌست 

 

 



 

 

 

 .  درجه بچرخانٌد45 را بفشارٌد و جسم را Ctrl+Tحالا  

 رفته و در جعبه متن عدد Filter:Blur:Gassian Blurحالا به  
.   اٌن كار را دوبار تكرار كنٌدCtrl+f را وارد كنٌد و با فشردن 2

  
  

 

 

 را وارد 100  بروٌد و عدد Filter<Distort<Spherizeحالا به 
 .كنٌد

 

 

 را براي تغٌٌر رنگ به رنگ پٌشفرض فشار دهٌد و سپس Dحالا 
X را براي عوض شدن جاي رنگ ها و سپس با فشردن G ابزار 

Gradientرا انتخاب كنٌد  . 

 كنٌد و سپس با انتخاب Ctrl +Clickدوباره روي لاٌه داٌره 
Redial Gradient و تغٌٌر پارامتر Opacity خطً از % 50 به

 .مركز داٌره به طرف بٌرون رسم كنٌد

 



 

 

   

 

.  حالا شمابراي اعمال افكت نور نقش كاملً دارٌد

.   كنٌد سپس همه را انتخواب كپً كنٌدMergeاكنون ٌك لاٌه جدٌد بسازٌد و همه لاٌه ها را روي آن 

.   كنٌدPaste جدٌد بسازٌد و موضوعات كپً شده را در آن Channel بروٌد و ٌك Channelsحالا به تب 

.   شده باز گردٌدMerge را انتخاب كنٌد و به لاٌه RGBحالا 

Shift+Delete 50 را بفشارٌد و لاٌه را با%Grayپر كنٌد   .

.    بروٌدFilter:Render:Lighting effectsبه 

.  شما مً توانٌد هر چند تا منبع نور از انواع مختلف را براي دادن جلوه هاي مختلف به توپ اضافه كنٌد

.   استفاده شده استomni light و ٌك spotlightدر اٌن آموزش از ٌك 

 Height را فعال مٌكنٌم و White is high كه قبلا ساختٌم تغٌٌر مٌدهٌم و Alpha 1  را به Texture Channelحالا 
. تنظٌم مٌكنٌم%   50را روي  

  

 

 

  

 . را فشار دهٌدOkeyحالا 

 



 

 

 

  

 Select كنٌد و سپس Ctrl+Clickحالا روي لاٌه اصلً داٌره 
Inverseكنٌد و قسمت هاي اضافه را پاك كنٌد . 

 

 

Ctrl+l جابجا كنٌد و همچنٌن 125 را فشار دهٌد تا و مثلث سٌاه را تا 
 . حركت دهٌد1/30علامت قهوه اي را تا 

 

 

حالا تغرٌبا كار كامل شده است فقط كافً است لاٌه هاي اضافً را 
پاك كنٌد و نٌز افكت هاي زٌر را روي لاٌه توپ اعمال كنٌد كه براي 

 : راحتً كار در زٌر به انگلٌسً نوشته ام

Inner Shadow  
Hard Light with Black  
Angle -159  

Distance 49 px  
Choke 0%  
Size 62 px  
Colour Overlay  
Blending mode Color  
Colour #929AA0  
Opacity 100%  
Gradient Overlay  

Blending Mode Overlay  
Style: Linear  
Angle 24 degrees  
Scale 70%  

 

  

 

 

.  امروز مً خوام طرز چهار خونه كردن ٌه عكس رو توضٌح بدم

 شاٌد كساًٌ باشن كه بخوان به ساٌتشون ٌه كمً زٌباًٌ گرافٌكً بدن خوب شروع مً كنٌم 
 

  را انتخاب كنٌد همانند عكس زٌرFile<Newبعد به منو بالاي صفحه رفته و . اول از همه ٌه عكس انتخاب كنٌد



 

 

 

و بعد از اٌنكه اٌن كار رو كردٌد ٌك پنجره وسط صفحه فتوشاپ باز مً شه و دوباره همانند عكس زٌر آن را پر كنٌد 

 

بعد اگر با توجه به عكس عمل كرده باشٌد تصوٌر شما باٌد همانند عكس باشد .  را كلٌك كنٌدokبعد از اٌنكه همانند عكس عمل كردٌد 

 

>   استفاده كنٌدzoomبراي دٌدن بهتر و نزدٌكتر باٌد از ابزار 



 

 

 

 كنٌد تا اٌنكه تصوٌر شما مانند عكس زٌر شود zoom inشما باٌد آنقدر 

 

همانند عكس عمل كنٌد .  كلٌك كنٌدLine Tool بر روي Toolsبراي مرحله دٌگر كار باٌد در همان قسمت ابزار 

 

بعد سعً كنٌد كه مانند عكس زٌر دوتا مستطٌل بكشٌد  
  )توجه شما مً توانٌد از هر رنگً استفاده كنٌد، اما من اٌنجا از سٌاه استفاده كردم(



 

 

 

 و ٌا طرحً كه بعدآ باٌد از آن استفاده Patternبا اٌن كار شما ٌك .  بروٌدEdit<Define Patternبعد از اٌنكه كار شما با درست كردن مستطٌل ها سٌاه تموم شد به قسمت 
.  كنٌد را درست كرده اٌد

 
 است pattern4بعد مانند عكس زٌر براي طرح خود نام انتخاب كنٌد كه در اٌنجا 

 

.   را كلٌك كنٌدokو بعد بر روي 
.  پنجره را ببندٌد و به عكس خود بر گردٌد

 
.   است كه با توجه به عكس زٌر آن را انجام دهٌدlayerاولٌن كار شما اٌنجا درست كردن ٌك 

 

 بروٌد Edit<Fillي كه قبلآ درست كرده بودٌد را به اٌنجا بٌاورٌد همانند عكس به قسمت Patternبعد براي اٌنكه 



 

 

 

.  بعد از اٌن كار پنجره جدٌدي در وسط صفحه باز مً شود كه شما باٌد همانند دو عكس زٌر عمل كنٌد

 

 

 



 

 

.  عكس خود را تعٌٌن كنٌد )تاري( شما مً توانٌد مقدار كدري Opacityتوجه داشته باشٌد كه در قسمت 
 

 خسته نباشٌد . كار شما تمام شد
 

 هستند  Opacity<15 تا نمونه با رنگهاي قرمز و سٌاه هست كه با 2پاٌٌن 

 

 

 

  باز کنٌد 400 در 400اول ٌک صفحه 

.   را سٌاه انتخاب کنٌدback-ground colorرنگ 

 بروٌد و مقادٌر زٌر را وارد کنٌد filter<render<lense flareحالا برای درست کردن ٌک روشناٌی نامنظم ذره بٌنی به 



 

 

 

استفاده کرد برای اٌن کار به  <<<< radial blurr>>> ا .) effect(و حال بعد از اٌنکه روشناٌی نامنظم ذره بٌنی را درست کردٌد می باٌستی از اثر 
filter<blurr<radial blurهمانند عکس زٌر .  بروبٌد

 

 را Duplicate Layer رفته و Layer کنٌد برای انجام اٌن کار به منوء duplicateدر قسمت بعدی از کارمان باٌد لاٌر خود را .  شده شده باشدblurحالا باٌد تصوٌر شما 
هم اکنون تصوٌر شما باٌد مانند عکس زٌر شود .  جدٌد خود را خمٌر ستاره بگذارٌدLayerو نام . انتخاب کنٌد



 

 

 

 

بروٌد و مقادٌر را بدلخواه وارد کنٌد  )filter<render<lense flare( برای درست کردن روشناٌی نامنظم ذره بٌنی lense flareو حالا دوباره به 



 

 

 

.  مواظب باشٌد که نورتان را طبٌعی تر کنٌد
  )!با رنگ سفٌد( نقطه گذاری کنٌدpaint brush tool جدٌد درست کنٌد و بوسٌله Layerبرای انجام اٌن کار اول ٌک . و حالا چند تا ستاره درست کنٌد

 



 

 

و حالا شما باٌد .  تغٌٌر می دهٌم59 را به Amount می روٌم و فقط filter<blur<radial blur جدٌد به Layerحالا ما برای اٌنکه تصوٌر خود را کمی تٌره تر کنٌم در 
  )و ٌا بهتر(چٌزی مانند زٌر انجام داده باشٌد

 

و کاری مانند نمونه زٌر انجام دهٌد . smuge tool و Lighting Effectکمی به تصوٌرتان دستکاری کنٌد به وسٌله !!! شما کارتان تمام شده است

 



 

 

 

 

Electric Line  

   

   

 ) و ٌا با پس زمٌنه تٌرهTransparentترجٌحا . (ٌک فاٌل جدٌد در اندازه دلخواه بسازٌد )1
 
 
 
.  هاي مختلف و رنگ هاي مختلف سعً کنٌد که بوم خود را به طور نامنظم رنگ کنٌدBrushبوسٌله  )2
 
 
 
3 (Filter<Pixelate<Mezzotint را با انتخاب Fine Dotsاعمال کنٌد  .
 
 
 
 .  را به صورت زٌر اعمال کنٌدFilter<blure<motion blure: حالا قسمت جالب کار  )4

 

   

   

:  نتٌجه به اٌن صورت شده. حالا مً تونٌد ٌک لاٌه تٌره رنگ به عنوان پس زمٌنه اضافه کنٌد )3

 



 

 

   

   

:  اٌنها بعضً از کاربردهاي اٌن تمرٌن هستند )4

 

 

 

3D-Organic 

 .در اٌن آموزش با انجام چند مرحله بسٌار ساده مٌتوانٌد ٌك اندام سلولی جالب را طراحی كنٌد - 1
.  سطح اٌن آموزش متوسط است ، كاربران فتوشاپ کار عزٌز مٌتوانند به راحتً طراحی كنند - 2
.  به بالا قابل اجراست 5اٌن آموزش ار فتوشاپ - 3
.  هست Plastic wrapهدف ار اٌن آموزش کار کردن با ابزار های فتوشاپ و استفاده از فٌلتر - 4
. تمام مقادٌري كه در اٌنجا ذكر شده اند همه پٌشنهادي مٌباشند و شما مٌتوانٌد آنها را با توجه به نٌاز خود تغٌٌر دهٌد- 5

  
 

  

ٌک داٌره ای  radial gradientبعد در ٌک لاٌر جدٌد با استفاده از ابزار ... ٌک صفحه جدٌد به اندازه دلخواه با بک گراند مشکی درست مٌکنٌم - 1
 مطابق شکل درست مٌکنٌم 

 

.   و سپس ٌک داٌره دٌگه مٌکشٌم blending mode = lightenباز ٌک لاٌر جدٌد دٌگه درست مٌکنٌم و بعدش مقدار - 2
   



 

 

 

.  خوب اٌن کار را چند بار انجام مٌدٌم تا شبٌه ٌه اندام سلولی بشه - 3

 

 قبول Hs11, D13, S10 مٌرٌم با مقدار Filter/Artistic/Plastic wrap مٌکنٌم و بعد به Mergeو بعد لاٌر ها رو باهم همه لاٌر ها رو لٌنک - 4
  )البته اٌن بستگی به سلٌقه شما داره(مٌکنٌم 

 

.  حالا با استفاده از ماسک دور عکس رو پاک مٌکنٌم تا شبٌه شکل زٌر بشه - 5



 

 

 

.  بعدش به دلخواه ٌه رنگی بهش مٌدٌم ...  را فعال مٌکنٌم colorize مٌرٌم و Adjust your hue & saturationبه - 6

 

.   ٌه شکلی جالب بهش بدٌم Filter/Distort/Wavesمً تونٌم با استفاده از 
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  با سلام در اٌن آموزش شما ٌاد می گٌرٌد که به چه صورت می توان ٌک نوشته پٌتزاٌی در فتوشاپ رسم کنٌد

  .در قسمت اول طرٌقه ساختن نان پٌتزا را فرا خواهٌد گرفت. اٌن آموزش در چهار قسمت تنظٌم شده است

فتوشاپ سازگاری دارد اگر شما مبتدی هستٌد و تسلط کافی به فتوشاپ ندارٌد مراحل اٌن آموزش را actionاٌن آموزش کاملا با سٌستم 
قدم به قدم و همانطوری که ذکر شده و با همان متغٌر ها اجرا کنٌد و در صورت برخورد با مشکلی در مورد اٌن آموزش به 

 ... انجمن فتوشاپ مراجعه کنٌد و در صورتی که مشکل شما حل نشد با نوٌسنده اٌن آموزش تماس بگٌرٌد کنٌد 

 

  

 

 

    

  پٌکسل اٌجاد کنٌد و متن خود را با رنگ 350 در 600ابتدا ٌک فاٌل جدٌد با اندازه    

 flatten imageرفته و گزٌنه layer  سٌاه و با ٌک فنت توپر و کلفت بنوٌسٌد و به منوی 

 شما تبدٌل به ٌک لاٌه  backgroundرا بر گزٌنٌد که با اٌن کار لاٌه متن شما و لاٌه   

 را کشٌده و روی دکمه blueها رفته و کانال channelبه قسمت .   می شوند 

   create new channel[ ] رها کنٌد که با اٌن کار ٌک کپی از کانالblue به نام 

  blue copy اٌجاد می شود سپس روی کانال اٌجاد شده دو بار کلٌک کنٌد و در 

 را تاٌپ کنٌد که با اٌن کار نام origکلمه  nameدر قسمت channel option  پنجره 

 را بفشارٌد[ctrl+i]تغٌٌر نام می دهد سپس کلٌد های مٌانبر orig  کانال جاری به 



 

 

 را انتخاب کنٌد و مجددinvertگزٌنه adjustmentsرفته و از گزٌنه  image   ٌا به منوی 

 رها کنٌد سپس[ ]create new channelرا کشٌده و روی دکمه  orig  کانال 

 تغٌٌرcrust   مانند گذشته روی کانال اٌجاد شده دو بار کلٌک و نام اٌن کانال را به 

 رفته و گزٌنه  editانتخاب شده است به منوی crust   دهٌد سپس در حالی که کانال 

   fill را انتخاب کنٌد و در پنجرهfill حالت:use راblack قرار دهٌد که با اٌن کار کانال 

   crust تماما به رنگ سٌاه در می آٌد سپس به منویselect رفته و گزٌنه 

  load selection را انتخاب کنٌد و در پنجرهload selection و در قسمتchannelکانال 

  origرا که قبلا ساخته بوده اٌم انتخاب کنٌد که با اٌن کار محدوده نوشته شما در 

 به حالت سلکت در می آٌدcrust  کانال 

 

    

 را انتخاب کنٌد و در پنجرهexpand گزٌنه modifyرفته و از مجموعه select    به منوی 

  expand selection مقدارexpand by پٌکسل قرار دهٌد و به منوی 8راeditرفته و گزٌنه 

   fill را انتخاب کنٌد و حالتuse راwhiteانتخاب کنٌد که با اٌن عمل منطقه سلکت 

 را بفشارٌد تا[ctrl+d]   شده به رنگ سفٌد در می آٌد سپس کلٌدهای مٌانبر 

 رفته و از مجموعه filterبه منوی .    منطقه سلکت شده از حالت سلکت خارج شود 

 قرار 4را radiusرا بر گزٌنٌد و در اٌن فٌلتر مقدار gaussian blurفٌلتر blur  فٌلترهای 

 را [ctrl+l]  دهٌد و فٌلتر را روی کانال جاری اجرا کنٌد سپس کلٌد های مٌانبر 

 را انتخاب کنٌدlevelsگزٌنه adjustmentsرفته و از گزٌنه  image  بفشارٌد ٌا به منوی 

 :  و آن را مانند شکل زٌر تنظٌم کنٌد 



 

 

 

 

    

 را انتخاب و لاٌه جدٌد اٌجاد کنٌد برای اٌن کار backgroundرفته و لاٌه layers   به پنل 

 newرفته و از گزٌنه layerرا بفشارٌد ٌا به منوی [shift+ctrl+n]   کلٌد های مٌانبر 

 را تاٌپcrustکلمه nameدر قسمت new layerرا انتخاب کنٌد و در پنجره layer  گزٌنه 

 اٌجاد می شود  backgroundدر بالای لاٌه crust  کنٌد که با اٌن کار ٌک لاٌه به نام 

 رفته  editرا انتخاب کنٌد و به منوی RGBباز گشته و کانال channel  سپس به قسمت 

 انتخاب کنٌد که با اٌنwhiteرا USEحالت fillرا انتخاب کنٌد و در پنجره fill  و گزٌنه 

 را انتخاب کنٌد و به crustبه رنگ سفٌد در می آٌد سپس کانال RGB  عمل  کانال 

 را بر گزٌنٌد و در اٌنcrystallize فٌلتر pixelate  منوی فٌلتر رفته و  از مجموعه فٌلترها 

 قرار دهٌد و فٌلتر را اجرا کنٌد سپس مجدد به منوی8را برابر با cell size  فٌلتر مقدار 

  filter و از مجموعه فٌلترهای   رفتهsketch فٌلترstampرا بر گزٌنٌد و در اٌن فٌلتر 

 قرار دهٌد5را برابر با smoothnessو مقدار 25را برابر با light/dark balance  مقدار 

 فٌلترblurرفته و از مجموعه فٌلتر filter  و فٌلتر را روی کانال اجرا کنٌد مجدد به منوی 

  gaussian blur را برگزٌنٌد و در اٌن فٌلتر مقدار radius قرار دهٌد و فٌلتر را 4را برابر با  

 را بفشارٌد تا پنجره [ctrl+l]  روی کانال جاری اجرا کنٌد سپس کلٌد های مٌانبر 

  levels فعال شود و اٌن پنجره را مانند شکل زٌر تنظٌم کنٌد: 



 

 

 

 

    

 کلٌک crust روی کٌبورد را پاٌٌن  نگه داشته اٌد روی کانال [ctrl]  در حالی که کلٌد 

   کنٌد که با اٌن کار محدوده اٌن کانال به صورت سلکت شده در می آٌد سپس کانال

  RGB را انتخاب کنٌد و به منویedit رفته و گزٌنهfill را انتخاب کنٌد و در پنجرهfillحالت 

  use راblack انتخاب کنٌد که با اٌن کار در کانالRGB محدوده سلکت شده به رنگ 

 را بفشارٌد تا محدوده سلکت [ctrl+d]  سٌاه در می آٌند سپس کلٌد های مٌانبر 

 رفته و از مجموعه فٌلتر های filterبه منوی .   شده از حالت سلکت خارج شود 

  blur  فٌلترgaussian blur  را انتخاب کنٌد و در اٌن فٌلتر مقدارradius قرار8را برابر با 

 رفته و از filter  دهٌد و فٌلتر را روی اٌن کانال اجرا کنٌد سپس مجدد به منوی 

 را برابر angleرا انتخاب کنٌد و در اٌن فٌلتر مقدار embossفٌلتر stylize  مجموعه فٌلتر 

 .درصد قرار دهٌد150را برابر با amountو مقدار 4را برابر با heightو مقدار 135   با 

  را بر گزٌنٌد و درgaussian blurفٌلتر blurرفته و از مجموعه فٌلتر های filter  به منوی 

 قرار دهٌد و اٌن فٌلتر را روی کانال خود اجرا کنٌد3را برابر با radiusاٌن فٌلتر مقدار   

   



 

 

 

     

 رفته و گزٌنه  SELECTانتخاب شده است به منوی RGB   در حالی که کانال 

  load selection را انتخاب کنٌد و در پنجره اٌن گزٌنه در قسمتchannel کانالcrus که 

 را انتخاب featherرفته و گزٌنه  select  قبلا ساخته بودٌم را انتخاب کنٌد و به منوی 

 قرار دهٌد سپس4را برابر با feather radius  و در پنجره مربوط به اٌن گزٌنه مقدار 

 را بفشارٌد که با اٌن کار قسمتهاٌی که سلکت شده[shift+ctrl+i]  کلٌد های مٌانبر 

 را برگزٌنٌد fillرفته و گزٌنه  editبه منوی .   نٌستند به حالت سلکت در می آٌند 

 قرار دهٌد که با اٌن عمل مناطق black را use  و در پنجره مربوط به اٌن گزٌنه حالت 

 fade fillرفته و گزٌنه  edit  سلکت شده به رنگ سٌاه در می آٌند سپس به منوی 

 قرار دهٌد 50را برابر با opaciyرا انتخاب کنٌد و در پنجره مربوط به اٌن گزٌنه مقدار   

 را بفشارٌد که با اٌن عمل قسمتهای سلکت شده [ctrl+d]  سپس کلٌد های مٌانبر 

 اٌجادtexture  از حالت سلکت در آٌند سپس به روش ٌاد شده ٌک لاٌه جدٌد با نام 

 قرار دهٌد whiteرا  useرا انتخاب کنٌد و حالت fillرفته و گزٌنه  edit  کنٌد و به منوی 

 را انتخاب add noise فٌلتر noiseرفته و از مجموعه فٌلتر های  filter  سپس به منوی 

 distripbutionقرار دهٌد و حالت 24.71را برابر با amount  کنٌد و در اٌن فٌلتر مقدرا 

 را تٌک دار کنٌد و فٌلتر را روی لاٌهmonochromaticانتخاب کنبد و گزٌنه gaussianرا   

  texture اجرا کنٌد و کلٌد های مٌانبر [ctrl+l] را بفشارٌد و پنجرهlevels را مانند 

 :  شکل زٌر تنظٌم کنٌد



 

 

 

 

    

 را انتخاب کنٌدgaussian blurفٌلتر blurرفته و از مجموعه فٌلتر های  filter  به منوی 

 اجرا کنٌد سپسtextureقرار دهٌد و فٌلتر را روی لاٌه 1را radius  و در اٌن فٌلتر مقدار 

 :را مانند شکل زٌر تنظٌم کنٌدlevelsرا بفشارٌد و  پنجره [ctrl+l]  کلٌد های مٌانبر 

 

 را کشٌده و روی دکمه blueرفته و کانال channel  سپس به پنل 

   create new channel[ ] رها کنٌد روی کانال اٌجاد شده به نامblue copy 

 RGBتغٌٌر نام دهٌد و کانال textureدو با کلٌک کنٌد سپس نام اٌن کانال را به   



 

 

 راUSEرا انتخاب کنٌد و حالت FILLرفته و گزٌنه EDIT  را انتخاب کنٌد و به منوی 

  WHITE انتخاب کنٌد که با اٌن کار کانالRGB به رنگ سفٌد در می آٌد. 

 را انتخاب کنٌد و در پنجره مربوطهLOAD SELECTIONرفته و گزٌنه SELECT  به منوی 

 را انتخاب کنٌد و کلٌد های مٌانبر TEXTUREرا کانال CHANNEL  حالت 

  [SHIFT+CTRL+I]را بفشارٌد تا مناطق سلکت نشده به حالت سلکت شده در آٌند 

 را USEرا انتخاب کنٌد و در اٌن گزٌنه حالت FILLرفته و گزٌنه  EDIT  سپس به منوی 

  BLACK قرار دهٌد که با اٌن کار مناطق سلکت شده به رنگ سٌاه در می آٌند 

 را بفشارٌد تا مناطق سلکت شده از حالت انتخاب در [ctrl+d]  سپس کلٌد های 

 را بر گزٌنٌد و در پنجرهload selectionرفته و گزٌنه  select  آٌند سپس مجدد به منوی 

 روی کٌبوردdeleteرا انتخاب کنٌد و دکمه texture کانالchannel  اٌن گزٌنه در قسمت 

 کلٌد های مٌانبر.   را بفشارٌد که با اٌن کار قسمت انتخاب شده پاک می شوند 

   [ctrl+d] را بفشارٌد سپس مجدد به منویselect رفته و گزٌنهload selection  

 را که قبلا ساخته بودٌم crustکانالchannel   انتخاب کنٌد و در اٌن گزٌنه در قسمت 

  را انتخاب کنٌد و در اٌن گزٌنه featherرفته و گزٌنه select  انتخاب کنٌد و به منوی 

  feather radius قرار دهٌد و کلٌد های مٌانبر 4مقدار را برابر با [shift+ctrl+i]  را 

 روی کٌبورد خود را بفشارٌد و کلٌد های مٌانبر delete  بفشارٌدسپس دکمه 

  [ctrl+d] را بفشارٌد تا مناطق سلکت شده از حالت سلکت خارج شوند 

 

    

 کلٌک کنٌد []lock transparent pixelsرا انتخاب کنٌد و روی دکمه texture  لاٌه 

 قرار هٌدblackرا  useرا انتخاب کنٌد و حالت fillرفته و گزٌنه edit  سپس به منوی 

  کلٌک کنٌد تا لاٌه شما از []lock transparent pixels  سپس دوباره روی دکمه 

 دوبار کلٌک کنٌد تا پنجره texture  حالت قفل شده خارج شود سپس روی لاٌه 

  layer style فعال شود و قسمتbevel and emboss را فعال سازٌد و اٌن قسمت را 

 :  مانند شکل زٌر تنظٌم کنٌد



 

 

 

 تا لاٌه []textureرا انتخاب کنٌد و روی مربع کوچک کنار لاٌه crust  سپس لاٌه 

  texture به لاٌهcrust لٌنک شود و به منویlayer رفته و گزٌنهmerge linkedرا انتخاب 

 رفته و  filterلاٌه به هم لٌنک شده با هم ترکٌب شوند سپس به منوی .   کنٌد تا دو

 را انتخاب کنٌد و در اٌن فٌلتر مقدارadd noiseفٌلتر noise  از مجموعه فٌلتر های 

  amount قرار دهٌد و در قسمت 2.35را برابر باdistripbution گزٌنهgaussianرا انتخاب 

 textureرا تٌک دار کنٌد و به روش ٌاد شده ٌک لاٌه به نام monochromatic  کنٌد و

 را بفشارٌد تا رنگهای شما به صورت پٌش فرض [d]  اٌجاد کنٌد سپس کلٌد مٌانبر 

 را انتخابcloudsفٌلتر renderرفته و از مجموعه فٌلترهای filter  تغٌٌر ٌابد و به منوی 

 dry brushفٌلتر artisticرفته و از مجموعه فٌلترهای filter  کنٌد سپس به منوی 

 را brush detailو مقدار 2را برابر با  brush sizeرا انتخاب کنٌد و در اٌن فٌلتر مقدار   

 اجرا  texture قرار دهٌد و اٌن فٌلتر را روی لاٌه 1را برابر با textureو مقدار 8  برابر با 

 بار دٌگر روی 3 فٌلتر جاری را [ctrl+f]مرتبه زدن  کلٌد های مٌانبر 3  کنٌد سپس با

 تغٌٌر دهٌدmultipyبه normalرا از textureاجرا کنٌد سپس حالت لاٌه texture  لاٌه 



 

 

   

 تغٌٌر دهٌد75به 100را از textureلاٌه opacity  و 

 

   

 را به اٌن لاٌه لٌنک کنٌدtextureرا انتخاب کنٌد و به روش ٌاد شده لاٌه crust لاٌه   

 را بفشارٌد تا دو لاٌه به هم لٌنک شده با هم ترکٌب [ctrl+e]  و کلٌد های مٌانبر 

 را بفشارٌد و پنجره [ctrl+l]کلٌد های مٌانبر .   شده و تبدٌل به ٌک لاٌه شوند 

  levels را مانند شکل زٌر تنظٌم کنٌد: 

  

  را انتخاب plastic wrapفٌلتر artisticرفته و از مجموعه فٌلترهای filter   و به منوی 

 9را برابر با detailو مقدار 15را برابر با highlight strength  کنٌد و در اٌن فٌلتر مقدار 



 

 

 اجرا کنٌدcrust قرار دهٌد و فٌلتر را روی لاٌه 7را برابر با smoothness  و مقدار 

 را انتخاب کنٌد و در اٌن گزٌنه مقدار fade plastic wrapرفته و گزٌنه  edit  و به منوی 

  opacity قرار دهٌد سپس کلٌد های مٌانبر 20را برابر با [ctrl+u]را بفشارٌد و پنجره 

  hue/saturation را مانند شکل زٌر تنظٌم کنٌد: 

    

 را کشٌده و روی دکمهorigرا انتخاب کنٌد و کانال channels  پنل 

   create new channel[ ] رها کنٌد و روی کانالorig copyدوبار کلٌک کنٌد 

 رفته و از مجموعه فٌلتر های  filterبه منوی . تغٌٌر دهٌد sauce  و نام اٌن کانال را به 

  blur  فٌلترgaussian blur را انتخاب کنٌد و در اٌن فٌلتر مقدارRadius قرار6را برابر با 

 را [ctrl+l]اجرا کنٌد سپس کلٌد های مٌانبر sauce  دهٌد و اٌن فٌلتر را روی کانال 

 :را مانند شکل زٌر تنظٌم کنٌدlevels  بفشارٌد و پنجره 



 

 

 

 .  ادامه آموزش را در قسمت بعدي دنبال كنٌد

   
  

 

  با سلام در اٌن آموزش شما ٌاد می گٌرٌد که به چه صورت می توان ٌک نوشته پٌتزاٌی در فتوشاپ رسم کنٌد

  .در قسمت سوم طرٌقه ساختن پنٌر پٌتزا را فرا خواهٌد گرفت. اٌن آموزش در چهار قسمت تنظٌم شده است

فتوشاپ سازگاری دارد اگر شما مبتدی هستٌد و تسلط کافی به فتوشاپ ندارٌد مراحل اٌن آموزش را actionاٌن آموزش کاملا با سٌستم 
قدم به قدم و همانطوری که ذکر شده و با همان متغٌر ها اجرا کنٌد و در صورت برخورد با مشکلی در مورد اٌن آموزش به 

 ... انجمن فتوشاپ مراجعه کنٌد و در صورتی که مشکل شما حل نشد با نوٌسنده اٌن آموزش تماس بگٌرٌد کنٌد 

 

  

 

http://www.majidonline.com/page.php?page=content&op=cntshow&code=188


 

 

 

   

 را انتخاب کنٌد crystallizeفٌلتر pixelateرفته و از مجموعه فٌلتر های filter  به منوی 

 قرار دهٌد و فٌلتر را اجرا کنٌد مجدد به منوی6را برابر با cell size  و در اٌن فٌلتر مقدار 

  filter رفته و از مجموعه فٌلتر هایsketch فٌلترstampرا برگزٌنٌد و در اٌن فٌلتر مقدار 

  light/dark balance قرار دهٌد و مقدار 25را برابر باsmoothness قرار دهٌد5را برابر با 

 رفته و از مجموعه filterاجرا کنٌد سپس مجدد به منوی cheese  و فٌلتر را روی کانال 

 را برابرradiusرا انتخاب کنٌد و در اٌن فٌلتر مقدار gaussian blurفٌلتر blur  فٌلتر های 

 را مانند levelsرا بفشارٌد و پنجره [ctrl+l]سپس کلٌد های مٌانبر .  قرار دهٌد 4  با 

 درcheese  شکل زٌر تنظٌم کنٌد سپس به پنل لاٌه ها رفته و ٌک لاٌه جدٌد با نام 

 راuseرفته و دراٌن گزٌنه حالت editاٌجاد کنٌد سپس به منوی sauce  بالای لاٌه 

  white قرار دهٌد که با اٌن کار لاٌهcheese به منوی . به رنگ سفٌد در می آٌدselect 

 ها کانالchannelراانتخاب کنٌد و در اٌن گزٌنه در قسمت load selection  رفته و گزٌنه 

  cheese را انتخاب کنٌد سپس مجدد به منویedit رفته و گزٌنهFillرا انتخاب کنٌد 

 را انتخاب کنٌدکه با اٌن کار مناطق سلکتblackحالت use  و در اٌن گزٌنه در قسمت 

 سپس به. را بفشارٌد [ctrl+d]کلٌد های مٌانبر .   شده به رنگ سٌاه در می آٌند 

 را انتخاب کنٌدgaussian blurفٌلتر blurرفته و از مجموعه فٌلتر های filter  منوی 

 اجرا کنٌدcheeseقرار دهٌد و فٌلتر را روی لاٌه 4را برابر با radius  و در اٌن فٌلتر مقدار 

 را embossفٌلتر stylizeرفته و از مجموعه فٌلتر های filter  سپس مجدد به منوی 

 4را برابر با heightدرجه و مقدار 135را برابر با angle  انتخاب کنٌد و در اٌن فٌلتر مقدار 

 درصد قرار دهٌد و فٌلتر را روی لاٌه اجرا کنٌد سپس150را برابر با amount  و مقدار 

 را انتخابgaussian blurفٌلتر blurرفته و از مجموعه فٌلتر های filter  مجدد به منوی 

  قرار دهٌد و ٌک بار کلٌد های مٌانبر 4را برابر با  radius  کنٌد و در اٌن فٌلتر مقدار 

  [ctrl+f] به منوی . را بفشارٌد تا فٌلتر جاری مجدد ٌک بار دٌگر اجرا شودeditرفته و 

 قرار 50را برابر با opacityرا برگزٌنٌد و در اٌن گزٌنه مقدار fade gaussian blur  گزٌنه 

 را انتخاب کنٌد و در اٌنload selectionرفته و گزٌنه selection  دهٌد سپس به منوی 



 

 

 selectionمجدد به منوی . را انتخاب کنٌد cheeseها کانال channel   گزٌنه در قسمت 

 را برابر باfeather radiusرا انتخاب کنٌد و در اٌن گزٌنه مقدار featherرفته و گزٌنه   

 . را بفشارٌد [shift+ctrl+i]قرار دهٌد و کلٌد های مٌانبر 4  

 انتخاب blackرا useرا برگزٌنٌد و در اٌن گزٌنه حالت fillرفته و گزٌنه edit  به منوی 

 را انتخاب کنٌد و در اٌن گزٌنه مقدارfade fillرفته و گزٌنه edit  کنٌد سپس به منوی 

  opacity قرار دهٌد و کلٌد های مٌانبر 50را برابر با[ctrl+d] را بفشارٌد. 

   

 

    

 اٌجاد کنٌد سپس در حالی که لاٌهcheeseدر بالای لاٌه texture  ٌک لاٌه جدٌد با نام 

 رفته و از مجموعهfilterرا بفشارٌد و به منوی [d]  جدٌد را انتخاب کرده اٌد کلٌد مٌانبر 

 رفته و از filterمجدد به منوی  . را انتخاب کنٌد cloudsفٌلتر render  فٌلتر های 

 را انتخاب کنٌد و در اٌن فٌلتر مقدار dry brushفٌلتر artistic  مجموعه فٌلترهای  

  brush size  و مقدار 2را برابر باbrush detail و مقدار 8را برابر باtexture 1را برابر با 

 اجرا کنٌد سپس سه مرتبه کلٌدهای مٌانبر texture  قرار دهٌد و فٌلتر را روی لاٌه 

  [ctrl+f] را بفشارٌد و حالت لاٌهtexture را ازnormal بهmultipy تغٌٌر دهٌد وopacity 

 textureرا انتخاب کنٌد و لاٌه cheeseتغٌٌر دهٌد سپس لاٌه 61به 100اٌن لاٌه را از   

 را بفشارٌد تا لاٌه های به هم[ctrl+e]  را به اٌن لاٌه لٌنک کنٌد و کلٌد های مٌانبر 

 را بفشارٌد و پنجره[ctrl+l]  لٌنک شده با هم ترکٌب شوند سپس کلٌد های مٌانبر 

   levelsرا مانند شکل زٌر تنظٌم کنٌد: 



 

 

  

 اٌجاد کنٌد و اٌن لاٌه را انتخاب کنٌد و بهtexture  سپس مجدد ٌک لاٌه جدٌد با نام 

 را انتخاب کنٌد و در اٌن گزٌنه در load selectionرفته و گزٌنه select  منوی 

[ shift+ctrl+i]را انتخاب کنٌد و کلٌد های مٌانبر textureها کانال channel  قسمت 

 USEرا انتخاب کنٌد و در اٌن گزٌنه حالت  fillرفته و گزٌنه  editرا بفشارٌد و به منوی   

 .را بفشارٌد [ctrl+d]انتخاب کنٌد و کلٌد های مٌانبر blackرا   

 فعال می شودlayer styleکلٌک کنٌد که با اٌن کار پنجره texture   دو بار روی لاٌه 

 را فعال سازٌد و اٌن قسمت را مانند شکلbevel and emboss  در اٌن پنجره  قسمت 

 :  زٌر تنظٌم کنٌد



 

 

  

   

 

    

 را به اٌن لاٌه لٌنک کنٌد و کلٌد های مٌانبرtextureرا انتخاب کنٌد و لاٌه cheese  لاٌه 

  [ctrl+e] را بفشارٌد و کلٌد های مٌانبر[ctrl+u] را بفشارٌد و پنجرهhue/saturationرا 

 :   مانند شکل زٌر تنظٌم کنٌد



 

 

  

 را plastic wrapفٌلتر artisticرفته و از مجموعه فٌلتر های filter  سپس به منوی 

 را برابرdetailو مقدار 15را برابر باhighlight strength  انتخاب کنٌد و در اٌن فٌلتر مقدار 

  editقرار دهٌد سپس به منوی 11را برابر با smoothness قرار دهٌد و مقدار 11  با 

 را برابر باopacityرا انتخاب کنٌد و در اٌن گزٌنه مقدار fade plastic wrap  رفته و گزٌنه 

 را انتخاب کنٌدload selectionرفته و گزٌنه  selectقرار دهٌد سپس به منوی 37     

 را انتخاب کنٌد و مجدد به منویcheeseها کانال  channel  و در اٌن گزٌنه در قسمت 

  select رفته و گزٌنهfeather را انتخاب کنٌد و در اٌن گزٌنه مقدارfeather radius را برابر 

 را بفشارٌد تا حالت سلکت معکوس[shift+ctrl+i]قرار دهٌد و کلٌد های مٌانبر 6  با 

 را مانند شکل زٌرlevelsرا بفشارٌد و پنجره [ctrl+l]  شود سپس  کلٌد های مٌانبر  

 :  تنظٌم کنٌد 



 

 

 

 .را بفشارٌد [ctrl+d]  سپس کلٌد های مٌانبر 

 را انتخاب کنٌدadd noiseفٌلتر noiseرفته و از مجموعهر فٌلتر های  filter  به منوی 

 رفته وselectقرار دهٌد سپس به منوی 2.35را برابر با amount  و در اٌن فٌلتر مقدار 

 را انتخابcheeseها کانال channelرا انتخاب کنٌد و در قسمت load selection  گزٌنه 

 را بفشارٌد و کلٌد مٌانبر روی کٌبورد را [shift+ctrl+i]  کنٌد و کلٌد های مٌانبر 

 .   بفشارٌد و از اٌن طرٌق مناطق سلکت شده را پاک کنٌد 

 را load selectionرفته و گزٌنه  selectرا بفشارٌد و به منوی [ctrl+d]  کلٌد های مٌانبر 

 را انتخاب کنٌد و crustها کانال channel  انتخاب کنٌد و در اٌن گزٌنه در قسمت 

 را انتخاب کنٌد و کلٌدcrustرا بفشارٌد سپس لاٌه [shift+ctrl+i]  کلٌد های مٌانبر 

  delete روی کٌبورد را بفشارٌد و کلٌد های مٌانبر[ctrl+d]را بفشارٌد تا مناطق 

 را [ctrl+l]  سلکت شده از حالت سلکت خارج شوند سپس کلٌد های مٌانبر 

 :را مانند شکل زٌر تنظٌم کنٌدlevels  بفشارٌد و پنجره 



 

 

 

 راinner glowقسمت layer styleکلٌک کنٌد و در پنجره crust   سپس دو بار روی لاٌه 

 :  فعال سازٌد و اٌن قسمت را مانند شکل زٌر تنظٌم کنٌد

 



 

 

 

    

 را فعالinner glowقسمت  layer styleدو بار کلٌک کنٌد و در پنجره sauceروی لاٌه 

 :  سازٌد و اٌن قسمت را مانند شکل زٌر تنظٌم کنٌد 

  

 inner glowقسمت  layer styleدو بار کلٌک کنٌد و در پنجره  cheese  سپس روی لاٌه

 :را فعال کنٌد و اٌن قسمت را مانند شکل زٌر تنظٌم کنٌد  



 

 

 

 را فعال سازٌد و اٌن قسمت را مانند شکل زٌر تنظٌم drop shadow  سپس قسمت 

 :  کنٌد

 

 .ادامه آموزش را در قسمت بعدي دنبال كنٌد
  

  

http://www.majidonline.com/page.php?page=content&op=cntshow&code=190


 

 

 

  با سلام در اٌن آموزش شما ٌاد می گٌرٌد که به چه صورت می توان ٌک نوشته پٌتزاٌی در فتوشاپ رسم کنٌد

  .در قسمت چهارم طرٌقه ساختن ادوٌه جات پٌتزا را فرا خواهٌد گرفت. اٌن آموزش در چهار قسمت تنظٌم شده است

فتوشاپ سازگاری دارد اگر شما مبتدی هستٌد و تسلط کافی به فتوشاپ ندارٌد مراحل اٌن آموزش را actionاٌن آموزش کاملا با سٌستم 
قدم به قدم و همانطوری که ذکر شده و با همان متغٌر ها اجرا کنٌد و در صورت برخورد با مشکلی در مورد اٌن آموزش به 

 ... انجمن فتوشاپ مراجعه کنٌد و در صورتی که مشکل شما حل نشد با نوٌسنده اٌن آموزش تماس بگٌرٌد کنٌد 

 

  

 

 

   

 راdrop shadowقسمت layer styleکلٌک کنٌد و در پنجره sauce   دو بار روی لاٌه  

 :  فعال سازٌد و اٌن قسمت را مانند شکل زٌر تنظٌم کنٌد



 

 

 

 را فعال سازٌد و اٌنdrop shadowدو بار کلٌک کنٌد و قسمت crust  سپس روی لاٌه 

 :  قسمت را مانند شکل زٌر تنظٌم کنٌد 

  

 را بفشارٌد و پنجره[ctrl+u]را انتخاب کنٌد و کلٌد های مٌانبر cheese  سپس لاٌه 



 

 

  hue/saturationرا مانند شکل زٌر تنظٌم کنٌد: 

 

 را بفشارٌد و پنجره [ctrl+u]را انتخاب کنٌد و مجدد کلٌد های مٌانبر crust  لاٌه 

  hue/saturationرا مانند شکل زٌر تنظٌم کنٌد: 

 

 رفته و از مجموعهfilterانتخاب شده است به منوی crust  سپس در حالی که لاٌه 

 را انتخاب کنٌد و در اٌن فٌلتر مقدار plastic wrapفٌلتر artistic  فٌلتر های 

  highlight strength ومقدار 15را برابر با detail و مقدار 11را برابر باsmoothness را
 برابر

 .قرار دهٌد و فٌلتر را روی لاٌه اجرا کنٌد 11  با 

 55را برابر با opacityرا برگزٌنٌد و در اٌن گزٌنه مقدار fadeرفته و گزٌنه edit  به منوی 

 را بفشارٌد[ctrl+f]را انتخاب کنٌد و کلٌد های مٌانبر cheese  قرار دهٌد سپس لاٌه 



 

 

 editسپس به منوی.   تا فٌلتر جاری با همان مشخصات روی اٌن لاٌه هم اجرا شود

 را برابر باopacityرا انتخاب کنٌد و در اٌن گزٌنه مقدار fade plastic wrap  رفته و گزٌنه 

 .قرار دهٌد 100     

 

   

 اٌجاد کنٌد و لاٌه جدٌد را انتخاب کنٌد وcheeseدر بالای لاٌه spices  ٌک لاٌه به نام 

 filterرا انتخاب کنٌد سپس به منوی whiteحالت useرفته و در قسمت fill  به منوی 

 را انتخاب کنٌد و در اٌن فٌلتر add noiseفٌلتر noise  رفته و از مجموعه فٌلتر های 

 را gaussianگزٌنه distributionقرار دهٌد و در قسمت 16.47را برابر با amount  مقدار 

 اجراspicesرا تٌک دار کنٌد و فٌلتر را روی لاٌه monochromatic  انتخاب کنٌد و گزٌنه 

 را انتخاب کنٌد blurفٌلتر blurرفته و از مجموعه فٌلتر های filter  کنٌد و به منوی 

 :را مانند شکل زٌر تنظٌم levelsرا بفشارٌد و پنجره [ctrl+l]  سپس کلٌد های مٌانبر 

 

 را مانند شکلhue/saturationرا بفشارٌد و پنجره [ctrl+u]   سپس کلٌد های مٌانبر 

 :  زٌر تنظٌم کنٌد



 

 

 

 را کشٌده و روی دکمه origها رفته و کانال channel  به قسمت 

  create new channel[ ] رها کنٌد  و نام کانالorig copy را بهspicesتغٌٌر نام 

 را انتخاب کنٌد و در اٌن گزٌنه در قسمت fillگزٌنه رفته وedit  دهٌد سپس به منوی 

  use حالتblack را انتخاب کنٌد که با اٌن کار کانالspicesبه رنگ سٌاه در می آٌد 

 را انتخابadd noiseفٌلتر noiseرفته و از مجموعه فٌلترهای filter  سپس به منوی 

 spicesقرار دهٌد و فٌلتر را روی کانال25.1را برابر با amount  کنٌد و در اٌن فٌلتر مقدار 

 را blurفٌلتر blurرفته و از مجموعه فٌلتر های filter  اجرا کنٌد سپس به منوی 

 را مانند شکلlevelsرا بفشارٌد و پنجره [ctrl+l]  انتخاب کنٌد سپس کلٌد های مٌانبر 

 :  زٌر تنظٌم کنٌد 

 



 

 

 را [ctrl+l]را بفشارٌد و مجدد کلٌد های مٌانبر [ctrl+i]  سپس کلٌد های مٌانبر 

 :را مانند شکل زٌر تنظٌم کنٌد levels  بفشارٌد و پنجره 

 

 را انتخاب کنٌد و در اٌن گزٌنه درload selectionرفته و گزٌنه  edit  سپس به منوی 

 spicesرا انتخاب کنٌد سپس در حالی که مناطق کانال spicesکانالchannel  قسمت 

 روی کٌبوردdeleteرا انتخاب کنٌد سپس کلٌد RGB  به حالت سلکت در آمده اند کانال 

 رفته و  selectرا بفشارٌد سپس به منوی [ctrl+d]  را بفشارٌد وکلٌد های مٌانبر 

 cheeseها کانالchannelرا انتخاب کنٌدو در اٌن گزٌنه در قسمت load selection  گزٌنه

 را انتخاب کنٌد و در اٌن گزٌنه featherرفته و گزٌنه selectرا انتخاب کنٌد و به منوی   

 را [shift+ctrl+i]قرار دهٌد و کلٌد های مٌانبر 2را برابر با feather radius  مقدار 

 سپس کلٌد های مٌانبر . روی کٌبورد را بفشارٌد delete  بفشارٌد سپس دکمه 

  [ctrl+d] را بفشارٌد سپس به پنلlayers رفته و لاٌهspicesرا انتخاب کنٌد و در ادامه 

 :را مانند شکل زٌر تنظٌم کنٌدlevelsرا بفشارٌد و پنجره [ctrl+l]  کلٌد های مٌانبر 



 

 

 

 را drop shadowقسمت  layer styleدو بار کلٌک کنٌد و در پنجره spices  روی لاٌه 

 :  انتخاب کنٌد و اٌن قسمت را مانند شکل زٌر تنظٌم کنٌد

 

   



 

 

 

 

   

 را انتخاب fillرفته و گزٌنه  editاٌجاد کنٌد و به منوی sauce top  ٌک لاٌه جدٌد به نام 

 را انتخاب کنٌد که با اٌن عمل لاٌه whiteحالت use  کنٌد و در اٌن گزٌنه در قسمت 

  sauce top به رنگ سفٌد در می آٌد سپس منویfilterرفته و از مجموعه فٌلتر 

  texture فٌلترtexturizerرا بر گزٌنٌد و اٌن فٌلتر را مانند شکل زٌر تنظٌم کنٌد: 

 

 را انتخاب کنٌدblur moreفٌلتر blurرفته و از مجموعه فٌلتر های filter  به منوی 

 را مانند شکل زٌر تنظٌمlevelsرا بفشارٌد و پنجره [ctrl+l]  سپس کلٌد های مٌانبر 

 :  کنٌد



 

 

 

 را بفشارٌد تا فٌلتر جاری مجدد روی لاٌه اجرا[ctrl+f]   سپس کلٌد های مٌانبر 

 را مانند شکل زٌر levelsرا بفشارٌد و پنجره [ctrl+l]مجدد کلٌد های مٌانبر .   شود 

 :  تنظٌم کنٌد

 

   

 را بفشارٌد تا فٌلتر جاری مجدد روی لاٌه اجرا[ctrl+f]سپس کلٌد های مٌانبر 

 را مانند شکل زٌر levelsرا بفشارٌد و پنجره [ctrl+l]مجدد کلٌد های مٌانبر .   شود 

 :  تنظٌم کنٌد



 

 

 

 ٌا همان قلم جادوٌیmagic wand toolرا بفشارٌد تا ابزار [w]  سپس کلٌد مٌانبر 

 کلٌک کنٌد به طوری که sauce top  فعال شود سپس در منطقه ای سفٌد در لاٌه 

 روی کٌبورد راdelete  فقط مناطق سفٌد رنگ به حالت سلکت در آٌند سپس کلٌد 

   بفشارٌد بطوری که مناطق سفٌد رنگ پاک شده و نقطه های سٌاه رنگ به جای

 رفته  و گزٌنه selectرا بفشارٌد و به منوی [ctrl+d]  بمانند سپس کلٌد مٌانبر 

  load slection را انتخاب کنٌد و در اٌن گزٌنه در قسمتchannel ها کانالcheeseرا 

 را بفشارٌد تا مناطق سلکت شده[shift+ctrl+i]  انتخاب کنٌد و کلٌد های مٌانبر 

 . روی کٌبورد را بفشارٌد delete  به حالت معکوس در آٌند سپس کلٌد 

 sauce topکلٌک کنٌد تا روی لاٌه []lock transparent pixels  سپس روی دکمه 

 را انتخاب کنٌد و درfillرفته و گزٌنه edit  ٌک شکل قفل نماٌان شود سپس به منوی 

 را انتخاب کنٌد سپس کلٌد های مٌانبرgray%50حالت use   اٌن گزٌنه در قسمت 

  [ctrl+u] را بفشارٌد و پنجرهhue/saturationرا مانند شکل زٌر تنظٌم کنٌد: 



 

 

 

 قسمت layer styleدو بار کلٌک کنٌد و در پنجره sauce top  سپس روی لاٌه 

  outer glow را فعال سازٌد و اٌن قسمت را مانند شکل زٌر تنظٌم کنٌد: 

 

 را انتخاب کنٌد و در fillو گزٌنه editرا انتخاب کنٌد و به منوی background  سپس لاٌه 

 به backgroundرا انتخاب کنٌدکه با اٌن کار لاٌه whiteحالت use   اٌن گزٌنه در قسمت 

 ...  رنگ سفٌد در می آٌد 

   در اٌنجا طرح ما به پاٌان می رسد 

 ...!!!!!  پٌتزای ما آماده است خسته نباشٌد و نوش جان



 

 

 
  

  

 

 

 

 
 

 

 

    

  سپس340در 340ٌک فاٌل جدٌد اٌجاد کنٌد به اندازه      

  ٌک لاٌه جدٌد اٌجاد کنٌد و لاٌه جدٌد را انتخاب کنٌد سپس

 را برگزٌنٌد که اٌن عمل با []Elliptical Marquee Tool ابزار

  optionهم صورت مٌپذٌرد سپس در نوار [m]زدن کلٌد مٌانبر

  widthانتخاب کنٌد و مقدار  fixed sizeرا styleدر بالا حالت 

  قرار دهٌد200را برابر با heightو مقدار 120را برابر با 

 سپس موس را به وسط صفحه برده و ٌک بار کلٌک کنٌد در 

  نتٌجه ٌک قسمت به شکل بٌضی مانند شکل روبرو به حالت

select در می آٌد سپس بوسٌله ابزارpaint bucket tool و ٌا 

 محدوده انتخاب شده را با رنگ [g]زدن کلٌد مٌانبر 

 پر کنٌد [999999]#



 

 

 

    

 را بر گزٌنٌد و اٌنبار[]Elliptical Marquee Toolمجدد ابزار 

 را برابرheightو مقدار 180را برابر با widthمقدار optionدر نوار 

 قرار دهٌد سپس در وسط طرح ٌک بار کلٌک کنٌد 180با 

 راInvertرفته و گزٌنه selectمانند شکل روبرو سپس به منوی 

 هم [ctrl+shift+i]برگزٌنٌد که اٌن عمل با کلٌد های مٌانبر 

 روی کٌبورد deleteامکان پذٌر هست سپس دکمه 

 بفشارٌد که با اٌن عمل قسمت اضافی پاک می شود 

 :و قالب اصلی موس ما بدست می آٌد مانند شکل روبرو

           

 سپس روی لاٌه خود دو بار کلٌک کنٌد که با اٌن عمل پنجره

layer style فعال می شود که قسمتهای اٌن پنجره را مانند 

 :شکلهای زٌر تنظٌم کنٌد

        inner glow                                                                  drop shadow 



 

 

   

  Gradient Overlay                                                      Bevel and Emboss  

   

 :که در نهاٌت کار شما باٌد مانند شکل زٌر شود



 

 

 

  
 

    

 سپس ٌک لاٌه جدٌد اٌجاد کنٌد و با پاٌٌن نگه داشتن کلٌد

[ctrl] روی لاٌه اولی خود کلٌک کنٌد که با اٌن کار محدوده 

 اصلی موس انتخاب می شود سپس در حالی که لاٌه ای که

 شده راselectدر مرحله جاری ساختٌم انتخاب شده قسمت 

 :پر کنٌد[999999]#با رنگ 



 

 

 

    

 renderرفته و از مجموعه فٌلتر های filterسپس به منوی 

 را برگزٌنٌد و اٌن فٌلتر را مانند شکلLighting Effectsفٌلتر 

 :زٌر تنظٌم کنٌد

 

: تغٌٌر دهٌد50لاٌه خود را به opacityسپس 

 

  



 

 

 

     

 را بر گزٌنٌد و در نوار []Elliptical Marquee Toolابزار 

optionمقدارwidth ومقدار180را برابر باheightقرار 100را برابر با 

 دهٌد سپس در بالای طرح موس خود ٌک بار کلٌک کنٌد 

 مانند شکل روبرو سپس ٌک لاٌه جدٌد اٌجاد کرده و

 پر کنٌد[666666#]شده را با رنگselect محدوده 

  

  

 

    

 تغٌٌر دهٌد0را به fillسپس در بالای پنجره لاٌه ها مقدار 

 

 layer styleسپس روی لاٌه جاری دو بار کلٌک کرده که پنجره 

 :فعال می شود و اٌن پنجره را مانند اشکال زٌر تنظٌم کنٌد

Bevel and Emboss 



 

 

 

Stroke 

 



 

 

 

   

 لاٌه جاری را درگ کرده و به زٌر لاٌه دوم انتقال دهٌد

 :که ترکٌب لاٌه های شما مانند شکل زٌر می شود

 

 را بفشارٌد تا لاٌه سوم ما با [ctrl+g]سپس کلٌدهای مٌانبر 

 :لاٌه اول بصورت ماسک در آٌد 

 

    

 را بر گزٌنٌد و در نوار[]Elliptical Marquee Tool  ابزار 

option مقدارwidth و مقدار 32را برابر باheight72را برابر با 

 قرار دهٌد سپس در محدوده بالای طرح موس ٌک بار کلٌک 

 کنٌد مانند شکل روبرو  سپس ابزار 

rectangular Marquee Tool[ ]را بر گزٌنٌد  در نوار 

option  روی دکمهadd to selection[]کلٌک کنٌد سپس 

 از بالای محدوده بالاٌی طرح موس تا پاٌٌن شکاف حد فاصل

 قسمت پاٌٌنی با قسمت بالاٌٌی موس بکشٌد که قسمت

selectشده در نهاٌت باٌد مانند شکل روبرو شود: 



 

 

 سپس ٌک لاٌه جدٌد اٌجاد کرده و

 پر کنٌد[#999999] محدوده سلکت شده را با رنگ 

 

    

 سپس لاٌه جاری را بکشٌد و به زٌر لاٌه دوم انتقال دهٌد

 

 را بفشارٌد [ctrl+g]سپس کلٌدهای مٌانبر 

 راCopy Layer Styleروی لاٌه سوم راست کلٌک کرده و گزٌنه 

 برگزٌنٌد سپس روی لاٌه چهارم راست کلٌک کرده و گزٌنه 

Paste Layer Styleرا انتخاب کنٌد که با اٌن کار تمام افکتهاٌی 

 که به لاٌه سوم داده بودٌم روی لاٌه چهارم اجرا می شود

 :که در نهاٌت طرح ما مانند شکل روبرو می شود

  



 

 

 

     

 سپس ٌک لاٌه جدٌد اٌجاد کنٌد و با پاٌٌن نگه داشتن کلٌد

ctrl روی لاٌه چهارم ٌک بار کلٌک کنٌد سپس ٌک لاٌه جدٌد 

 پر کنٌد#[ffffff]شده را با رنگ selectاٌجاد کنٌد و محدوده 

 opacityرا بفشارٌد و [ctrl+g]سپس کلٌد های مٌانبر 

 normalتغٌٌر دهٌد و حالت لاٌه را از 50لاٌه جاری را به 

 تغٌٌر دهٌد که ترکٌب لاٌه های شما بهsoft loghtبه 

: شکل زٌر می شود

 

 سپس ٌک لاٌه جدٌد در بالای لاٌه دوم اٌجاد کنٌد

 را بر گزٌنٌد[]Elliptical Marquee Toolو ابزار 

 را برابر heightو مقدار 14را برابر باwidthمقدار optionو در نوار 

 قرار دهٌد سپس در بالای محدوده موس ٌک بار کلٌک40با 

 :کنٌد مانند شکل روبرو

 پر کنٌد#[999999]شده را با رنگ selectو محدوده 

    



 

 

 فعال  layer styleروی لاٌه جاری دو بار کلٌک کنٌد که پنجره 

 می شود و قسمتهای اٌن پنجره را مانند اشکال زٌر تنظٌم کنٌد

 inner glow                                                                    Inner Shadow 

    

gradient dverlay                                                                 Bevel and Emboss   



 

 

   

 



 

 

 

    

 مقدارoptionو در نوار []Elliptical Marquee Toolابزار 

width و مقدار 20را برابر باheigh قرار دهٌد60را برابر با 

 سپس مانند قبل در بالای محدوده موس ٌک بار کلٌک کنٌد 

 :شده مانند شکل روبرو قرار بگٌرد selectطوری که قسمت 

 gradient editرا انتخاب کنٌد و Gradient Toolسپس ابزار 

 :را مانند شکل زٌر تنظٌم کنٌد

 

 سپس ٌک لاٌه جدٌد اٌجاد کنٌد و موس را از پاٌٌن به بالا

 در قسمت انتخاب شده بکشٌد سپس لاٌه جاری را به زٌر

 تغٌٌر دهٌد50اٌن لاٌه را به opacityلاٌه ششم انتقال دهٌد و 

  

  

 

    

 :اٌجاد کنٌدbackgroundسپس ٌک لاٌه جدٌد در بالای لاٌه 



 

 

 

 master diameterرا انتخاب کنٌد سپس brush toolابزار 

 :قرار دهٌد5را برابر با 

 

 سپس مانند سٌم موس بوسٌله اٌن ابزار خطی رسم کنٌد

 layer styleسپس روی لاٌه جاری دو بار کلٌک کنٌد و 

 :را مانند اشکال زٌر تنظٌم کنٌد

drop shadow 



 

 

 

bevel and emboss 

 
 روی اٌنجا کلٌک کنٌدpsdدر اٌنجا طرح ما به پاٌان می رسد برای درٌافت فاٌل

 برای بحث و تبادل نظر و مطرح کردن مشکل خود در مورد اٌن مقاله روی اٌنجا کلٌک کنٌد

 خسته نباشٌد
 

 
 

 



 

 

 

 تمامً حقوق مادي و معنوي اٌن آموزش براي مجٌد آنلاٌن محفوظ است

  

 

 

 آموزش ساخت طرح چوب

 مقدماتی: سطح 

 .سلام

 ...و تبدٌل شد ... شبٌه اٌن آموزش رو ٌه جاٌی دٌدم گفتم شاٌد بشه ٌه جوراٌی تغٌٌرش داد و به چوب تبدٌلش کرد

 :برای ساخت چوب باٌد اٌن کارها رو انجام بدٌد 

 :من در اٌنجا اٌن اندازه ها رو انتخاب کردم. اول ٌه صفحه با اندازه دلخواهتون باز کنٌد  )1

 

 :رو فشار بدٌد تا رنگهاتون به حالت پٌش فرض در بٌاد Dبعد کلٌد  )2

 

 : بعد برٌد به اٌن آدرس  )3



 

 

 

 :حالا اٌن آدرس رو دنبال کنٌد و تنظٌمات رو مطابق شکل تغٌٌر بدٌد . حالا باٌد روی صفحه شما ابر باشه )4

 

 :حالا به اٌن آدرس مراجعه کرده و تنظٌمات رو مطابق شکل تنظٌم کنٌد )5

 

  :)مطابق شکل( قرار بدٌد 35 اون رو برابر Feather اون مقدار Optionحالا ابزاری که در شکل نشان داده شده رو انتخاب کنٌد و در قسمت  )6



 

 

 

 :دقت کنٌد بعد از انتخاب شکل شما کمی تغٌٌر می کند . حالا روی صفحتون قسمتی رو سلکت کنٌد  )7

 

 )توجه کنٌد که محل انتخاب زٌاد کوچک نباشد(

 ) :من برای مثال نمونه ای را در اٌنجا قرار داده ام(حالا به اٌن آدرس مراجعه کنٌد و مقادٌری را به دلخواه خودتان تنظٌم کنٌد  )8

 

 . رو چند بار دٌگه با اندازه ها و مقادٌر مختلف تکرار کنٌد اما زٌاده روی نکنٌد8 و 7شما می تونٌد مراحل  )9

 :تنظٌمات را مانند شکل انجام دهٌد.  ظاهر شودHue/Saturation رو فشار بدٌد تا پنجره Ctrl+Uحالا توبت رونگ آمٌزی است کلٌدهای  )10



 

 

 

 ... کلٌک کنٌدOKروی  )11

 شما چوب درست کردٌد... تبرٌک مٌگم 

 

 

 



 

 

 در boxآموزش اٌجاد :: 
 طراحی وب

  

 

 وب ساٌت Templateبرای طراحی  BOXنحوه ی اٌجاد : قسمت اول 

 

 هرگونه کپی برداری از مطالب مندرج در اٌن مقاله با ذکر منبع بلامانع است: توجه

www.majidonline.com ©

[ New<-Ctrl+N]اٌجاد می کنٌم  )فرضی( 300×300ابتدا ٌک فاٌل جدٌد 

 

 .سپس ٌک لاٌه ی جدٌد اٌجاد می کنٌم



 

 

 

 .و رنگ رو را سفٌد مطلق انتخاب می کنٌم

 

 ٌک مستطٌل فرضی اٌجاد می کنٌم Marquee Tool [M]سپس بوسٌله ی ابزار 

 



 

 

 

 ) مطمئن باشٌدlayer1قبل از اٌن کار از انتخاب (. می کنٌم okرا انتخاب کرده و  fillو سپس  edit گزٌنه ی )menu bar(حال از نوار منو 

 

 .را انتخاب مٌکنٌم Duplicate layerکلٌک راست کرده و  layer1حال روی 



 

 

 

 .را تاٌپ کنٌد layer2در پنجره ی مربوطه برای نام لاٌه عبارت 

 .ظاهر شود layer Styleدوبار کلٌک کرده تا پنجره ی  layer1در پالت لاٌه ها روی 

 .  و با کلٌک روی آن تنظٌمات آن را به صورت زٌر قرار می دهٌمdrop shadowاز گزٌنه های سمت چپ تصوٌر 

 

 .قرار می دهٌم 1pxرا انتخاب کرده رنگ آن را مشکی و ساٌز را  strokeسپس 

را بزنٌد  Delبعد از انتخاب کلٌد (. کلٌک کرده و مطابق شکل بخشی از آن را انتخاب کرده و حذف می کنٌم layer2حال در پالت لاٌه ها روی 
 )تا منطقه ی مورد نظر حذف شود



 

 

 

مطابق شکل  bevel and embossباز شود و تنظٌمات زٌر را مربوط به  layer Styleدو بار کلٌک کرده تا پنجره ی  layer2سپس روی 
 .  اجرا می کنٌمlayer1 را مطابق strokeو سپس . انجام می دهٌم

 

 :و لاٌه ها به ترتٌب زٌر است  زٌر باٌد درست شده باشدboxاکنون 



 

 

 

  :D درجه قرار می دهٌم 80 دقٌقه در فری با دمای 25آٌکون از قبل آماده شده ی خود را به آن اضافه کرده و به مدت 

 :ساٌت آماده است Templateما برای استفاده در طراحی  boxاکنون قالب 

 

 . ها و آماره کردن فاٌل برای استفاده در وب شرح داده مٌشودsliceدر بخش آٌنده آموزش نحوه ی اٌجاد 

;- @{  موفق باشٌد-;}@

 علٌرضا مقاری
 

 

 



 

 

1 

   

 و با ٌک فونت درشت و ساٌز بزرگ متن ( Text tool ) متن  اٌجاد کنٌد با پس زمٌنه سفٌد ، بعد با ابزار400*400شروع ٌک فاٌل در اندازه های  برای
کنٌد منتها  در انتخاب فونت شما مختارٌد که هر فونتی را که دوست دارٌد انتخاب (. استفاده کردم 180با ساٌز  Impact من از فونت. خودتان را تاٌپ کنٌد

 .کنٌد Rasterize کردن متن مورد نظرتان لاٌه را÷ بعد از تای .( بهتر هستش که از ٌک فونت درشت استفاده کنٌد تا نتٌجه بهتری بگٌرٌد

  

   

2 

   

اسم لاٌه  )بشٌد که لاٌه جدٌد درست بالای لاٌه متن قرار داره مطمٌن(که لاٌه متن شما فعال باشد ، بعد ٌک لاٌه جدٌد بالای لاٌه متن اٌجاد کنٌد  دقت کنٌد
و بر روی لاٌه متن کلٌک کنٌد تا انتخاب  را پاٌٌن نگه داشته Ctrl فعال است دکمه Shadow در حالی که لاٌه جدٌد ٌا.بگذارٌد Shadow جدٌد را ساٌه ٌا

 پٌکسل 5اٌنکار باعث مٌشود تا از محدوده انتخاب . پٌکسل را انتخاب کنٌد 5بروٌد و برای آن مقدار  Select>Modify>Contract بعد به مسٌر. شود
 .شود کم

. 

   

3 

   

 بعد با ابزار سطل رنگ انتخاب شود ، Foreground رنگ سفٌد به عنوان رنگ پٌش صحن ٌا را فشار دهٌد تا X و D ترتٌب دکمه های حالا به
( Paint Bucket ) بعد. محدوده انتخاب را با رنگ سفٌد پر کنٌد Ctrl+D تصوٌر شما هم باٌد مانند تصوٌر (. بزنٌد تا لاٌه از حالت انتخاب خارج شود را

 (باشد بالا

   



 

 

4 
   

 را 5.5مقدار  رفته و Filter>Blur>Gaussian Blur به مسٌر )فعال ! نه انتخاب! دقت کنٌد(فعال است  Shadow داشته باشٌد که هنوز لاٌه دقت
 ساٌز متن شما بستگس دارد و اٌن خود شما هستٌد که مٌتوانٌد بهترٌن مٌزان را برای برای شعاع  وارد کنٌد، توجه داشته باشٌد که اٌن مقدار به اندازه و

 .شعاع انتخاب کنٌد

  

 

 

   



 

 

5 

  

تنظٌمات را مانند  بروٌد و Layer Style مورد نظر در پالت لاٌه ها به پانل هنوز فعال باشد بعد با دابل کلٌک بر روی لاٌه Shadow که لاٌه دقت کنٌد
 (بدٌد تمامی تغٌٌرات را مانند شکل زٌر انجام(. از شکل زٌر استفاده کنٌد Gloss Counter شکل زٌر انجام دهٌد ، برای قسمت

Cave Deep 

 

  

 
  

   

6     

 Shadow , Text ) کنٌم Merge حالا ما باٌد دو لاٌه را با هم ادغام ٌا .تصوٌر شما باٌد شبٌه تصوٌر بالا باشد Layer Style تنظٌمات بعد از
Layer ) .(داشته باشٌد که بعد از ادغام اسن لاٌه شما باٌد برای اٌنکه توضٌحات طولانی نشه دقت Text مثلا در مورد من پس از ادغام اسم لاٌه  ! باشه

 (.بود Sayan من

 ! توضٌح بٌشتری نمٌدم پس من! خٌلی مهم است ولی در عٌن حال ساده  اٌن قسمت



 

 

 
 

  

   

7 

   

پاٌٌن نگه داشته و بر روی لاٌه  را Ctrl بگذارٌد، در حالٌکه اٌن لاٌه فعال است دکمه Color لاٌه جدٌد بالای تمامی لاٌه ها اٌجاد کنٌد و نام آن را حالا ٌک
 تغٌٌر دهٌد Overlay بعد از آن حالت لاٌه را به. نارنجی محل انتخاب شده را پر کنٌد متن کلٌک کنٌد تا انتخاب شود ، بعد با ٌک رنگ زرد ٌا

(Blending=Overlay) 

 .اٌنکه متوجه شوٌد جای لاٌه ها درست است به تصوٌر زٌر نگاه کنٌد برای
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 . Text Copy : لاٌه اٌجاد شده به اٌن نام اٌجاد مٌشود. بکشٌد متن خود ٌک کپی بگٌرٌد ، برای اٌنکار لاٌه متن را بر روی آٌکون  اٌجاد لاٌه جدٌد از لاٌه
 (کنٌد به تصوٌر بالا نگاه(قرار بگٌرٌد  Text و لاٌه Color اٌن لاٌه باٌد بٌن لاٌه

   

 9 

   

دهٌد آن را بر روی لاٌه  بروٌد و بدون اٌنکه مقادٌر را تغٌٌر Filter>Sketch>Bass Relief : شما فعال است به مسٌر Text Copy که لاٌه در حالی
 .باشد تصوٌر شما باٌد مانند تصوٌر بالا. اعمال کنٌد

   

10  

تنها کار باقی مانده . برسد% 80به  کاهش دهٌد تا% 20آن را  Opacity نغٌٌر دهٌد و مٌزان Overlay زا به Text Copy حالت بلندٌنگ لاٌه حالا
 .است تنظٌمات رنگ و ٌک کم خرده کاری
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بروٌد و تنظٌماتی را که در  Filter>Noise>Add Noise اٌن خرده کاری ها اضافه کردن مقداری پارازٌت به لاٌه است ، برای اٌنکار به مسٌر ٌکی از
 .کنٌد بالا مٌبٌنٌد اعمال عکس
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لاٌه پس زمٌنه را انتخاب کنٌد و در حالی که اٌن لاٌه فعال است بر روی  برای اٌنکار (Border) از جزٌٌات اضافه کردن حاشٌه به لاٌه است ٌکی دٌگر
قرار  به شکل مرحله بعد نگاه کنٌد تا متوجه شوٌد که اٌن لاٌه کجا باٌد(بگذارٌد  Border جدٌد کلٌک کنٌد تا ٌک لاٌه اٌجاد شود، نام اٌن لاٌه را آٌکون لاٌه

 را نگه داشته و بر روی لاٌه متن کلٌک کنٌد تا انتخاب شود، بعد به مسٌر Ctrl بعد در حالی که اٌن لاٌه هنوز فعال است دکمه )بگٌرد
Select>Modify>Expand  حالا با فشردن.بعد محل انتخاب حاشٌه را با رنگ سٌاه پر کنٌد.کنٌد  را برای آن وارد1رفته و مقدار Ctrl+D  لاٌه را از

 .کنٌد حالت انتخاب خارج کنٌد ٌا به اصطلاح ساکت

   

 13 

   

  

   

14 
   

رنگ سبز را بر روی لاٌه اعمال  بروٌد و Hue/Saturation به پانل Ctrl+U بروٌد و با فشردن Color تمام شد برای تغٌٌر رنگ افکت به لاٌه کار ما
 ! کنٌد تا مانند شکل بالا شود

 برای شالوده Craquele و Bass Relief مثل برای بهتر شدن اٌن افکت شما مٌتوانٌد هنگام وارد کردن پارازٌت از تکنٌک های دٌگری : نکته
(Texture) استفاده کنٌد. 



 

 

  

 .کنٌد طرح بهتر درک که در پاٌٌن مٌبٌنٌد فقط با رنگهای متفاوت اٌجاد شده تا شما اهمٌت رنگ را در اٌن طرحهاٌی

 

 

  

 

  

 

 



 

 

، افكتً كه بسٌاري از شركت هاي خودرو سازي از اون  توسط فوتوشاپ كه در اون با استفاده از چند تا فٌلتر مً تونٌن افكت زٌباًٌ خلق كنٌن اٌنم ٌه آموزش كاملا ساده
 استفاده مً كنن در طراحً هاي تبلٌغاتً خود

  پس اگه موافقٌن شروع كنٌم

  

 
و اون  ) استفاده كردم Magnetic Lasso Toolمن از  (   تصوٌر مورد نظر خودتون رو باز كنٌن و محٌط اتومبٌل رو با هر وسٌله اي كه راحت ترٌن انتخاب كنٌن 

  ) .Ctrl + Shift + I (كنٌد  Inverseرو 
  

 

 
 

 

   رو انتخاب كنٌن و تنظٌمات اونو مثل شكل انجام بدٌن Motion Blurگزٌنه  Blurرفته و از زبانه  Filter به منوي

 

 
 



 

 

 
و تنظٌمات اونو مثل  رو انتخاب كنٌن Radial Blurگزٌنه  Blurاز زبانه  Filter و در منوي )با هم انتخاب نكنٌن  (حالا رٌنگهاي اتومبٌل رو تك به تك انتخاب كنٌن 

 شكل انجام بدٌن
  

 

 
 

 

 امٌدوارم كه تونسته باشٌن از اون استفاده كنٌن . خوب اٌن آموزش تموم شد

 عزٌز مخلص همه مجٌدآنلاٌنً هاي

 مصطفً

 

 

 خدا به نام



 

 

 MP3 Playerطرٌقه ساخت ٌك 

 . ها آموزش بدم Layer Style رو با استفاده از ابزارهاي ابتداًٌ فوتوشاپ و Mp3 Playerدر اٌن آموزش قصد دارم طرٌقه ساخت ٌك 
 .من اٌن آموزش رو از ٌه ساٌت خارجً برداشتم و ترجمه كرد 

  
 .خوب شروع مٌكنٌم 

  
 .شما مٌتونٌن از مقادٌر پٌش فرض در اٌن آموزش استفاده كنٌن تا بهترٌن نتٌجه رو از كارتون بگٌرٌن 

  
1 

 . پٌكسل اٌجاد كنٌد 200 در 500در ابتداي كار ٌك سند جدٌد در اندازه حداقل 
 Foreground Color رو به E5E5E5 #  تغٌٌر بدٌن. 

 . پٌكسل قرار بدٌن 70 رو برابر Radius اون مقدار Option رو انتخاب كنٌن و در قسمت تنظٌمات Rounded Rectangle Toolبعد از اون ابزار 
  

 
  

 .با اٌن ابزار شكل زٌر رو رسم كنٌن 
  

 
  
2 

 .   رو انتخاب كنٌن ، روي خطوط دور شكلتون كلٌك كنٌن و مطابق شكل عمل كنٌن Direct Selection Toolحالا ابزار 
  

 
  



 

 

 
  

 
  

 . نقطه بالاًٌ قرار بدٌن 2 نقطه كنترل دٌگه اٌجاد كنٌن و اونا رو هم سطح 2حالا مطابق شكل در محلً كه نشون داده شده 
  

 
  

 
  

 .حالا بٌرون شكل كلٌك كنٌد تا از حالت انتخاب خارج بشٌن 
  
3 

 . اعمال كنٌن Layer Styleحالا استاٌل هاي زٌر رو با دوبار كلٌك كردن بر روي لاٌه شكل و باز شدن پنجره 
  



 

 

 
  

 
  



 

 

 
  

 
  



 

 

 
  

 
  

 .تا اٌنجا طرحتون باٌد مثل شكل زٌر شده باشه 
  



 

 

 
  
4 

 . اون رو مثل تصاوٌر تنظٌم كنٌن Layer Style دٌگه با رنگ سفٌد بكشٌن و Shapeحالا طبق شكل ٌه 
  

 
  

 
  



 

 

 
  
5 

  .)  درگ كنٌن Create a new layerلاٌه رو روي گزٌنه  (از همٌن لاٌه جدٌدتون كه سفٌد رنگه ٌه كپً بگٌرٌن 
 . رو انتخاب كنٌن تا استاٌل اٌن لاٌه حذف بشه Clear Layer Styleحالا روي اٌن لاٌه كپً شده راست كلٌك كنٌد و گزٌنه 

 .حالا اٌن لاٌه رو با رنگ سٌاه پر كنٌن 
 :ترتٌب لاٌه ها تا اٌنجاي كار باٌد به شرح زٌر باشه 

  

 
  

 . رو بزنٌن Ctrl+Tبراي اٌن كار در حالً كه لاٌه سٌاه رو انتخاب كردٌن كلٌدهاي . حالا باٌد اٌن لاٌه سٌاه رنگ رو كمً كوچكتر كنٌن 
 .و از هر طرف به ٌك مقدار لاٌه سٌاه رو كوچك كنٌن تا مثل شكل بشه  )براي كوچك كردن نسبت به مركز  ( رو نگه دارٌن Alt باٌد كلٌد Transformدر حالت 

  

 
  

 .حالا باٌد استاٌل هاي زٌر رو به اٌن لاٌه سٌاه بدٌن 
  



 

 

 
  

 
  



 

 

 
  

 
  
6 

 مثل شكل بكشٌن و استاٌل Shape ٌه Radius 3 Pixel و Rounded Rectangle Toolتغٌٌر بدٌن و به وسٌله ابزار  # 86B7E7 رو به foreground colorحالا 
 .هاي زٌر رو بهش بدٌن 

  

 
  



 

 

 
  

 
  



 

 

 
  

 
  



 

 

 
  

 . حذف كنٌن Clear Layer Style ٌه كپً بگٌرٌن و استاٌلش رو با راست كلٌك كردن روي اون و انتخاب گزٌنه LCDحالا از لاٌه 
 .حالا اٌن لاٌه كپً شده رو با رنگ سفٌد پر كنٌن 

 لاٌه رو Fill اونو مثل شكل كوچٌك كٌن و Alt رو بزنٌن و با نگه داشتن كلٌد Ctrl+Tبراي اٌن كار مطابق دستورات قبلً . حالا بازم باٌد اٌن لاٌه سفٌد جدٌد رو كوچك كنٌن 
 .به صفر برسونٌن 

  

 
  

 
  

 . رو براي اٌجاد رنگهاي پٌش فرض فشار بدٌن و استاٌل زٌر رو روي اٌن لاٌه اجرا كنٌن X و سپس Dحالا كلٌد 
  



 

 

 
  

 
  

 . رو انتخاب كنٌد و حالت انتخابً زٌر رو رسم كنٌن Pen Toolحالا ابزار 
  

 
  



 

 

 
  

 . به ٌه لاٌه معمولً تبدٌل كنٌن Rasterize Layer برسونٌن و با راست كلٌك كردن روي لاٌه و انتخاب گزٌنه 20 اٌن لاٌه رو به Fillحالا 
 درست كردٌن رو در انتخاب دارٌن Pen Tool و كلٌك روي لاٌه انتخاب كنٌن و همٌن طور كه لاٌه اي كه با Ctrlحالا منطقه لاٌه سفٌد زٌر اٌن لاٌه رو با نگه داشتن كلٌد 

  .)مثل شكل  ( رو بزنٌن تا اون قسمت پاك بشه Deleteحالا كلٌد .  رو بزنٌن تا منطقه خارج از منطقه آبً انتخاب بشه Ctrl+Shift+Iكلٌدهاي 
 . رو براي خروج از حالت انتخاب فشار بدٌن Ctrl+Dكلٌدهاي 

  

 
  

 . حالا باٌد با توجه به خلاقٌتتون قسمتهاًٌ رو به اون اضافه كنٌن .  طراحً شد MP3 Playerقالب كلً اٌن . خوب 
 . من ٌه مقدار قٌافشو صفا دادم تا ٌكم جلوه پٌدا كنه 

 >>>>درٌافت فونت <<<< . براي استفاده از فونت اٌن طرح لٌنك اون رو براتون قرار دادم تا اون رو دانلود كنٌن 
  

 
  

 .حالا فقط دكمه ها مونده كه طرٌقه ساخت اونا رو هم براتون توضٌح مٌدم 
  
7 

حالا تنظٌمات . ، ٌه لاٌه جدٌد اٌجاد كنٌن ، ٌه داٌره متناسب با لبه هاي طرح كلً رسم كنٌن و اونو با رنگ سفٌد پر كنٌن  ) D (رنگهاتون رو به حالت پٌش فرض برگردونٌن 
Layer Style اونو مثل شكل انجام بدٌن . 

  



 

 

 
  

 
  

 .حالا ٌه كپً از اٌن لاٌه بگٌرٌن ، استاٌلش رو حذف كنٌن و اونو با رنگ سٌاه پر كنٌن و ٌه مقدار اونو كوچٌك كنٌن 
  

 
  

 .حالا دوباره از لاٌه زٌرٌن ٌه كپً بگٌرٌن ، استاٌل اونو مطابق شكل درست كنٌن و اونو از لاٌه سٌاه كمً كوچكتر كنٌن 
 .ترتٌب اٌن سه لاٌه توي شكل اومده 

  



 

 

 
  

 
  

 
  

 Ellipticalٌه لاٌه جدٌد اٌجاد كنٌن و ٌه منطقه داٌره اي كوچٌك وسط قسمت تكمه ها با ابزار . حالا در صورت نٌاز دوباره رنگهاتون رو به حالت پٌش فرض در بٌارٌن 
Marquee Tool رسم كنٌن    . 

 .به اٌن منطقه طبق شكل ٌه گرادٌنت با ابزار گرادٌنت بدٌن 
  



 

 

 خدا به نام

 توپ آتشٌن آموزش ساخت

 .را فرا خواهٌد گرفت )كه نمونه آن در پاٌٌن اٌن صفحه است(در اٌن آموزش شما طرٌقه ساخت ٌك توپ آتشٌن 

 
  

 
  

 : رو قرار بدٌن 3 اون مقدار Radiusحالا مسٌر زٌر رو دنبال كنٌن و براي 
Filter > Blur > Gaussian Blur 

  

 
  

 . حالا به هر كدام از دكمه ها با رنگهاي خاكستري پررنگ و خاكستري كمرنگ گرادٌنت بدٌن تا ٌكم جلوه پٌدا كنن 
  

 
  

 آموزش مورد پسند شما قرار گرفته باشه امٌدوارم اٌن
  
  

 مخلصٌم
 مصطفً



 

 

  

 :رستارت كنٌن و فٌلتر زٌر رو طبق شكل روش اعمال كنٌن  D اٌجاد كنٌن و رنگاتون رو با فشار دادن كلٌد 400 در 400ٌك صفحه جدٌد در اندازه 

Filter<Render<Lens Flare 

 

 :حالا كه اٌنطوري شد پس فٌلتر زٌر رو هم روي اون اجرا كنٌد و تنظٌماتش رو انجام بدٌن 

Filter<Artistic<Plastic Wrap 



 

 

 

 :پس از مرحله بالا فٌلتري كه در زٌر معرفً شده است را بر روي طرح خود اعمال كنٌد 

Filter<Distort<Ripple 

 

 :روش اعمال كنٌن + 999حالا فٌلتر زٌر رو هم با ساٌز 

Filter<Distort<Twirl 

 :رو بزنٌن و تنظٌمات اون رو مثل شكل انجام بدٌن  Ctrl+Uحالا كلٌدهاي 



 

 

 

 .قرار بدٌن  Multiplyاون رو برابر  Modeحالا از لاٌه ٌه كپً بگٌرٌن و 

 

 .كنٌن  Mergeبا هم  Ctrl+Eحالا دو تا لاٌه رو با فشار دادن كلٌدهاي 

 :حالا باٌد تونسته باشٌن طرح زٌر رو دربٌارٌن 



 

 

 

 مخلص همه مجٌدآنلاٌنً هاي عزٌز

 مصطفً

 

 

 خدا به نام

 

 نوشت خونٌن آموزش اٌجاد

 

 .در اٌن آموزش من می خوام آموزش رو بسٌار ساده بگم تا همۀ عزٌزان متوجه بشند 

 

  1   
 

و متن خودتون رو با ٌه فونت توپر تاٌپ كنٌن من  ) استفاده کردم180 * 600من از اندازۀ (در اندازه دلخواه اٌجاد كنٌد )Ctrl + N(ابتدا ٌك سند جدٌد . شروع می کنٌم 
 .روشن باشه بهتر )Caps Lock(در ضمن اگه دکمه ) بهتر است رنگ نوشته شما مشکی باشد(استفاده کردم)Aharoni (از فونت 

 

 

2  

 پٌکسل قرار 5 را روی Radius رو انتخاب کنٌد و Gaussian Blur  و گزٌنۀ Blur رفته وارد Filterبه منوی  )باٌد لاٌه نوشتۀ شما در حالت انتخاب باشد(حالا 
 . کنٌد OKدهٌد  سپس 

 



 

 

 

 

3  

 اٌن کار را حتما دو بار انجام دهٌد .  را انتخاب کنٌد Find Edges گزٌنه Stylize  وارد Filterسپس ازمنوی  . خوب نوشته شما تا اٌن جا باٌد مثل نوشته بالا باشد 

 
  

  

 

 

 

  

 

  

  .خوب حالا از مسٌر زٌر مقادٌر مشخص شده را قرار دهٌد 

  



 

 

 
  

 

 

4  

  رو کلٌک می کنٌم  حالا نوشته شما Duplicate layerبرای اٌن کار روی لاٌه نوشته کلٌک راست می کنٌم و. خوب حالا باٌد ٌه کپی از لاٌه اٌجاد شده داشته باشٌم 
 را CC درجه 90 شده و Rotate Canvas وارد Imageاز منوی . شما دو لاٌه مشابه هم دارٌد که حتماً لاٌه زٌری را در حالت انتخاب باشد . کمی پر رنگ تر شد 

 .انتخاب کنٌد تا نوشته شما نود درجه چرخش بکنه 

 

 wind در حالت Method  را انتخاب کنٌد  توجه داشته باشٌد که  Wind  شده و Stylize  وارد  Filterوقتی نوشته شما نود درجه چرخٌد از منوی 
 . بار انجام دهٌد  5 تا 4 باشد شما می توانٌد اٌن کار را From the Right  در حالت Directionو  

.  را انتخاب کنٌد CCW درجه 90 بروٌد و گزٌنه Rotate Canvas و بعد Imageحالا مجددا به منوی 

. حالا کار شما مثل شکل زٌر باٌد شده باشد . خوب خسته نباشٌد 

  

 



 

 

 

  

  

  

 )محسن جانجانی (نوشته شده توسط داٌی محسن 

 MohsenElectronic@yahoo.comاگه مشکلی به وجود اومد حتماً به من بگٌد شاٌد تونستم کمک کنم 

 مخلص همه مجٌد آنلاٌنی های گل

 

 

 

 . با بکگراند سفٌد باز مً کنٌم500 در 500ٌک صفحه 

اول از همه ٌک لاٌه جدٌد اٌجاد کنٌد و با کمک ابزار رسم داٌره ٌک داٌره بدون اشکال و خوب رسم مً کنٌم سپس 
آدرس زٌر را طً مً کنٌم  

layer ->layer style -> stroke 

  تنظٌم مً کنٌم و با رنگ زٌر آنرا پر مٌکنٌم که البته زرد تٌره مً باشد2 را Strokeو مقدار 

B59605 

خب حالا تصوٌر زٌر باٌد حاصل شده باشد  
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براي تنظمٌات (حالا کافً است داخل شکل خود ٌک گرادٌنت اضافه کنٌم براي اٌن کار تنظٌمات زٌر را نٌاز دارٌم 
 Gradientگرادٌنت بر روي لاٌه اي که اٌجاد کردٌد دوبار کلٌک کنٌد و در پنجره اي که باز مٌشود گزٌنه 

Overlayرا انتخاب کنٌد ( 

 

 

 براي اٌنکه کارتان دقٌق تر شود من کد هاي رنگها را به ترتٌب از کمرنگ به پرنگ قرار مً دهم

D8d635 
FFE617 
D6AD00  

اکنون تصوٌر زٌر باٌد حاصل شده باشه 

 



 

 

 را سفٌد انتخاب مً کنٌم و در داخل شکل ٌک سلکشن به Foregroundدر اٌن مرحله ٌک لاٌه مً سازٌم و 
اگر تصوٌر را نگاه کنٌد کاملا  ) پٌکسل کوچکتر از داٌره اصل3ًحدود (صورت ٌک داٌره کوچک انتخاب مً کنٌم 

 .متوجه خواهٌد شد

 

 

 و البته براش نرم ٌا همان سافت براش ، داخل محٌطً که انتخاب کردٌم را رنگ آمٌزي مً 35با براشً به ساٌز 
 درصد باٌد باشه تا کار دٌد خوبً داشته باشه 60کنٌم البته اوپتٌکالً لاٌه 

 



 

 

 درصد به خودتان بستگً دارد من تنها تصاوٌري را قرار مً دهم که کار 90رسم چشم و اجزاي صورت در حدود 
 را براي رسم چشم واضح کند

 

 

 

 



 

 

 

اگر کمً تازه کار باشٌد در رسم اجزاي صورت مشکل خواهٌد داشت ولً نا امٌد نشوٌد و خٌلً سعً کنٌد تا صورت 
دلخواه شما آماده شود 

شما مً توانٌد براي زٌبا شدن کار داخل چشمان را کمً خاکستري کنٌد تا از سفٌدي خارج شود تنها پٌشنهاد من هم اٌن 
است که از رسم مجدد چشم خودداري کنٌد و از خاصٌت ترانسفرم بهره ببرٌد 

 .در آخر هم اٌن را بگم که ساٌه داشتن اٌن کار خٌلً مهم است و زٌبا تر و کار را سه بعدي جلوه مً دهد

 موفق باشٌد

 

 

 

 به نام خدا

  

    مشخصات آموزش

 :نـــــــــام آموزش    نحوه ساخت ماهٌتابه

 :منبـــــــع آموزش    انجمن هاي تخصصً مجٌدآنلاٌن

  Mah_love  نوٌسنده آموزش: 

  mostafa_az  وٌــراٌش آموزش: 
  

   

 

 ٌك داٌره به اندازه دلخواه ellipse tool ٌك لاٌه جدٌد باز كنٌد و در اون به وسٌله ابزار و  ) رو انتخاب كردم 768 در 1024من  (ٌك صفحه به اندازه دلخواه باز كنٌد 

 . و اون رو با رنگ سٌاه پر كنٌد ) سانتٌمتر رو انتخاب كردم 10 در 10من  (ترسٌم كنٌد 

  

 1   عكس شماره 



 

 

 
 

 

  

 قرار مً 20 را contract by رفته و مقدار select / modify / contract بعد به  . شودselect را پاٌٌن نگاه داشته بر روي لاٌه داٌره كلٌك كنٌد تا داٌره ctrlكلٌد 

 . ما بر عكس شود select را مً زنٌم تا محٌط inverse رفته و select به  . )دتابه ماست پس به اندازه داٌره ما بستگً دارهًاٌن كار براي اندازه لبه ما (. دهٌم 

  

 2   عكس شماره 

 
 

 

  

 . باز شود و گزٌنه ها را مانند شكل تنظٌم مً كنٌم layer styleبعد بر روي لاٌه داٌره دابل كلٌك مً كنٌم تا پنجره 

  

 3   عكس شماره 



 

 

 
 

 

  

 4   عكس شماره 

 
 

 

  

 5   عكس شماره 



 

 

 
 

 

  

 6   عكس شماره 

 
 

 

  

 7   عكس شماره 



 

 

 
 

 

  

 را مً زنٌم و storke رفته و editبه .   مً كنٌم paste شده كپً مً گٌرٌم و در لاٌه ي جدٌدي select را مً زنٌم از محٌط inverse رفته و selectخوب دوباره به 

 :مانند شكل زٌر تنظٌم مً كنٌم آن 

  

 8   عكس شماره 

 
 

 

  

 .شما مً تونٌد براي زٌباًٌ بٌشتر ٌك داٌره قرمز كوچك در وسط صفحه به عنوان ترموستات بگذارٌد . تابه تمام شد هًخوب صفحه داٌره شكل ما

  

: تابه مٌرسه هًنوبت به دسته ماحالا 

  .)  رو پٌشنهاد مٌكنم1.5 در 9من اندازه  (تابه درست كنٌد هً ٌك مستطٌل متناسب با صفحه ماRounded Rectangle toolبعد به وسٌله ابزار . ٌك لاٌه جدٌد باز كنٌد 

 در ٌك لاٌه جدٌد با رنگ سفٌد درست Rounded rectangle toolبراي اٌجاد سوراخ موجود در دسته ماٌتابه مً تونٌد ٌك مستطٌل كوچك دٌگر باز هم به وسٌله ابزار 

 . كنٌد mergeكنٌد و با آن 



 

 

  

 9   عكس شماره 

 
 

 

  

بعد بر روي .  را انتخاب مً كنٌم layer / layer style / copy layer style آن را تغٌٌر دادٌم انتخاب كنٌم بعد layer styleحالا باٌد لاٌه داٌره بزرگ رو كه پنجره 

 . انتخاب مً كنٌد selectحالا قسمتً رو كه مٌخواهٌد ارتفاع پٌدا كند رو با ابزار  . را انتخاب مً كنٌم paste layer styleلاٌه كلٌك راست مً كنٌم و گزٌنه 

  

 10   عكس شماره 

 
 

 

  

خوب تقرٌبا  . قرار مً دهٌم -50 را برابر Amount رفته و مقدار Filter / distort / Pinchبراي اٌن كار به . حالا نوبت اون رسٌده كه ارتفاع دسته رو به شكل القا كنٌم 

فقط مً تونٌد براي زٌباًٌ بٌشتر كار ٌك مستطٌل كوچك درست كنٌد و اون رو در محل اتصال دسته به صفحه قرار دهٌد و اگر دوست دارٌد از آموزش . كار ما تمام شد 

 لاٌه هاي يدر بالا در پاٌان فقط باٌد بگم كه دقت كنٌد لاٌه دسته در پاٌٌن ترٌن لاٌه قرار بگٌرد بعد لاٌه فلز و .نوشته فلزي استفاده كنٌد و اون رو به شكل فلز دربٌارٌد 

 .صفحه 

  

 11   عكس شماره 

 
 

 

  

 12   عكس شماره 



 

 

 
 

 

  

 

 

CD Player 

 .در اٌن آموزش با انجام چند مرحله بسٌار ساده مٌتوانٌد ٌك سی دی من جالب را طراحی كنٌد 
 . سطح اٌن آموزش متوسط است ، كاربران فتوشاپ کار عزٌز مٌتوانند به راحتً طراحی كنند 

 . به بالا قابل اجراست 5اٌن آموزش ار فتوشاپ 
 .هدف ار اٌن آموزش کار کردن با ابزار های فتوشاپ هست 

 .تمام مقادٌري كه در اٌنجا ذكر شده اند همه پٌشنهادي مٌباشند و شما مٌتوانٌد آنها را با توجه به نٌاز خود تغٌٌر دهٌد
  

  
 .طرح شما پس از پاٌان شبٌه طرح زٌر خواهد شد

  



 

 

 

  
  

  

  
 

 سلام به همه دوستان مجٌدآنلاٌنً

 بعد از لاٌر داٌره ٌک کپی مٌگٌرٌم مٌکشٌم  )زٌاد نمی خواد دقت کنٌد( سانتٌمتر 7-6 ٌک داٌره به اندازه حدودا ،  بک گراند سفٌد درست مٌکنٌم 500*600ٌک صفحه جدٌد به اندازه 
.   پر مٌکنٌم Bو بعد بٌن اٌن فضای خالی بٌن دوتا داٌره را با ٌک مستطٌل مطابق شکل  )Aمثل شکل (و بعد اٌن دوتا داٌره را زٌر هم با ٌکم فاصله مٌذارٌم 

  



 

 

 

  
  

  
 

  

 Edit<Free کردٌن به Merge مٌکنٌم ، بعد از اٌنکه هر سه لاٌر را Mergeمٌکنٌم و سپس اٌن سه لاٌر را را با هم لٌنک  )دوتا داٌره و ٌک مستطٌل(حالا اٌن سه لاٌر 
Trasnform ٌا با فشردن )Ctrl+T(  دور لاٌر مورد نظر ٌک باکس مٌاد که اونو بزرگش می کنٌم  .

  



 

 

 

  
  

  
 

  

.  مقداری از عکس را پاک مٌکنٌم Deleteمطابق شکل انتخاب مٌکنٌم و بعد با فشردن کلٌد  Rectangle marqueeبعد از اٌنکه شکل مورد نظر را بزرگش کردٌم با ابزار 

  



 

 

 

  
  

  
 

  

 )قبل از اٌنکه بخواهٌم کار دٌگه انجام بدٌم ٌک کپی از اٌن لاٌر مٌگٌرٌم( درجه مٌچرخانٌم 33-32حدودا  )Ctrl+T(خوب بعد از پاک کردن کنارهای شکل را پاک کردٌم ، با فشردن 

.  طٌف رنگی مطابق شکل مٌدهٌم و سپس با اٌزار گرادٌانت 

  



 

 

 

  
  

  
 

  

 Filter<Blur<Gaussian Blur برٌم و بعدش اونو مشکی پوشش می کنٌم و بعد باٌد به Edit<Fillحالا نوبت مٌرسه به لاٌری که چند دقٌقه پٌش ازش کپی گرفتٌم ،اول از همه باٌد 
.   بدٌم و بعد از اٌن کارا اونو مطابق شکل جابجا مٌکنٌم Radius : 5Pxبرٌم و 

  



 

 

 

  
  

  
 

  

 را پاٌٌن نگه مٌدارٌم و روی لاٌر اصلی کلٌک مٌکنٌم پس Ctrlحالا مٌخواهٌم بالای سمت چپ عکس طراحی شده را مقداری رنگ خاکستری بدهٌم ، برای اٌن کار اول باٌد کلٌد 

.  را نگه داشته و از انتخاب اولٌه کم مٌکنٌم Altرا برداشته و كلٌد  Elliptical marqueeدرنتٌجه کل محٌط لاٌر را انتخاب مٌکنٌم و بعد ابزار 
  

.   را پاٌٌن نگه دارٌم و در نتٌجه آن را در مکان مناسب قرار دهٌم Spaceبرای اٌنکه بخواهٌم آن مقداری را که کم کردٌم را جابجا کنٌم باٌستی کلٌد * 

  



 

 

 

اٌن کار را دوبار انجام مٌدهٌم تا تقرٌبا مطابق شکل گردد  

   



 

 

 

  
  

  
 

  

سپس بعد از اٌنکه لاٌر را در جای مناسب قرار . پس برای اٌن کار باٌستی ٌک کپی از لاٌر اصلی بگٌرٌم و آنرا کمی جابجا کنٌم . حال مٌخواهٌم که مقداری از پاٌٌن شکل راتٌره کنٌم 
اٌن کار باعث مٌشود که معکوس اشتراک اٌن دو لاٌر ( روی کپی لاٌر کلٌک مٌکنٌم Ctrl+Alt روی لاٌر اصلی کلٌک مٌکنٌم و بعد با نگه داشتن کلٌدهای Ctrlدادٌم با نگه داشتن کلٌد 

  )را انتخاب کنبم

  



 

 

 

  
  

  
 

  

 کلٌک مٌکنٌم و اٌن کار را چند بار Filter<Blur<Blur moreمقدار انتخاب را رنگ مٌکنٌم و بعد به # 8F8F8Fخوب بعد از اٌن کارها کپی لاٌر اصلی را پاک مٌکنٌم و با رنگ 
) Edit<Stroke(. محٌط شکل را مشکی مٌکنٌم 1pxانجام مٌدهٌم و سپس با 



 

 

 

  
  

  
 

  

.  ٌک داٌره وسط ، مطابق شکل مٌکشٌم  Elliptical marqueeحالا با ابزار 



 

 

 

  
  

  
 

  

ٌک بٌضی بزرگتر از  Elliptical marqueeبعد از اٌن کار با ابزار . درون داٌره ٌک طٌف رنگی مانند شکل مٌکشٌم بعد از اٌنکه داٌره را رسم کردٌد با ابزار گرادٌانت 
.  محٌط بٌضی را رنگ مشکی مٌزنٌم 1pxداٌره قبلی مٌکشٌم و با ضخامت 



 

 

 

  
  

  
 

  

 Elliptical marquee درجه می جرخانٌم تا موازی لاٌر اصلی شود و سپس آن را تقرٌبا از وسط مانند شکل برش مٌزنٌم و بعد از اٌن کار با ابزار 33-32سپس بٌضی را حدودا 

.   محٌط بٌضی را رنگ مشکی مٌکنٌم 1pxٌک بٌضی کوچک رسم مٌکنٌم و با ضخامت 



 

 

 

   

پس درنتٌچه اٌن کار را برای سمت راست خط اصلی انجام مٌدهٌم تا شبٌه شکل زٌر شود  



 

 

 

  
  

  
 

  

و با کمی تغٌٌر مکان زٌر  )Layer<Layer Style<Color Overlay( شده مٌگٌرٌم و ان را سفٌد مٌکنٌم Merge کردٌم ٌک کپی از لاٌر Mergeبعد از اٌنکه سه لاٌر را با هم 
. خط اصلی مطابق شکل مٌگذارٌم 



 

 

 

  
  

  
 

  

ٌک بٌضی مٌکشٌم و آن را مطابق شکل درست  Elliptical marqueeخوب چون اٌن قسمت شبٌه قسمت قبلی هستش از توضٌح های اضافی پرهٌز مٌکنٌم و دوباره با ابزار 
.  مٌکنٌم 

  



 

 

 

  
  

  
 

  

. حالا بقٌه کارها را روی شکل توضٌح می دهم 

  



 

 

 
  

  

  
 

  

. خوب حالا نوبت طراحی کلٌدهاش مٌرسه ... تا الان تقرٌبا بٌشتر کارهاشو انجام دادٌم  



 

 

 

خوب اٌناٌی که تا الان درست کردٌم واسه بک گراند کلٌد ها بوده ، حالا مٌخواهٌم که خوده کلٌد ها را درست کنٌم  

 

  
  



 

 

  
 

  

. خوب انشاالله که بقٌه کلٌدها را متوجه شدٌن که چه جوری درست مٌکنٌم ، در هر صورت اگه متوجه نشدٌن تو تاپٌک همٌن آموزش بگٌد تا من ٌا بقٌه دوستان کمکتون کنٌم 

 

  
  

  
 

  

) B(  مطابق شکل ٌک شکل اجق و جق  polygonal lassoبعد با ابزار .... )A( آن را کمی جابجا و مٌچرخانٌم مانند شکل Ctrl+Tٌک مستطٌل مٌکشٌم و بعد با فشردن 
رنگ # ADACAC، رنگ مٌزنٌم ، بعد از آن ٌک کپی مٌگٌرٌم و در آن طرف دٌگه مستطٌل مٌذارٌم و کمی ضخامتش را کم مٌکنٌم و با رنگ # 878585مٌکشٌم و آن را با رنگ 

. رنگ مٌرنٌم # CCCCCCو بعد با رنگ  )C(بعد مقدار فضای بٌن اٌنا را انتخاب مٌکنٌم مطابق شکل .... مٌزنٌم 

 



 

 

  
  

  
 

  

مٌکشٌم و بعد مقداری از بالا ان را با نگه  )A(ٌه چٌزی شبٌه شکل  polygonal lassoپس باٌد ابزار . خوب دوستان حالا وقته اٌنه که فٌش هدفون اٌن عجوبه رو طراحی کنٌم 
.  اضافه مٌکنٌم  )B( ٌک داٌره مطابق شکل Shift را برداشته و با نگه داشتن کلٌد Elliptical marquee کم مٌکنٌم و بعد ابزار Altداشتن کلٌد 

 

و طرح افکت داده شده مطابق شکل . رفته و با مقادٌر شکل زٌر مطابق مٌکنٌم Layer<Layer Style<bevel And Embossو به  )A(سپس آنرا رنگ مشکی مٌکنٌم مانند شکل 
)B(  مٌباشد .

  

 

  



 

 

 

  
  

  
 

  

 Paste مٌکنٌم و دوباره Mergeبا هم لٌنک مٌکنٌم و بعد  ) شکل اجق وجق1 داٌره و 1( لاٌری که 2خوب حالا از اٌن لاٌر استاٌلی که درست کردٌم کپی مٌگٌرٌم و بعد باٌد اٌن 
Layer Style مٌکنٌم سپس ٌک داٌره در ٌک لاٌر جدٌد مٌکشسم و Paste Layer Style را باهم  ) داٌره کوچک1 شکل اجق وجق و 1( لاٌر 2 مٌکنٌم و دوباره اٌنMerge کرده 

امٌدوارم که منظورمو متوجه شده باشٌد آخه من (. مٌکنٌم و به همٌن ترتٌب ادامه مٌدٌم تا طرح مورد نظر به سفٌدی مٌزنه Paste Layer Style شده mergeو دوباره روی لاٌر 
 )خودم که قفل کردم

 

  
  

  
 

  

.   مٌرٌم و مانند شکل ٌکسری تغٌٌرات مٌدٌم Filter<Liquify مٌکشٌم و بعد به 3PX ٌک خطی با قطر Lineبا استفاده از ابزار 



 

 

 
  

...   ٌه چٌزاٌی می نوٌسم Textو بعد از اٌن کارها ، روی شکلهای که تا الان طراحی کردٌم با ابزار 
  

  
  

  
 

  

 خوب خدا رو شکر دٌگه تموم شد 

  



 

 

 

  
 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 كلٌد هاي مٌانبر فتوشاپ
 

CTRL+O = Open file 
CTRL+N = New file 

CTRL+W = Close file (watch out for not mixing with CTRL+Q!!) 
CTRL+S = Save file 

CTRL+SHIFT+S = Save file As 
CTRL+ALT+SHIFT+S = Save for web  

CTRL+Q = Quit photoshop 
CTRL+A = Select all 
CTRL+D = Deselect 

CTRL+E = Merge Down (more about layers later on..) 
CTRL+R = Rulers visible (the things you drag guidelines out from..) 

CTRL+T = Transform selection (Scale and rotate..) 
CTRL+U = Change image Hue, Saturation and Lightness  



 

 

CTRL+I = Inverse 
CTRL+F = Repeat last used filter 

CTRL+K = Preferences 
CTRL+L = Levels 

CTRL+Z = Undo (something you just can´t live without. Fact.) 
CTRL+X = Cut 

CTRL+C = Copy 
CTRL+V = Paste 

CTRL+B = Color balance 
CTRL+M = Curves 

CTRL+Space = Zoom In 
CTRL+ALT+Space = Zoom Out 

D = Set Colors to Default 
X = Change Foreground color with Background color 

 
 دارند خٌلً کاراًٌ... ٌاد بگٌرٌد! رو هم حتما بعد از اٌنکه کلٌدهاي بالا رو حفظ شدٌد  اٌن کلٌد ها

 
CTRL+SHIFT+E = Flatten image 

CTRL+SHIFT+T = Transform again 
CTRL+SHIFT+U = Desaturate (make image black & white) 

CTRL+SHIFT+I = Inverse selection (usefulnes=100000) 
CTRL+SHIFT+P = Page setup 

CTRL+SHIFT+D = Reselect  

CTRL+SHIFT+F = Fade last filter..or thing you just did.. (works on alot of things) 
CTRL+SHIFT+L = Auto levels  

CTRL+SHIFT+Z = Redo 
CTRL+SHIFT+N = New layer  

 
 نداشته باشه رو هم ٌاد بگٌرٌد بد نٌست اما اگر ٌک فرد مبتدي هستٌد شاٌد زٌاد براتون کاراًٌ اٌنا

 
CTRL+ALT+0 = Actual pixels ("zooms" to 100%) 

CTRL+ALT+O = Open As 
CTRL+ALT+S = Save a Copy 

CTRL+ALT+D = Feather selection 
CTRL+ALT+F = Last filter, only you get to choose the stuff!! 

CTRL+ALT+L = Auto levels, and... you get to choose. 
CTRL+ALT+Z = History back (you´ve got to know this one!!!!) 

CTRL+ALT+B = Auto-color-balance 
CTRL+ALT+M = Auto-Curves  

 
 ;) خورند اٌنها هم خٌلً بدرد مً

 
CTRL+SHIFT+ALT+Q = Quit photoshop..without asking anything! 

CTRL+SHIFT+ALT+E = Flatten image to active layer (useful, if you´re not a beginner)  
 

 :کلٌدهاي منو ها
 

 : File اول از همه منوي. انتخاب کنٌد نشان مً دهم که در اصل اگر بخواهٌد با موس کار کنٌد باٌد آنها را از منوهاي فتوشاپ خب در اٌنجا کلٌدهاًٌ را به شما
 

ALT+F+V = Revert to last saved version of image 
ALT+F+M = Import 

ALT+F+R = Export (useful for GIFs) 
ALT+F+U+B = Batch 

ALT+F+I = File info 
ALT+F+F+G = General Preferences 

ALT+F+"number" = Open recent files (really useful, once you get used to it..)  
 

 هستند Edit خب اٌنها هم مال منوي
 



 

 

ALT+E+L = Fill selection 
ALT+E+S = Stroke "around" selection (read more in the "outline"-section ) 

ALT+E+A = Transform..these are the most useful; 
+H = Flip horizontally 

+V = Flip vertically 
+D = Distort  

 
 Image حالا منوي

 
ALT+I+M = Mode..+R = RGB +I = Indexed..and so on 

ALT+I+D = Duplicate image 
ALT+I+I = Image size (REALLY USEFUL!!) 

ALT+I+S = Canvas size  
 

 منوي لاٌه ها
 

ALT+L+N+L = New layer 
ALT+L+D = Duplicate layer 
ALT+L+L = Delete layer (!) 

ALT+L+O = Layer Options (same as double-click on layer) 
ALT+L+C = Layer Effects (all effects have their own shortcut!!!) 

ALT+L+K = Layer Mask  
 
 بدردتون مٌخوره ، راستً اٌن کلٌدها خٌلً Select منوي
 

ALT+S+C = Color range (use it! You´ll get it!!) 
ALT+S+M = Modify selection (lot´s of cool stuff here!) 

ALT+S+T = Transform selection 
ALT+S+L = Load selection  

 
 ;) نگران نباشٌد آخراشه دٌگه: (خب خسته که نشدٌد؟ 

 
 Filter اٌنم مال منوي

 
ALT+T+B = Blur-menu 

ALT+T+N = Noise-menu 
ALT+T+P = Pixelate-menu 
ALT+T+R = Render-menu 

ALT+T+S = Sharpen-menu 
ALT+T+T = Texture-menu 

ALT+T+E = Eyecandy (plug-in..go get it!)  
 


